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This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code
is provided under the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

3. Altered versions— including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions—must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases— including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited frommis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

____________________________________________________________________________

Copyright © 2018 - 2024. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size, intrusion porosimetry, powder rheology, and activity testing
of catalysts. The company has R&D and manufacturing sites in the USA, UK, and Spain, and
direct sales and service operations throughout the Americas, Europe, and Asia. Micromeritics
systems are the instruments-of-choice in more than 10,000 laboratories of the world’s most
innovative companies and prestigious government and academic institutions. Our world-class
scientists and responsive support teams enable customer success by applying Micromeritics
technology to the most demanding applications. For more information, please visit
www.micromeritics.com.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA 30093-2901 USA
Phone: 1-770-662-3636
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3636
International: Contact your local distributor or call 1-770-662-3636
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.micromeritics.com).

n Calculations document (PDF)
n Error Messages document (PDF)
n Operator Manual (PDF)

n Parts and Accessories

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.
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1 ANALYZER COMPONENTS

A. Septum port
B. Mass spectrometer

port
C. LED lights
D. Vapor generator and

fan
E. Heating Mantle
F. Furnace
G. Dewar and Dewar

stand
H. Gas exhaust ports
I. Gas inlet ports

Component Description
Dewar and Dewar
stand

Dewar and Dewar stand.

Furnace Controls the temperature of the sample.

Gas exhaust ports For attachment of appropriate exhaust systems to meet local safety
standards for chemisorption exhaust.

Gas inlet ports For preparation, carrier, and loop gases.

Heating mantle For use with an optional vapor generator.

LED lights Indicates the communication between the analyzer and the computer.

n Red - Indicates a fault. Illuminates when there is no communication
with the computer. When the analyzer application is exited, the red
and the Attention! LED illuminate.

n Green - Indicates normal communication.
n Attention! - When blinking, indicates that operator attention is

required. Check the computer monitor for instructions. This light blinks
if aWait step requiring operator action was included in the experiment
steps. After performing the requested action, clickOK. The blinking

1 Analyzer Components
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1 Analyzer Components

Component Description

stops.

Mass spectrometer
port

To attach an optional mass spectrometer.

Septum port To inject gas into an analysis.

Vapor generator
and fan

Allows analysis using vapors from liquids carried by an inert gas.
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EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories are located on the Micromeritics web page.

Option Description
CryoCooler Analyses can be started at sub-ambient temperatures. The

CryoCooler can be used to speed throughput by ramping the furnace
temperature rapidly to ambient after an analysis.

CryoCooler II - LN2 cooler. For use with all AutoChem instruments.

CryoCooler III - Norhof CryoCooler. For use on the AutoChem
II 2920 and AutoChem III only.

KwikCool The standard version ramps the furnace temperature rapidly to near
ambient, reducing analysis time and increasing throughput. The Vor-
tex KwikCool version uses compressed air to chill the air for cooling
without a Dewar.

MKS Cirrus 3 Connects directly to a dedicated port for detection and identification
of low concentrations of condensable and/or reactive gases.

Vapor Generator Allows an inert carrier gas, such as helium, to be bubbled through the
liquid at up to 100 °C. The vapor then passes through a cooler
condensation zone maintained at an accurate temperature to ensure
a stable vapor pressure. The vapor then passes to the loop valve
zone (Fill/Inject valve) for precise injections onto the sample.

Equipment Options and Upgrades
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1 Analyzer Components

GAS REQUIREMENTS AND PURITY

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases
should be of a purity listed below. Gas regulators can be ordered from Micromeritics. Parts and
accessories are located on the Micromeritics web page.
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SPECIFICATIONS FOR THE AUTOCHEM II 2920

Voltage 85 to 265V~

Power 1250 VA, operating, max

Frequency 50-60 Hz

Overvoltage category II

Electrical

Range -100 °C to 1100 °C with CryoCooler option
Ambient to 1100 °C without CryoCooler option

Selection Digitally set, 1 °C increments

Ramp Rates
Up to 100 °C per minute from -100 °C to 800 °C
Up to 50 °C per minute to 1000 °C
Up to 25 °C per minute to 1200 °C

Temperature System

Loop (Analysis) H2, CO, O2, N2O, NH2 vapors such as pyridine, water, etc

Carrier He, Ar, and other gases

Preparation H2, O2, He, Ar, and others

Gases

All Mass Flow Controllers (MFCs)

Manual Control 1 to 100 mL/minute1 )

Automatic Analysis 10 to 75 mL/minute

Gas Flow Rate

1 ) Rate for Nitrogen; other gases have a different range.

Specifications for the AutoChem II 2920
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1 Analyzer Components

Loop (Analysis) H2, CO, O2, N2O, NH2 vapors such as pyridine, water, etc

Carrier He, Ar, and other gases

Preparation H2, O2, He, Ar, and others

Gases

Inlet Ports (18), 6 each for preparation gas, carrier gas and loop (analysis) gas

Temperature Control Internal gas lines and valves heated up to 150 °C

Gas Delivery

Type Fused quartz Flow-Thru sample tubes, for use up to 1200 °C,
accepts powders and pellets up to 9 mm in diameter

Sample Tube

Height 62 cm (24.5 in.)

Width 66 cm (26 in.)

Depth 58 cm (22.75 in.)

Weight 60 kg (130 lbs)

Physical

Temperature 15 °C to 35 °C operating,
0 °C to 50 °C non-operating

Humidity 20 to 80% relative, non-condensing

Indoor or outdoor use
Indoor only
Altitude: 2000 mmax
Pollution degree of the intended environment: 2

Environment
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Operating System Windows 10 or higher operating system is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required.

Read/Write Permissions All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.

Specifications for the AutoChem II 2920

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 1 - n





2 ABOUT THE SOFTWARE

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Helpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs and copy and
paste graphics are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user-defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can be manipulated and displayed interactively using MicroActive reports.

PEAK EDITOR FOR DYNAMIC ANALYSIS
Peak Editor on page 6 - 3

The TCD (Thermal Conductivity Detector) features a Peak Editor, which allows the evaluation of
results, peak editing, and reports. Adjusting peak boundaries can be used to eliminate baseline
noise or other undesirable effects. The Peak Editor also allows the separation of composite
peaks.

2 About the Software
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2 About the Software

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes— such as adding, moving, or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer,
refer to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP address must be 192.168.77.100.

SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

SOFTWARE UNINSTALL
The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.
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MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Selections Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit 

[n] displays on the menu bar for each analyzer attached to the computer.
Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals
defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Use to access the embedded operator manual, Micromeritics web page,
and information about the application.

Main Menu Bar Options

Menu Structure
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2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.

Common Fields and Buttons
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Selections Description
Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCII text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

Selections Description
Replace All Selects another .SMP file where the values will replace all values for

the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)
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FILE STATUS, DESCRIPTION, AND LOCATION
In the File Selector window, theMic Description column and theMic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently used for analysis.

Complete Sample files used in an analysis that is completed.

No Analysis Sample files that have not been used to perform an analysis.

File Status

File Type File Name
Extension

Analysis Conditions .ANC

Methods .MTH

Report Options .RPO

Sample Information .SMP

SPC Report .SPC

File Type and File Name Extension

File Type File Name Extension
Portable document
format

.PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup lan-
guage

.XML

File Types for Printing or Exporting

File Status, Description, and Location
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt +[Unit n] Opens the Unit [n]menu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens the Reportsmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector window.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

Shift + F9 Opens the shortcut menu of either the selected component on the ana-
lyzer schematic when manual control is enabled or the onscreen reports.

Keyboard Shortcuts
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OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Always Open Edit View Opens files with a Complete status in the tabbed file editor rather
than in the Peak Editor view.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

Option Presentation
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2 About the Software

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.
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LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.

Libraries
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2 About the Software

CONFIGURE THE ANALYZER

ENVIRONMENTAL DEFAULTS FOR TCD ANALYZERS

Options > Environmental Defaults

These values are used in some calculations to account for the effect of environmental conditions
on the analysis. These parameters are used in the Dynamic Analysis reports. To ensure accurate
loop calibration, enter current environmental conditions daily, or whenever there is a significant
change in one or more of the environmental conditions.

Saturation pressure (Po) of the adsorbate used by BET analysis is obtained from the
adsorptive properties for the experiment gas specified.

Selections Description
Ambient temperature
[text box]

The temperature of the room where the analyzer is located.

Atmospheric
pressure
[text box]

The atmospheric pressure of the room where the analyzer is located.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Environmental Defaults
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GAS CONNECTIONS

Unit [n] > Gas Connections
Adsorptive Properties on page 4 - 2

Use to configure the gas type connected to each analysis port. The gases available in the drop-
down lists come from the Adsorptive Properties (.ADP) files. ClickOK when done.

UNIT SELECTION

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

Gas Connections
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2 About the Software

UNIT CONFIGURATION

Unit [n] > Unit Configuration
Use to display and confirm hardware and software configurations and calibrations of the analyzer.

Fields Description
Configuration
[group box]

Displays the IP address used by the analysis program, serial
number, and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. [button] Displays the Board ID dialog, which
describes the circuit boards in the analyzer. Use the Board drop-
down list to select a board to view.

Board ID. [button]Click to display information from the circuit
boards in the analyzer. Use the drop-down list to select a board
to view. The parameters shown cannot be edited.

Serial #. Displays the analyzer serial number.
Loop volume [text box] Enter the volume of the gas injection loop. Three standard

Unit Configuration
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Fields Description
volume loops are provided with the analyzer. The loop volume is
determined by performing a loop calibration. See Loop Cal-
ibration for TCD Analyzers Tutorial on page 11 - 10.

Options [group box] Displays options installed on the analyzer.

For Temperature controller:

M— indicates Micromeritics
E — indicates Eurothem

CryoCooler type:

n CryoCooler II - (default) LN2 cooler

n CryoCooler III - Norhof CryoCooler

Software Versions
[group box]

Displays the software versions of the MIC BIOS, controller soft-
ware, and analysis program.

Unit Configuration (continued)

Unit Configuration
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2 About the Software

INSTRUMENT STATUS

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Enable Manual Control

Unit [n] > Show Instrument Schematic
Enable Manual Control on page 10 - 4
Gas Pathways on page 2 - 21

A. Preparation gas MFC
B. Cold trap valve heat zone
C. Analysis heat zone
D. Detector heat zone
E. Auxiliary port
F. Loop valve heat zone
G. Septum
H. Loop gas MFC
I. Carrier gas MFC
J. Reference gas MFC
K. Inlet valves

Icon or Symbol Description
Auxiliary I/O. Lists the current auxiliary settings for Digital and
Relay Output (DO and RO) and Digital Input (DI). The current Aux-
iliary 1 and Auxiliary 2 signals are also displayed if recorded. See
Auxiliary Inputs and Outputs on page C - 1.

Auxiliary Port. Connect an external detector (such as a mass
spectrometer) to the analyzer. It cannot be manually controlled.

Calibration Valves. Used during automatic calibration pro-
cesses. Generally, it is not necessary to change the state of the
calibration valves.

Analyzer Schematic Icons
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Icon or Symbol Description
Closed Valve. Yellow indicates a closed valve. When manual
control is disabled, closed valves appear white.

CryoCooler. Displays only if installed. The CryoCooler speed can
be set from 0 to 100%.

Blue. Indicates the Dewar is full

Red. Indicates the Dewar is empty. When the rate speed is set to
100%, the Dewar displays as red and empty, a warning light
illuminates, and the pump will beep continuously.

Yellow. Indicates Dewar level is unknown and rate is set to zero
(for CryoCooler III installations only).
Detector Heat Zone. Set the detector heat zone by clicking
anywhere in the orange box. Set the Filament Temperature by
clicking the detector rectangle on the right side of the schematic.

Gas Inlet Valves. The inlet displays the gas mnemonic if one is
assigned. Right-click the inlet valve to open or close the valve.

Analyzer Schematic Icons (continued)

Show Instrument Schematic
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2 About the Software

Icon or Symbol Description
Heat Zones. Controls the temperature of various parts of the
analyzer. Component heat zones are enclosed with an orange
rectangle. Click a heat zone icon to display the current
temperature and the target temperature. Right-click the icon, then
select Set Temperature to change the heat zone’s target
temperature. Using the default temperature (110 °C) for all heat
zones is recommended to ensure a cleaner system.

The cold trap heat zone controls the temperature of the cold trap
valve.
KwikCool. Displays only if installed.

Mass Flow Controller. Controls the flow of gas into the analyzer.
The MFC target and flow rate are displayed. Right-click and select
an option:

n Open. Fully opens the MFC.
n Close. Closes the MFC to stop gas flow.
n Set. Displays the applicable Mass Flow Controller dialog box in

which you can open the controller, close the controller, or set
the flow rate.

n Zero. Sets the MFC to read zero flow under current conditions.

Open Valve. Green indicates an open valve.

Analyzer Schematic Icons (continued)
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Icon or Symbol Description
Pressure Transducer. Displays the current pressure in the car-
rier gas path, upstream from the septum but downstream from the
Mass Flow Controller. It cannot be manually controlled.
Rotary Valve. Controls the gas flow through the cold trap, sample
tube, loop, and optional vapor generator. Select the needed state.
From left to right, the valves and their states are:

n Cold Trap. Bypass, Trap
n Analysis. Analyze, Prepare
n Loop. Fill, Inject
n Vapor. Vapor, Bypass (optional)

Sample Furnace. Controls the temperature of the sample. Click
to display the sample temperature, the target temperature, the fur-
nace temperature, and the ramp rate. Right-click the icon and
select Set Temperature to change the Set Point and/or the Ramp
Rate.
Septum. Makes manual injections of gas into the gas stream.

Analyzer Schematic Icons (continued)

Show Instrument Schematic
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2 About the Software

Icon or Symbol Description
Valve options Close. Closes the selected valve.

Open.Opens the selected valve.

Temperature control
options

Select Set Temperature to modify furnace or heater settings.

Schematic Shortcuts
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Gas Pathways

The colored lines that lead from the gas inlets through the analyzer and to the exhaust represent
the current flow path. A different color path represents each gas source:

Pink Loop gas

Blue Carrier and Reference gases

Green Preparation gas

Black Blended gas

When a gas valve is opened, or the flow path is changed, it takes several minutes for
the new gas to move through the entire system.

The behavior of the loop valve is one example. When an analysis includes a loop injection, the
schematic shows the path available in Fillmode, then Injectmode.
n In Fillmode, the analysis gas enters the loop, and the excess gas vents out the exhaust.
n In Injectmode, the analysis gas bypasses the loop and exits the analyzer through the exhaust.

At that time, the carrier gas path is available from the inlet all the way through the loop, through the
sample tube, and past the detector.

When the valve switches to Injectmode, the quantity of analysis gas contained in the loop— one
exact unit — is pushed out of the loop and through the sample tube by the carrier gas. When the
application is recording the TCD signal, the loop injection shows as a peak on the Results view of
the Analysis window.

The analysis gas may be greatly dissipated as it travels out of the loop and through the sample
tube, particularly if the carrier gas flow rate is low. Higher carrier gas flow rates minimize the
dispersion of the loop gas.

SHOW STATUS

Use to show the current status for each port.

If multiple units are attached to the computer, select Show Status on each Unit [n]menu. The
status for all units displays.

Show Status
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2 About the Software

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages.

Selections Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Report [button] Click to select the print destination and the report start date.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Instrument Log
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METHODS

Options > Default Method
File > Open > [.MTH File]
AMethod determines the default sample identification format and sequence number. AMethod is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed. Only a single selection
is required for each new sample file created.

TheMethod drop-down list displays only those methods applicable to the open sample file type.

Default Method Examples Default Method Examples

Selections Description
Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labels may be renamed, and the new label becomes a
part of all new sample files.

Sequence number
[text box]

Specify a default numeric string to use as a prefix in the Sample field
when a new sample file is created. This number increments with
each sample file created.

Default Methods

Methods
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2 About the Software

EXPORT FILES
File > Export
Exported Data Example on page D - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Click List and open an .SMP file.
2. Select an experiment and the applicable options.
3. ClickOK.
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LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

Example of
File List

List Files
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2 About the Software

ANALYSIS TYPES FOR TCD ANALYZERS
The basic concept for all analyses is the same: the filament detects changes in the gas mixture
flowing past it. The sample, gas selection, and analysis conditions determine what changes occur.

BET Surface Area Analysis on page 11 - 1
Pulse Chemisorption Analysis Tutorial on page 11 - 12
Temperature Programmed Desorption Analysis on page 11 - 20
Temperature Programmed Oxidation Analysis on page 11 - 26
Temperature Programmed Reduction Analysis on page 11 - 32

The BET surface area analysis evaluates the total surface area of the catalyst before and after
chemisorption. Pore-plugging phenomena, which might occur due to the irreversible adsorbed
species during chemical reactions, and the occurrence of sintering1 ) , can be studied.

After outgassing the sample, a mixture of nitrogen and helium (typically 5 to 30% N2) flows over
the sample that is immersed in a liquid nitrogen (LN2) bath. Both the adsorption and desorption of
the N2 are recorded. The amount of nitrogen desorbed at LN2 temperatures and the sample
weight is used to calculate the total specific surface area.

The entire BET analysis — or even repeat analyses— is performed in situ.

n Langmuir Surface Area Analysis. The Langmuir surface area analysis allows for evaluating
the total surface area of the catalyst and is especially useful for adsorbate/adsorbent systems
that adsorb only a monolayer. These materials typically exhibit a Type 1 isotherm and are often
microporous. The Langmuir surface area analysis may be best applied to zeolites and micro-
porous carbons. Typically the Langmuir surface area will exceed the BET surface area for
these materials and provide a more accurate estimation of the total surface area. The Langmuir
surface area report may be applied to a wide range of gas concentrations and is not limited to
the typical BET range (5 to 30% N2).

1 ) Sintering is the fusing of small particles (or small features of a sample). Sintering tends to
reduce the active surface area.
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n Total Pore Volume Analysis. The total pore volume is a single-point estimate of the pore capa-
city of a material. The total pore volume analysis is usually conducted near the saturation pres-
sure of the adsorbate (0.995 P/P0). The total pore volume of a material can be determined on
both fresh and used materials. The difference in pore volume may indicate pore plugging and
directly relate to changes in the performance of catalysts and adsorbents.

For a high surface area sample (> 100 m2/g), a quantity less than 50 mg is recommended. The
high sensitivity combined with a large amount of adsorbed gas allows smaller sample quant-
ities to be used while maintaining high precision. The reduced sample quantity will also reduce
the likelihood of saturating the high sensitivity detector.

ADDITIONAL USES OF THE TCD ANALYZER

The analyzer may also be used for temperature programmed reactions, catalyst pretreatment,
and isothermal reactions. The tremendous flexibility of the analyzer allows the use of custom
applications.

Temperature Programmed Reaction

A temperature programmed reaction monitors the products from the reaction between gases and
a catalyst at a specified temperature. The analyzer can be programmed to raise the temperature
of a catalyst bed at a constant ramping rate as the gases flow through the catalyst. At the optimal
temperature, the gases react in the presence of the catalyst, creating products. The products of
the reaction and excess reactants can be diverted to a gas chromatograph or to a mass
spectrometer to be analyzed.

Catalyst Pretreatment

Catalyst pretreatment usually consists of activating a catalyst before its use in a chemical
reaction. For example, a temperature programmed oxidation reaction may require reduction of the
catalyst under a flow of H2 at a specific temperature.

Isothermal Reaction

An isothermal reaction is similar to a temperature programmed reaction except that the catalyst is
kept at a constant temperature (isothermal) to perform the catalytic reaction. Both the product of
the reaction and the excess reactants can be diverted to a gas chromatograph or to a mass
spectrometer to be analyzed.

Additional Uses of the TCD Analyzer
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APPLICATIONS

Catalytic processes that benefit from TPD/TPR analyses include:

n Polymerization
n Hydrogenation
n Catalyst cracking
n Hydrocracking
n Isomerization

n Oxidation
n Dehydrogenation
n Hydrotreating
n Alkylation reforming
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3 SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode. After data is collected, the
file is shown in MicroActive mode or the tabbed file editor.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

3 Sample Files
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3 Sample Files

SAMPLE FILES
File > New Sample > [.SMP File]

File > Open > [.SMP File]

Analysis condition defaults for metal stoichiometry factors can be set using the
sample information metal table editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis conditions experiment step editor.
If required, stoichiometry factors for a completed pulse chemisorption experiment can
be viewed and modified using the peak editor’s stoichiometry settings window.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

Advanced
option presentation

Basic or Restricted
option presentation
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Selections Description
Active Metals [button] Displays a list of active metals. See Active Metals for

Chemisorption Analyzers on page 3 - 5.
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Mass [group box] Enter a value for sample mass. Mass can be changed any time
before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. The equation
used to calculate sample mass:

Masssample = Masssample+tube – Masstube
Method [drop-down box] Select a method from the drop-down list.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Sample [text box] Enter a sample description.

Submitter [text box] Enter submitter identification information. This text box may have
been renamed or may not display if modified inOptions > Default
Methods.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Sample Files

Sample Files
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3 Sample Files

OPEN A SAMPLE FILE
File > Open > [.SMP File]

When working with an existing sample file, consider copying the sample file to
maintain the original configuration options.

File Status Displays
No Analysis Tabbed file editor

Complete
Analyzing Peak Editor view

Tabbed file editor in
Advanced view

Peak Editor View

To view the tabbed file editor for a sample file with a Complete status, select Advanced from the
view selector drop-down list at the bottom of the window.
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ACTIVE METALS FOR CHEMISORPTION ANALYZERS
Options > Active Metals Defaults
Or, click Active Metals on the Sample Description tab when using the Advanced presentation
option.

Atomic Weights and Cross-Sectional Areas on page B - 1

Up to 20 elements can be specified. At least one element must have a non-zero % of the sample
weight.

Selections Description
% of Sample Weight *
[column]

Percentage, by weight, of each element contained in the sample.

% Reduced * [column] The percent of metal reduced during preparation.

Adsorptive [button] Click to display and modify both the adsorptives and their associated
stoichiometry factor. Stoichiometry factors for each gas are metal-
specific.

Active Metals

Active Metals for Chemisorption Analyzers
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3 Sample Files

Selections Description

Stoichiometry Factor. The stoichiometry factor is defined as the
moles of metal species covered per mole of adsorptive.

Atomic Cross Sect.
Area (nm2) [column]

Atomic cross-sectional area of the element.

Atomic Weight [column] Atomic weight of the element.

Density g/cm3 [column] Density of the element.

Element
[drop-down box]

Select or enter the active metal.

MxOy, X *
MxOy, Y *
[column]

X and Y values specify the empirical formula for metal and oxygen,
respectively, in a metal oxide.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Active Metals (continued)

* Options are shown only when using the Active Metals button on the Sample Description tab.
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4 PARAMETER FILES
Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed, or new
parameter files created.

The following file types can exist as part of the sample file as well as individual parameter files.

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Method .MTH

Report Options .RPO

Parameter File Types

4 Parameter Files
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4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
Gas Connections on page 2 - 13
Gas Charts on page E - 1

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

Selections Description
Adsorptive
[drop-down box]

Name of the adsorptive gas whose properties are being defined.

Estimate mass flow
constant and thermal
conductivity [group box]

Select if a gas blend will be used for the estimated Relative Thermal
Conductivity and Mass Flow Constant. Select the gases to be used
in the blend.

Gas blend. [check box] Select to specify a preblended mixture of a
chemically insert gas and a chemically active gas. The blend'sMass
Flow Constant and Relative Thermal Conductivity are automatically
calculated from those for the two gases in the blend.

Fluid properties [button] Use to import parameters from a Fluid Properties (.FPI) file.
Changing fluid properties should only be necessary if an adsorptive
is to be used for which no adsorptive properties are provided.
Contact Micromeritics Scientific Services if new fluid properties are
required.

Hard-sphere diameter
[text box]

Estimate of the molecular size used in calculating the thermal
transpiration correction.

Adsorptive Properties
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Selections Description
Mass flow constant
[text box]

Scaling factor for the Mass Flow Controller measured flow rate.
Applicable only for the gas used in the flow prep tasks. The default is
preset for gases provided with the application.

Mnemonic [text box] Enter the mnemonic name for the adsorptive.

Molecular cross-
sectional area [text box]

The area that a single adsorbed molecule occupies on the surface of
the sample. It is used in surface area calculations.

Molecular weight
[text box]

The molecular mass is used for the weight % column of the isotherm
tabular report and the pressure composition isotherm plot.

Relative thermal
conductivity[text box]

Enter the thermal conductivity relative to Air.

Vapor [check box] Select if vapor is going to be used and enter the vapor defaults.

High-resolution fluid properties. Use to import parameters from a
Fluid Properties (.FPI) file. Changing fluid properties should only be
necessary if an adsorptive is to be used for which no adsorptive
properties are provided. Contact Micromeritics Scientific Services if
new fluid properties are required.

Antoine equation. Enter the Antoine constants.

n A, B, C. Enter the Antoine constants used in the vapor
TCD calibration.

n Min/Max temperature. Enter the temperature range where the
constants are valid.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Adsorptive Properties (continued)
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4 Parameter Files

ANALYSIS CONDITIONS
Insert Experiment Steps on page 4 - 7

File > Open > [.ANC File]
Analysis conditions specify the parameters used to guide an analysis.

When inserting experiments, select the instrument type in the View conditions for
drop-down list.

Selections Description
Analysis Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Analysis Conditions
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Selections Description
Baseline [button] Specifies baseline settings if aWait step depends upon the Baseline.

Establishes the Slope or Acceleration threshold and Duration for
determining what constitutes a Stable Baseline, a Change From
Baseline, and a Return To Baseline. These values control whether a
particular change in the signal is significant to the current experiment
— such as defining a stable baseline.

SomeWait steps are contingent upon the values selected— such as
if the experiment contains aWait until Baseline is stable step, the
signal is compared to these values to determine if a stable baseline
has been established. Lower slope/acceleration values and longer
durations create a more rigorous definition of these factors than higher
values and shorter durations.

Stable Baseline. [group box] Detected when the signal slope is below
the threshold for the indicated duration.

Change from Baseline. [group box] Detected when the signal
acceleration exceeds the threshold for the indicated duration.

Return to Baseline. [group box] Detected when the signal
acceleration falls below the threshold for the indicated duration.

Analysis Conditions (continued)
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4 Parameter Files

Selections Description
Delete [button] Deletes the currently selected step. If the step is an experiment, a

prompt displays to confirm deletion of all steps for that experiment.
Edit [button] Displays the applicable dialog box for the selected step.

Insert [button] Inserts a new step into the task list.

To ensure safe operation and reliable results, a chemically inert gas
flow should be inserted between flows of two chemically reactive
gases such as hydrogen and oxygen.

Insert Analysis
Conditions [button]

Loads an entire list of steps, baseline parameters, and peaks
parameters from the selected dynamic analysis conditions file.

Step Detail [group box] Displays summary information about the highlighted experiment step.

View conditions for
[drop-down box]

Selects the instrument model to use, and the editor only shows the
options available for that model. The selection is saved and reused
when the file is reopened and disabled during and after analysis.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Analysis Conditions (continued)
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INSERT EXPERIMENT STEPS

Experiments can be customized to control the analysis reaction. When an experiment is inserted,
the initial conditions are specified first, then the individual steps. On the Analysis Conditions tab,
click Insert to insert an experiment. Select the experiment step in the box, then click Edit to
modify settings. An analysis set is created by inserting up to 99 experiments in the sample file.

To edit steps that have not been started, the analysis must be suspended.

n Upcoming steps - display as black or blue
n Current step - step is highlighted and displays as light blue
n Completed steps - display as light green

The DDE Command step andWait for synchronization message option in the Wait
step are no longer supported.

Data from one experiment are not available for editing until the next experiment in the
analysis has begun recording.

Selections Description
Change Valves Sets the rotary valves as specified.

Experiment Fields

Insert Experiment Steps
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4 Parameter Files

Selections Description

Dose

Injection Type:

n Inject loop gas. Automatically injects the contents of the loop into the
path that leads to the sample. The contents of the loop are pushed out
of the loop by the carrier gas.

n Manual injection. Prompts the user to inject a dose of gas into the
septum using a syringe.

n Get physisorption point. Provides a series of steps necessary to col-
lect data for a physisorption point. These steps include placing a
Dewar of liquid nitrogen around the sample tube, waiting for a return to
baseline, then replacing the Dewar with water at room temperature.
Repeated points can be taken by placing the Dose step within a
Repeat Loop.

After Injection. Specify the conditions for completion of this step.

Baseline. See Baseline button in Analysis Conditions on page 4 - 4.

Experiment Fields (continued)
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Selections Description
Experiment

Experiment description. Description of the experiment.

Type of analysis.See Analysis Types for TCD Analyzers on page 2 -
26.If Pulse Chemisorption is selected, the Stoichiometry button is
enabled. When modifying the Active Metals table during the insertion of a
Pulse Chemisorption experiment, changes to the Active Metals table on
the Sample Description tab are not affected. This is useful when
sequencing multiple experiments and Stoichiometry is different from one
experiment to the next.

Initial Conditions. Description for Zones, Gas Flows, Outputs, and
Peaks buttons are provided elsewhere in this table.

Stoichiometry.Opens the Active Metals table. Specify the percent of
sample weight of the active metals in the sample and the stoichiometry
factor. See Active Metals for Chemisorption Analyzers on page 3 -
5.

Experiment Fields (continued)

Insert Experiment Steps
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4 Parameter Files

Selections Description

Analysis condition defaults for metal stoichiometry factors
can be set using the sample information metal table
editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis
conditions experiment step editor. If required,
stoichiometry factors for a completed pulse
chemisorption experiment can be viewed and modified
using the peak editor’s stoichiometry settings window.

See Peak Editor on page 6 - 3.

Recording Options

n Include input signal. Allows the use of external electrical input from
an auxiliary port or choose to report an analyzer specific parameter
from the drop-down list. See Auxiliary Inputs and Outputs on
page C - 1.

n Zero the TCD signal when recording starts. Zeros the TCD signal
automatically the first time recording starts in an experiment.

n Invert the TCD signal. Inverts the TCD signal. For example, if only
negative peaks are expected, this option can be used to record the
peaks in the positive direction.

Peaks:

Use to control peak detection during analysis.

Experiment Fields (continued)
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Selections Description
After analysis, peak detection can be further controlled using the Peak
Editor. See Peak Editor on page 6 - 3. The TCD detects and records all
deviations from baseline, but only those which satisfy the criteria
established in this window are reported as peaks.

The defaults are usually acceptable. See Peak Detec-
tion / Integration Options on page F - 1.

Gas Calibration

Use to calibrate the TCD so that peak area data can be converted to
volume data. During a gas calibration, a series of known gas mixtures
flows through the analyzer and the resultant signal readings are
recorded. The analyzer can then use these data to calculate the
concentrations of unknown mixtures flowing past the detector during
subsequent analyses.

Description. Description of the experiment.

Calibration Gases. Select the Carrier and Loop gases to be used in this
calibration. The gases available are those specified in an Adsorptive
Properties [.ADP] file. See Adsorptive Properties on page 4 - 2 and
Gas Charts on page E - 1 for gas combinations.

Flow rate. Specify a flow rate for the calibration gases. Typically, the
same flow rate is used for both the carrier and reference gas. To use
different flows, select Different reference flow.

Different reference flow. Use to specify different flows for the calibration
gases. When selected, the Rate field is enabled to enter a different flow.
This flow is used for the reference gas; the carrier gas uses the Flow Rate
field.

Experiment Fields (continued)
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AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 4 - 11



4 Parameter Files

Selections Description
The carrier gas flows through the path that contains the sample tube, and
through the reference path. The reference path flows directly from the
inlet over the reference detector, making it possible for the detector to
detect variations in the gas that traveled through the sample tube (carrier)
path.

Recording Options. See Recording Options on page 4 - 10
Gas Flow

Use to select the gases for this step, specify the flow rates, specify the
percent of the carrier gas mixture which is composed of the reactive, and
set the state of the rotary valves.

The listed gases are those specified in the Adsorptive Properties file. See
Adsorptive Properties on page 4 - 2 andGas Charts on page E - 1
for gas combinations. Select None when no gas is to be flowing (the flow
rate is ignored).

Prep Gas, Carrier/Reference Gas, Loop Gas. Select the gas for each
set of inlet ports. The gases listed are those with defined adsorptive
properties. If manual injections are to be programmed, the gas to be
injected must be selected as Loop or Injection gas.

When an analysis is started, the application verifies that the selected
gases are connected to the appropriate ports. If there is a discrepancy
between a gas selected for the current sample file and the gases
indicated in theGas Configuration window, an error message is
displayed.

Rate.The rate at which gas is to flow.

Different reference rate. The carrier gas flows through two separate
paths through the analyzer — through the path that contains the sample

Experiment Fields (continued)
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Selections Description
tube, and through the reference path. The reference path flows directly
from the inlet over the reference detector, making it possible for the
detector to detect variations in the gas that traveled through the sample
tube (carrier) path.

The same flow rate is typically used for both the carrier and reference
gas. To use different flows in these two paths, select Different reference
rate, then specify the flow to use for the reference gas path in the Rate
field. (The Rate field determines the carrier gas flow rate.)

Blend carrier and loop gases. Select to have the carrier and loop
gases blended then enter the percentage for the gases. Whichever field
is modified, the other field automatically defaults to a percentage totaling
100. If this option is selected for a Physisorption experiment, set the
correct blended active concentration in the peak editor after analysis
completes.

Cold trap valve, Analysis valve, Loop valve, Vapor valve, Cold trap
valve, Analysis valve, Loop valve, Back pressure valve. Select a
status for each valve. If Vapor is selected for the status of the vapor valve
and the vapor generator is not attached to the analyzer when the analysis
is started, an error message is displayed.

Loop Calibration

Use to verify the volume of the loop for use in calculations on analyses
that use the loop. Sample analysis data yield signal vs. temperature data
and peak areas. Associating the sample file with a loop calibration file
makes it possible for the application to convert sample data to volume
values.

Experiment Fields (continued)
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Selections Description
Outputs Use to specify the state of the digital and relay outputs.

Ports are provided for connecting auxiliary inputs and outputs. For
example, the digital outputs can be used to control a mass spectrometer.
See Auxiliary Inputs and Outputs on page C - 1.

Start Recording

Specifies how frequently the signal reading is recorded. A Stop
Recording step is inserted in the steps automatically when a Start
Recording step is inserted. Multiple steps can be inserted between the
Start Recording and Stop Recording steps.

One measurement every [n] seconds. [text box] Specify the frequency
of measurements.

If a Start Recording step is immediately followed by a step
that prompts an immediate peak, peak data are recorded
before any baseline readings can be collected. To collect
some baseline data before the first peak, insert aWait for [n]
minutes step after the Start Recording step but before the
step which causes the peak.

Experiment Fields (continued)
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Selections Description
Start Repeat

Specifies the duration of the repeat sequence. Automatically inserts a
Start Repeat and a Stop Repeat in the list of steps. Multiple experiment
steps can be inserted within the Repeat loop.

Repeat until peaks are equal or [n] times. [button] Stops repeating the
steps within the loop when the last two peaks are equal to within 5% of
the area, or when the maximum number of repeats is reached. This
option is useful when performing H2 or CO pulse chemisorption on
supported metal catalysts.

Repeat until peaks are zero or [n] times. [button] Stops repeating the
steps within the loop when the last two peaks are each less than 10% of
the area of the first peak, or when the maximum number of repeats is
reached. This option is useful when performing an N2O decomposition for
characterizing copper catalysts.

Repeat [n] times. [button] Stops repeating the steps within the loop
when the specified number of times is reached.

Repeat until peaks match the first peak or [n] times. [button] Stops
repeating the steps within the loop when the last two peaks each match
the first peak to within 10% of its area or when the maximum number of
repeats is reached.

Experiment Fields (continued)

Insert Experiment Steps

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 4 - 15



4 Parameter Files

Selections Description
Temperature Ramp

Changes the sample temperature.

Temperatures above 850 °C can cause damage to a metal
sample tube.

Also, sample temperatures significantly above 1100 °C will
cause accelerated wear on furnace components and lead to
premature failure of the furnace. Experiments should be
designed with sample temperatures at or below 1100 °C or to
minimize operating time above 1100 °C.

Ramp Type [group box]:

n Furnace ramp. [button] Ramps the furnace temperature directly
to the End temperature ignoring the sample temperature.

n Sample ramp. [button] Ramps the sample temperature to the End
temperature. The actual furnace temperature is adjusted to meet
this target.

n Sample ramp and equilibrate. [button] Ramps the sample tem-
perature to the End Temperature and waits for it to equilibrate
before proceeding.

n Return to ambient. [button] Allows the furnace temperature only
(not the sample temperature) to return rapidly to a temperature to
below 45 °C.

End temperature. [text box] The ending temperature for the ramping
procedure. If the CryoCooler is installed, it is automatically enabled if an
ending temperature below 20 °C is used.

Experiment Fields (continued)
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Selections Description
Hold time. [text box] Temperature at which the sample is to be held while
degassing.

Ramp rate. [text box] The rate at which the temperature will change
while advancing to the hold temperature.

Enable KwikCool. Select to use the KwikCool to reduce the furnace
temperature more rapidly during cool down. If selected and the KwikCool
is not attached to the analyzer when the analysis is started, an error
message is displayed. If the CryoCooler (rather than the KwikCool) is
attached, the cool down operation is performed by the CryoCooler.

Termination

Return to ambient temperature. Allows the furnace temperature only
(not the sample temperature) to return rapidly to a temperature between
14 °C and 50 °C.

Enable KwikCool. See Enable KwikCool in Temperature Ramp.

Leave the detector enabled after analysis. Several hours may be
required for the analyzer to reach thermal stability after the detector is
enabled. This option keeps the detector enabled after analysis, allowing
the analyzer to remain stable.

Gas flow through the detector is required while the detector is enabled
but is not necessary if the detector is disabled. It is recommended to flow
an inert gas to continuously purge the system.

Should the analysis be canceled due to an analyzer error, the detector
will be left enabled if this option is enabled. Should the analysis be
canceled, this option is ignored, and the detector is left enabled.

Experiment Fields (continued)

Insert Experiment Steps
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Selections Description
Vapor Calibration

A separate calibration of the TCDmust be made when vapor is to be
used during analysis. The Vapor Calibration experiment allows the
calibration of the TCD so that peak area data can be converted to volume
data. During a Vapor Calibration, one vapor at a series of temperatures is
flowed through the analyzer and the resultant signal readings are
recorded. The analyzer uses this data to calculate the unknown
concentrations of vapors flowing past it during subsequent analyses.

Experiment Fields (continued)
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Selections Description
Wait

Specify a waiting routine.

Wait [n] minutes. [button] Specify the time to wait.

Wait for operator. [button] Enter a description of the operator task.
During an analysis, the entered message displays at the appropriate
time. The analysis continues after the operator clicksOK.

Wait until baseline is stable. [button] Specify if the analysis should wait
until the baseline becomes stable,  then click Baseline to specify the
settings.

Wait for change from baseline or [n] minutes. [button] Specify the
time to wait, clickOK, then click Baseline to specify the settings.

Wait for return to baseline. [button] Waits for a return to baseline. If
enabled, clickOK, then click Baseline to specify the settings.

Wait for digital input number. [button] Enter the number of the digital
input source being awaited, then specify the maximum number of
minutes to wait for input. If the digital input is not received before the time
elapses, the analysis will continue, and a warning message is displayed.
See Auxiliary Inputs and Outputs on page C - 1.

Experiment Fields (continued)
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4 Parameter Files

Selections Description
Zones Click to set the heat zone temperatures.

The Filament temperature must be set at least 20 °C higher than the
Block zone temperature.

The Refluxmust be at least 10 °C cooler than the Flask zone.

If the optional vapor generator is not installed when the analysis is
started, the vapor generator fields are ignored by the application.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Experiment Fields (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
Or, click the Report Options tab when in Advanced option presentation.

The Calculations document can be found on the Micromeritics web page
(www.micromeritics.com).

Additional reports are available using the Reportsmenu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

Report Options
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Selections Description
Edit [button] Select the report in the Selected Reports box. See Selected

Reports on page 7 - 1.
Integration [button] See Peak Detection / Integration Options on page F - 1

Report Options
[drop-down box]

Browse for a .RPO file that contains report options parameters to
be used in the report.

Selected Reports
[group box]

Select the report names to include in the report.

Show graphic [check box] Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the
generated report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Report Options
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5 PERFORM AN ANALYSIS

ANALYSIS TEMPERATURE GUIDELINES FOR ALL ANALYSIS TYPES

n Starting Temperature. Experiments should be started at a temperature that is lower than that
at which the reaction begins. If the reaction begins below ambient temperature, use the
optional CryoCooler.

n Maximum Temperature. The experiment’s maximum temperature is limited to the tem-
perature at which the sample sinters.

n Ramp Rate. The recommended ramp rate is 5-10 °C/min, however a different ramp rate can be
specified. For example, if using 500 °C as the starting temperature of the reaction, it is more
expedient to ramp the temperature rapidly (for example, 50 °C/min.) to a value near 500 °C,
then proceed with the experiment at 5-10 ºC/min.

5 Perform an Analysis
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5 Perform an Analysis

COOLING OPTIONS

The furnace must cool during temperature programmed analyses if:

n a low temperature is required as part of the analysis, or
n to speed cooling of the furnace to increase sample throughput or reduce analysis time.

If cooling is required for the analysis, a CryoCooler may be necessary. Cooling options are:

n Allow the temperature to return to ambient over time. If time is not a consideration, allow
the furnace to cool over time. It may take two hours or more for the furnace to cool from 1100 °C
to near ambient. This may be acceptable when time is not limited.

n Promote cooling by manually opening the furnace. The furnace cools more rapidly when it
is open. This option requires the availability of an operator to open and close the furnace at the
appropriate times during analysis.

When it has been used recently, the furnace and/or the sample tube may be hot. Use
the cotton gloves provided in the accessory kit when handling heated surfaces. These
cotton gloves are not intended to protect hands when heated surfaces are above
60 °C.

n Connect a cooling gas or cryogen flow to the inlet on the front of the furnace. A cooling
flow of an appropriate gas or cryogen can be connected to the inlet on the furnace. Read the
warning listed above. This option can provide rapid cooling of the sample but offers no control
of the target temperature or the speed at which it is achieved. The gas or cryogen must be non-
reactive— such as nitrogen, air, helium, argon, liquid nitrogen, or liquid argon.

n Connect the optional CryoCooler to the inlet in the front of the furnace. The CryoCooler
provides control of the sample temperature to temperatures as low as -100 °C. The CryoCooler
is required for accurate analyses that include signal recording below ambient. The CryoCooler
Operator Manual can be found on the Micromeritics web page (www.micromeritics.com).
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DEWAR PRECAUTIONS

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

n Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

n When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

FOR GLASS DEWARS

n Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or
other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it
has a protective coating.

n Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shat-
tering may occur.

n If the Dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of
flying particles should the Dewar be knocked over, dropped, or broken.

Dewar Precautions
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5 Perform an Analysis

MIXING AN IPA/LN2 SLURRY

An isopropyl alcohol (IPA) /liquid nitrogen (LN2) slurry is used to maintain cold trap
temperatures of approximately -80 °C. Improperly mixing an IPA/LN2 slurry could
cause injury. If the mixture is not stirred continuously, gas may build up under the sur-
face, causing the liquids to splash out of the Dewar.

1. Chill a 600 mL Dewar by rinsing it with LN2. Allow a small amount of LN2 to remain in the bot-
tom of the Dewar (approximately 1 cm deep).

2. Stirring constantly, slowly add approximately 500 mL of IPA. For greatest safety, use
a laboratory squirt bottle. Squirt the stream of IPA along the inside edge of the Dewar, close
to the top of the Dewar, allowing the IPA to flow down the inside wall of the Dewar. Do not
stop stirring the mixture in the bottom of the Dewar, even if stirring becomes difficult. As stir-
ring and adding IPA continues, the mixture will loosen and become easier to stir.

3. When all the IPA has been placed in the Dewar, slowly begin pouring LN2 into the Dewar.
Approximately 1 liter is needed. Continue to stir the mixture as LN2 is added. As ice chunks
form, break them up and stir them down into the mixture. Avoid splashing. Gently knock ice
chunks away from the sides of the Dewar and continue stirring. Add liquid nitrogen until the
slurry is within 25 mm (1 in.) of the top of the Dewar.

4. Lift the stirrer out of the slurry and observe as the slurry drips into the Dewar; the
stirrer should be thickly coated with slurry.

The goal is to achieve a slurry that has a thick, syrupy consistency without large chunks.
When the slurry is cold enough, small pieces of ice may be present (10 - 20% of the
mixture). A little ice accumulation along the sides of the Dewar is acceptable.

PROTECT DETECTOR FILAMENTS BY FLOWING GAS

A carrier gas must be flowing through the detector whenever the detector filaments
are turned on; otherwise, the filaments will deteriorate and lose sensitivity. If the
gases are shut off, the filaments are automatically turned off after five minutes.

The flowing gas also continuously cleans the plumbing of any water vapor which can enter when
the sample tube is removed. Ten cm3/min is sufficient to perform this function.
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PREPARE FOR ANALYSIS
It is recommended to perform the tasks in the provided order.

CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are needed for cleaning. The procedures following the
materials list are recommended.

Supplied by Micromeritics Supplied by User

n Funnel
n Sample data worksheet
n Sample tube
n Sample tube brush
n Sample tube rack
n Sample weighing support
n Stopper for sample tube

n Acetone or isopropyl alcohol
n Analytical balance
n Detergent (such as Alconox)
n Drying oven
n Forceps
n Insulated gloves
n Pipe cleaners
n Rubber gloves or clean, lint-free cloth
n Safety glasses
n Ultrasonic cleaning unit
n Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

Prepare for Analysis
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5 Perform an Analysis

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in
the rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high-purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube
is installed on the analysis port.
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10. Blow out the sample tubes with oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper.

PREPARE THE SAMPLE

To obtain the most repeatable, accurate results:

n Use approximately the same amount of sample for each analysis (especially if data are com-
pared sample to sample).

n Ensure the sample is well dispersed in the tube, not against the side or walls of the tube.
n Ensure the sample particle size distribution remains fairly constant from sample to sample.

(Large particles of a substance reduce at a different rate than small particles of the same sub-
stance.) For samples with a wide particle size distribution, care should be taken that each
sample is representative of the entire lot’s distribution.

Micromeritics recommends analyzing samples weighing between 20 mg and 2 g. When
determining a sample amount, consider that the sample must be contained within the bottom 20
mm (3/4 in.) of the sample tube.

When determining sample size, consider the percentage of active metals in the sample. Materials
with lower percentages of active metals may require larger sample amounts for analysis, while
materials with high percentages of active metals can be analyzed using smaller samples.

Larger amounts of very fine powders may become packed in the sample tube and
block gas flow. The resulting increase in gas pressure may force some of the sample
out of the sample tube, causing contamination of, or damage to the analyzer. A
possible solution is to expand the sample bed with quartz wool.

CREATE THE SAMPLE FILE

Sample Files on page 3 - 2

Prepare the Sample
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5 Perform an Analysis

DETERMINE THE SAMPLE MASS FOR CHEMISORPTION

Use Quartz Filter Discs for Chemisorption on the facing page
Sample Data Worksheet for Chemisorption on page H - 6

Bulb sample tubes are for pellets and other samples without loose particles. Using
powder samples in bulb tubes may cause the loose particles to go into the analyzer's
exhaust.

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Record the sample tube identification on the Sample Data Worksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize

at zero.
3. If analyzing a powder or sample made of fine particles, push a piece of quartz wool all the

way down into the sample tube.
4. If using quartz wool, put a second piece of quartz wool just inside the sample tube.

If using filter discs, push a filter disc down into the tube until it sits on top of the quartz wool.
Place a second filter disc just inside the sample tube.

5. Place the sample tube set (sample tube with quartz wool or filter discs and stoppers) on the
sample support. Record the stabilized mass on the Sample Data Worksheet.

6. Remove the sample weighing support and sample tube set from the balance.
7. Place the sample container on the balance and allow the balance to stabilize at zero.

Do not touch the sample with bare hands. Oil from hands could affect the accuracy of
results.
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8. Slowly add approximately 0.5 to 1.0 gram of sample to the sample container.
9. If a second piece of quartz wool or filter disc was inserted, remove the top portion of the

quartz wool or the filter disc from the sample tube.
10. Use a funnel to slowly pour sample from the container into the sample tube on top of the

quartz wool in the tube.

Ensure all sample in the container is placed in the sample tube to avoid errors caused
by incorrect sample mass.

11. If using quartz wool, insert the top portion of quartz wool into the tube and press it down.
If using filter discs, insert the filter disc into the tube and press it down.

Ensure the disc is flat on top of the sample. A seal must be created around the edge to
prevent the sample from escaping.

12. Wipe the top of the sample tube with a clean, lint-free cloth, such as a Kimwipe®, to remove
any quartz wool that may have adhered to the surface.

13. Weigh the sample tube set containing the sample and the stoppers. Record this mass as
the Sample + tube.

Use Quartz Filter Discs for Chemisorption

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

The use of quartz wool is not mandatory; however, it can provide extra protection for
light powdered samples.

Wear latex gloves when handling the quartz sample tube. The natural oils in human
skin can chemically damage and weaken the quartz tube. It is also important that the
sample tube and its components, as well as the sample and exhaust ports, be clean
and free of debris. Dust particles from quartz wool or the insulator disc of previous
analyses may adhere to the port and/or components, preventing a proper seal of the
sample tube.

Use quartz filter discs or quartz wool to aid in chemisorption sample preparation. Quartz filter
discs (placed both below and above powdered samples) not only provide a more uniform sample
surface but also keep the analyzer free of sample debris. The filters can be used up to 900 °C.

Determine the Sample Mass for Chemisorption
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5 Perform an Analysis

1. Insert a small portion of quartz wool into the sample tube to serve as a support for the
powdered sample. Use a filler rod or smaller sample tube to push the quartz wool to the bot-
tom of the sample tube.

A. Quartz disc
B. Sample
C. Quartz disc and quartz wool

2. Insert a quartz disc into the sample tube and push it into the tube until it rests on top of the
quartz wool. Inspect the disc to ensure that there is a good seal and that the sample will not
go past the filter. An additional filter can be inserted if needed.

3. Insert a second filter disc on top of the quartz wool. Ensure that the filter is placed high
enough into the sample tube for easy retrieval.

4. Take the initial tube weight (with both filters).
5. Remove the top filter disc. Place it on a clean surface, then use a funnel to add the

powdered sample on the bottom filter disc.
6. Reinsert the top filter disc into the sample tube, then use a rod or smaller sample tube to

push it down until it reaches the top of the sample.
7. To remove the quartz wool and disc after analysis, use the quartz wool extractor tool.

SAMPLE TUBE INSTALLATION

Sample Tube on page 9 - 24
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FILL AND INSTALL THE DEWAR

Dewar Precautions on page 5 - 3
Check and Clean the Dewar on page 10 - 15

To surround the cold trap, the Dewar must rest on a small stand. Hold the Dewar beneath the cold
trap, then raise it enough to slide the stand underneath the Dewar. Lower the Dewar until it rests
on the stand. Ensure the cold trap is immersed.

If performing an analysis that requires use of the cold trap and cryogen, check the cryogen level in
the Dewar. It should be approximately 25 mm (1 in.) from the top.

The cryogen must not be cold enough to trap the carrier gas or analysis gas. Do not
use liquid nitrogen with argon carrier gas. For example, use an alcohol and liquid nitro-
gen slurry (-80 ºC).

Fill and Install the Dewar
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5 Perform an Analysis

PERFORM A SAMPLE ANALYSIS
Unit [n] > Sample Analysis
Analysis Tutorials on page 11 - 1

1. From the menu bar, select Unit [n] > Sample Analysis.
2. Click New to create a new sample file, or click Browse to select an existing file.

3. Edit theMass, Empty Tube, and Sample +  fields, as needed.
4. Click Next and select a calibration file for each experiment.

5. Click Next and read the warnings.
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6. Click Start to begin the analysis.

A. Suspend/Resume/Skip
buttons

B. Port report buttons
C. Live graph settings

TheOperation view displays experiment steps and details as steps are performed. Text
colors indicate the progress. Completed steps are shown in green. In progress steps are
shown in light blue. Pending steps are shown in black, dark blue or dark green (depending
on their nesting level).

7. To change steps that have not been started:
n Click Suspend, select the step, then click the appropriate button for modification. 
n Click Resume to continue the analysis.

8. Select the Results view to see the analysis in progress.

Perform a Sample Analysis
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5 Perform an Analysis

9. Click the Live Graph Settings button to hide or show different settings.

RESET THE ANALYSIS
Unit [n] > Reset
Use to abort the current analysis and return the analyzer to a safe state. The following actions
occur:

n All gas flows stop
n The detector is disabled
n The heat zones are reset to 0 °C
n The target furnace temperature is reset to 20 °C

Do not select this option unless you are sure you want to stop the current analysis. The analysis
cannot be resumed after Reset is selected.
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6 ABOUT REPORTS
Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Start
Generates a report on a sample analysis.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > Open Reports
Opens the selected report.

6 About Reports
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6 About Reports

INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a plot of the data collected during
analysis will display.

2. From the view selector drop-down list at the bottom of the window, do either of the following:
n Change the option presentation of the sample description window to either Basic or

Advanced to modify certain file parameters.
n Select another plot from the list and edit the data contained in the plot.

3. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:
n Drag the blue bars to increase or decrease the range of data included in the plot.
n Right-click to display a popup menu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

4. Click Save.

MICROACTIVE REPORTS
This feature provides a quick and easy way to investigate and manipulate analysis data using a
variety of reporting methods.

When a sample file with a status of Complete or Analyzing is opened, a linear plot and log plot of
the data collected during analysis are displayed as well as a summary of the analysis giving the
total pore volume. Numerous reports are accessible from a drop-down menu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters are also displayed. Plots may be edited by selecting the data points or data point
range to be included in the plots and modifying the parameters. When a report is edited, the
results are immediately reflected in the plots and summary data.
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PEAK EDITOR

Analysis condition defaults for metal stoichiometry factors can be set using the
sample information metal table editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis conditions experiment step editor.
If required, stoichiometry factors for a completed pulse chemisorption experiment can
be viewed and modified using the peak editor’s stoichiometry settings window.

The Peak Editor feature provides the viewing and editing of up to 16 dynamic analysis
experiments. The Peak Editor options are accessed by opening a Completed sample file and
selecting a "Peak Editor" entry from the drop-down menu at the bottom of the report window.
Peaks can be defined, edited, or deleted.

Peaks are defined by a baseline. If the Find All Peaks button is clicked (enabled when Edit Peaks
is selected), the Peak Editor will define baselines for all positive peaks detected according to the
Integration window accessed from the Integration button. For Loop calibrations, peaks are found
using events that occurred during the analysis — such as the time an injection started— instead
of peak detection options. The baseline can be manually defined by double left clicking in the
signal graph on the starting baseline point (this places the Peak Editor into baseline creation
mode). The ending baseline point is then defined by left clicking in the signal graph on the ending
baseline point. Baseline creation mode can be exited by right clicking in the signal graph.

Peak Editor
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6 About Reports

PEAK EDITOR VIEW
Open a Sample File on page 3 - 4

When a sample file with a Complete status is opened, three views are available:

n Overlay Experiments View
n Stacked Experiments View
n Peak Editor

To change the view, select the view from the drop-down list at the bottom of the graph window.
Only the Peak Editor view allows editing of the experiment.

Example of
Overlay Experiments view

Example of
Stacked Experiments view
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Example of
Peak Editor view

Selections Description
Calibration
[button]

Calibration. Select a previously defined calibration file. If the
experiment and calibration gases differ, a warning displays. The system
also compares the experiment flow rate and calibration flow rate. If they
differ, a warning displays.

Experiment Information
n Description. Enter a description of the current experiment.
n Type of analysis. Select the analysis type that most closely

describes the current experiment. This will affect what is reported as
part of the Summary report data and the available reports.

n Vapor. Select a vapor before creating or applying a vapor calibration.
This field is only visible for vapor experiments.

n Loop volume. Displays the volume of the gas injection loop.

Peak Editor

Peak Editor
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6 About Reports

Selections Description

n Ambient temperature. Displays the ambient temperature entry from
theOptions > Environmental Defaults setting. This field may be
edited.

n Atmospheric pressure. Displays the atmospheric pressure entry
from theOptions > Environmental Defaults setting. This field may
be edited.

n Active concentration. Displays the percent of the gas mixture which
is composed of the reactive gas versus an inert filler. This value is
used for data reduction, including pulse chemisorption.

n P0 of adsorbate. Displays the saturation pressure of the adsorbate.
n Adsorbate cross-sectional area. Displays the area that a single

adsorbed molecule occupies on the surface of the sample. It is used
in surface area calculations.

n Manual Injections. Displays the injection settings entered during
analysis. This table may be edited.

Create Calibration. Create a signal calibration from the currently
selected experiment.

Delete [button] Clears all peaks from the table and removes all markings from the
peaks.
To delete a single peak, select the peak from the peak table or left click
the peak to enable the Delete Peak button.
n Delete All is available only when the Fit Peaks selection is enabled.
n Delete All Peaks is available only when the Edit Peaks selection is

enabled.
n Delete Peak is available only when the Fit Peaks selection is

enabled.

Delete Baseline
[button]

Removes the baseline from the graph.

Available only when the Fit Peaks selection is enabled.
Display Options
[group box]

Use to change how the data are displayed.

Zero. Select to zero the signal (starting baseline).

Invert. Select to invert the signal (peak).

Hide Peak Marks. Select to hide all marks from peaks.

Smooth. Select to smooth the signal on the display.

n Order andWindow. Enabled when the Smooth checkbox is selec-

Peak Editor (continued)
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Selections Description

ted. The smoothing process uses the Savitzky-Golay filter to fit a poly-
nomial order n into size of the specified window [m].

Find All Peaks
[button]

Defines baselines for all positive peaks detected according to the
Integration window, accessed via the Integration button. Loop
calibrations do not use Integration button settings when finding peaks.

Find All Peaks automatically detects the peaks and draws the baseline
for detection. Place the cursor over one of the baseline end points and
double left click to grab the baseline. Move the cursor to the new
position and right click. Available only when the Edit Peak selection is
enabled.

Gaussian
[drop-down box]

Standard Gaussian curve. Available only when the Fit Peaks selection
is enabled.

Import M.S. [button]
Remove M.S. [button]

Mass spectrometer data can be imported and overlaid in theOverlay
Experiment view. In the Peak Editor view, it is saved as a separate
signal.

Import M.S. Click to import mass spectrometer data. In the bottom
right-hand corner of the pop-up window, select the type of mass
spectrometer file to import (Quadera, Quadstar, MKS, or TAMS). Select
the file, then clickOpen to import the signals.

A popup window prompts the user to sync the temperature data with the
current experiment temperature data.

Remove M.S. Click to remove all previously imported mass
spectrometer signals from the current experiment.

Import standard
peaks [button]

Imports the saved peak parameters from the Edit Peaks view. Available
only when the Fit Peaks selection is enabled.

Peak Editor (continued)

Peak Editor
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6 About Reports

Selections Description
Integration Options
[button]

See Peak Detection / Integration Options on page F - 1.
Interpolation [button] Interpolate Temperature. Select to interpolate the temperature. Click

Range to specify a temperature range. Slide the blue bars on the graph
to indicate the range.

Log Normal Skewed
[button]

A 4-parameter, log-normal shape that allows for skewed peaks. This is
the default peak. Available only when the Fit Peaks selection is enabled.

Peak fit model
[button]

Select the peak shape. Available only when the Fit Peaks selection is
enabled. Options include: Gaussian, Lorentzian, Pearson type VII,
Pseudo-Voight, and Log Normal Skewed (3 and 4).

Sample mass
[text box]

Calculates the mass-specific quantities. Initial value is taken from the
sample information at the start of the analysis.

Peak Editor (continued)
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Selections Description
Snap to Signal
[button]

Places the selected baseline point on the signal curve.

Stoichiometry
[button]

See Active Metals for Chemisorption Analyzers on page 3 - 5.

View Type
[group box]

Edit Peak. Locates peaks via signal integration over a baseline.

Fit Peaks. Locates peaks via function fitting to minimize residual over a
baseline.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Peak Editor (continued)

Peak Editor
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6 About Reports

REPORT FEATURES AND SHORTCUTS
Graph Features and Shortcuts on page 6 - 14

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.

6 - 10 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024



REPORT HEADER SHORTCUTS
Right-click in the report header to display header shortcuts.

Selections Description
Copy header as text Copies the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Opens a dialog box for editing the report title.

Report Header Shortcuts

Report Features and Shortcuts
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6 About Reports

REPORT TOOLBAR
The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list
box, then click Show.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Selections Description
Default Style [button] Specifies default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button] Displays the Print window for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button] Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Report Toolbar

6 - 12 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024



TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Selections Description
Align column Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Edits the report title and/or title font attributes. Click Font to modify
font attributes.

Move column Right-click the column to be moved. SelectMove column on the short-
cut menu and select Left or Right for the move.

Rename column Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font Right-click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Tabular Report Shortcuts

Report Features and Shortcuts
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GRAPH FEATURES AND SHORTCUTS
Right-click in the graph area to display graph report shortcuts.

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy graph Copies the graph to the clipboard. It can then be pasted into other
software programs.

Delete baseline Deletes the baseline from the graph

Edit axis Edits the selected axis properties.

Gridlines. Changes how to display major / minor grid lines.

Scale.
n Autoscale minimum/maximum. To manually specify minimum /

maximum autoscale, deselect the option and enter the new
amount in the text box.

n Invert scale. Inverts the scale.
n Linear/Logarithmic. Scales the graph as linear or logarithmic.
n Scale font. Modifies the font for the scale label. Deselect Use

default font to enable font options.

Title. Edits the selected axis label.

Title font.Modifies the font for the selected axis label. Deselect Use
default font. Select new font attributes for report data. Enable Use
default font to reset default fonts.

Graph Shortcut Options
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Selections Description
Edit curve Edits selected curve properties.

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Style. Selects another style for the collected data curve.

Title. Changes the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Graph Shortcut Options (continued)

Graph Features and Shortcuts
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6 About Reports

Selections Description
Edit legend Changes the legend location and font.

Edit title Changes the report title.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Graph Shortcut Options (continued)

AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of
Axis cross-hair feature
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ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Selections Description
Grid Line Styles
[selection]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the
logarithmic and linear scales. Deselect this option to remove the grid
lines.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Graph Grid Lines

Graph Features and Shortcuts
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6 About Reports

REPORT EXAMPLES FOR AUTOCHEM ANALYZERS

FIRST ORDER KINETICS REPORT
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SIGNAL VS. TEMPERATURE REPORT

Signal vs. Temperature Report
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SIGNAL VS. TIME REPORT
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SUMMARY REPORT

Summary Report
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7 SELECTED REPORTS

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

ADVANCED REPORTS - PYTHON MODULE

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

Advanced Reports

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 11 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

7 Selected Reports
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7 Selected Reports

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. On the Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.

Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Advanced Reports
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BET SURFACE AREA REPORT

Selections Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Deselect report
options to exclude from the experiment. If this is a new file, no
experiments are listed. Experiments are not included in the list until
BET data are collected.

Report Type [group box] Select the report types to generate.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

BET Report

BET Surface Area Report
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7 Selected Reports

FIRST ORDER KINETICS REPORT

Selections Description
Plot [check box] Select to have the report formatted in a graph format.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

Tabular Report
[check box]

Select to have report formatted in table format.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

First Order Kinetics Report
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GRAPH REPORT OPTIONS

n Input Signal [n] vs Temperature [n]
n Input Signal [n] vs Time [n]
n TCD Concentration vs. Temperature
n TCD Concentration vs. Time

n TCD Signal and Concentration vs. Time
n TCD Signal vs. Temperature
n TCD Signal vs. Time
n Temperature vs Time

Any signal (the detector signal or the 1 or 2 auxiliary signal) may be plotted against time or
temperature. Any signal can be overlaid onto the primary signal.

For color output to a monitor or printer, signals are displayed in different colors. For black and
white output, different symbols are used.

Selections Description
Mass spec [group box] Autoscale.When enabled on the report parameters windows,

allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.

Graph Report Options

Graph Report Options
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7 Selected Reports

Selections Description
Options [button] Enabled when the Show peak marks option is selected.

Lists the peaks for the results of the highlighted experiment. Select
any (or all) peaks to include in the graph.

Select the peak labels to display on the graphs.
Overlay [group box] Specify overlay options to include in the report.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown. This option is disabled for new files.

Show peak marks
[check box]

n Enables theOptions button to specify the peaks to include in the
experiment.

n Displays the areas and baselines on the graph.
n Draws a straight baseline between the selected peaks.

X-axis [group box] Specify Time or Temperature for the x-axis variable.

Autoscale.When enabled on the report parameters windows,
allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.

Graph Report Options (continued)
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Selections Description
Y-axis [group box] Specify Time or Temperature for the y-axis variable.

Autoscale. When enabled on the report parameters windows,
allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.

Linear/Logarithmic. Scales the graph as Linear or Logarithmic.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Graph Report Options (continued)

LANGMUIR REPORT

BET Surface Area Report on page 7 - 3.

Langmuir Report
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7 Selected Reports

LOOP CALIBRATION REPORT

Selections Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Loop Calibration Report

OPTIONS REPORT

Options reports cannot be edited.

Options Report for AutoChem

Produces a printed report of predefined collection of sample file parameters.

n Active metals
n Analysis conditions
n Report options
n Sample information
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Options Report for Chemisorption

Produces a printed report of a predefined collection of sample file parameters. If Automatically
collected is selected in the Type of Data group box on the Sample Description tab, the following
information is reported:

n Task Summary. Lists conditions specified for each task selected.
n Analysis Task Options. Details conditions specified for the analysis task.
n Experiment Log. Identifies actual conditions under which each task transpired.
n Leak Test Results. Identifies outgas rates and the outcome for each leak test performed.

Options Report for Physisorption

Lists the conditions used to perform the analysis such as:

n Adsorptive properties
n Analysis conditions
n Analysis method
n Degas conditions
n Free space
n Saturation pressure (P0) and temperature

Options Report for Dynamic Analysis

Produces a printed report of predefined collection of sample file parameters.

Options Report for Mercury Porosimetry

TheOptions report for mercury porosimetry analyses lists the conditions used to perform the
analysis— such as:

n Analysis conditions
n Evacuation options
n High pressure options
n Low pressure options
n Material properties

n Mercury properties
n Penetrometer properties
n Reverberi options
n Sample information

Options reports cannot be edited.

Options Report
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7 Selected Reports

Options Report for Pycnometry Analyzers

TheOptions report provides information on the sample, its material properties, and analysis
conditions. This report cannot be edited.
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OPTIONS REPORT

Produces a printed report of predefined collection of sample file parameters.

n Active metals
n Analysis conditions
n Report options
n Sample information

Options Report

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 7 - 11



7 Selected Reports

PULSE CHEMISORPTION REPORT

Selections Description
Area to Volume
Conversion
[group box]

Calculated. Uses the standard calculation and the raw signal.

Calibrated. Uses selected peaks for the conversion. A calibration
step must be included in the experiment to use this method.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Pulse Chemisorption Report
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Situation 1 Pulse adsorption experiment, no calibration applied in peak editor, report
option is Calculated.

Situation 2 Pulse adsorption experiment, no calibration applied in peak editor, report
option is Calibrated.
Report displays an error message that calibration is not found and uses the
formula from Situation 1.

Situation 3 Pulse adsorption experiment, calibration is applied in peak editor, report
option is Calculated.

Situation 4 Pulse adsorption experiment, calibration is applied in peak editor, report
option is Calibrated.

Situation 5 Pulse reaction experiment, no calibration applied in peak editor, report option
is 'Calculated.

Situation 6 Pulse reaction experiment, no calibration applied in peak editor, report option
is Calibrated.

Report displays an error message that calibration is not found and uses the
formula from Situation 5.

Situation 7 Pulse reaction experiment, calibration is applied in peak editor, report option
is Calculated.

Situation 8 Pulse reaction experiment, calibration is applied in peak editor, report option
is Calibrated.

Quantity Adsorbed Formulas

Pulse Chemisorption Report
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7 Selected Reports

where

Aend = Area of the last peak, shown as Peak Area in peak editor
Ax = Area of peak #X, shown as Peak Area in peak editor
AvgfirstN = Average of first N peak areas
AvglasttN = Average of last N peak areas
L = Loop quantity calculated from the injection volume, ambient

temperature, ambient pressure, and active gas concentration.

Masssample = Sample mass (grams)
N = Use the last N peaks for saturation in the Pulse Chemisorption Report

Options. For pulse reaction experiments (where gas is emitted by the
reaction and peak areas decrease over time) this is the first N peaks.

Qadsx = Quantity Adsorbed per gram for peak #X, shown in the Pulse Chemisorp-
tion Report's peak table. The report sets negative values to 0.0. To get
total quantity adsorbed, multiply by Masssample and sum across peaks.

Qend = Quantity of the last peak, shown as Peak Quantity in peak editor.
Qx = Quantity of peak #X, shown as Peak Quantity in peak editor

SUMMARY REPORT

The Summary Report for dynamic analyses provides a condensed summary of the peaks and
selected analysis parameters.
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TOTAL PORE VOLUME REPORT

Selections Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Deselect report
options to exclude from the experiment. If this is a new file, no exper-
iments are listed. Experiments are not included in the list until BET
data are collected.

Adsorbate density con-
version factor [text box]

Enter the appropriate value for converting the gas volume to liquid
volume. This value can be obtained by dividing the gas density by
the liquid density at the adsorption temperature.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Total Pore Volume Reports

Total Pore Volume Report
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8 CALIBRATION
Unit [n] > Instrument Calibration

A calibration file was created specifically for the analyzer and included with the
accessories. It is not necessary to recalibrate the system unless it seems out of cal-
ibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

8 Calibration
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8 Calibration

Selections Description
Accept [button] Replaces the existing calibration values with those entered.

Load from File [button] Loads a different calibration file.

MFC Full Scale [button]

Displays the full scale flow rate for the mass flow controllers. The full
scale was determined using H2 as the calibration gas.

Save to File [button] Saves the current calibration settings to a file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Calibration
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GAS CONCENTRATION CALIBRATION
Sample Files on page 3 - 2

After performing an analysis, peak area data can be converted to volume data. The application
can perform this conversion when additional information is provided.

In some cases (such as in TPR analyses), the analyzer needs to know how to correlate the signal
readings collected in the analysis with the volume of gas uptake at any given point in the analysis.
If the analyzer is provided with a series of known gas concentrations, and it records the signal
associated with each known concentration, then it can use this information to calculate the
concentrations associated with the signals it recorded during the analysis. From that point, it can
also calculate the volume of gas associated with each peak in the data.

1. Prepare and install a clean, empty sample tube.
2. Ensure the correct gases are connected.
3. Create the sample file:

a. Go to File > New Sample.
b. Complete the fields on the Sample Description tab as needed.

4. Select the Analysis Conditions tab.
5. Click Insert and selectGas Calibration.
6. ClickOK.

Gas Concentration Calibration
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8 Calibration

7. Select Hydrogen-Argon for Carrier.
8. Select Argon for Loop.
9. Enter 50 as the Flow rate.
10. Click Zones to set the temperature for the analyzer’s heated zones.
11. Complete the fields in the Set Temperature Zones window using the following table:

Field Enter
Analysis 110 °C

Block Zone 100 °C

Cold Trap 110 °C

Filament 175 °C

Set Temperature Zones Settings

12. ClickOK to close the Zones window.
13. ClickOK again to close the Calibration window.
14. Click Save As, provide a new file name, then click Close.
15. Go to Unit [n] > Sample Analysis.
16. Click Browse to locate sample file previously created.
17. Click Next three times in this sample file.
18. Click Start to start the analysis. Use the other views of the analysis window to observe the

progress of the analysis.

During the automatic analysis, the analyzer decreases the proportion of the analysis gas in
10% increments, beginning with 100% and ending with 0%. The resultant data should
appear as a series of ten stepwise changes in the TCD signal.

19. When the analysis ends, close the Analysis window.
20. When the displayed sample temperature reaches the ambient temperature, open the fur-

nace and remove the sample tube.
21. Go toOptions > Signal Calibration > Open. Select the calibration file, then clickOK.
22. Click Load Calibration Data then select the sample file for this calibration, then clickOK.
23. ClickOK. The data in the sample file are automatically inserted into the appropriate fields of

the Signal Calibration window

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

24. Assess the data listed in the table. In the Concentrations column, enter the starting and end-
ing gas mixture percentages. The application calculates the percentages for the rest of the
table.
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25. Assess the gas concentration plot, Goodness of Fit, and Coefficients to determine if the
calibration file is acceptable. Use your laboratory’s standards to determine what level of
linearity is acceptable. As a general guideline, use a calibration file with a very low value for
Goodness of Fit (less than 1/2% of the maximum concentration) when 1st or 2nd Degree is
specified.

Data points that deviate significantly from linear can be deleted. Evaluate the results when
the degree is changed (select a different degree from the drop-down list).

26. When satisfied with the calibration file, enter a descriptive name in the Description field.
27. Click Save, then click Close.
28. Go toOptions > Signal Calibration > Report to select a report to generate.

Gas Concentration Calibration
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GAS FLOW CALIBRATION
Unit [n] > Gas Flow Calibration
Gas Charts on page E - 1

Use theGas Flow Constant Calibration option to determine a constant used by the analyzer to
ensure accurate gas flows through each Mass Flow Controller (MFC). The Mass Flow Controllers
were calibrated before shipping and calibration is typically not necessary.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic. Flow the gas to be calibrated through MFC to be used for the calibration.

2. Connect a flow meter to the exhaust and measure the actual flow rate.
3. In theGas drop-down box, select the gas to be flowed. In the Actual flow field, enter the

actual flow rate to compute the mass flow constant.
4. Click Accept to change the mass flow constant in the Adsorptive Properties for the gas to

be the computed value.
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SIGNAL CALIBRATION FOR DYNAMIC ANALYSIS
Analyses yield data on signal reading, peak area, temperature, and time. These data are sufficient
for many applications; however, volume data may also be needed.

It is not necessary to perform a calibration if volume data are not needed. If volume data are
needed, calibration may be performed either before or after the analysis.

This does not apply to loop calibration, ambient temperature, and atmospheric pres-
sure.

A group of automatic calibration routines is provided in the form of specialized experiment steps. A
calibration run is an analysis using one of these experiment steps. The calibration run can be
performed before or after the sample analysis. It can be included as a step within the analysis, or
performed as a separate analysis.

After the sample data and calibration data are collected, the calibration file is associated with the
sample file, and the sample data are converted to volume. A single calibration run can be
associated with an unlimited number of sample data files. For example, TPR yields peak area and
the temperature at which maximum reduction occurs. To obtain the volume of gas uptake, a
calibration file must be associated with the analysis file. Then, reports are created in which the
area data are converted to volume data.

A calibration file can be associated with a sample file by doing the following:

n Using the default file or choose a different file in the Unit [n] > Sample Analysis window.
n Clicking Set Calibration on the Peak Editor window and select from a list of calibration files cre-

ated after the sample file was used in an analysis.

Signal Calibration for Dynamic Analysis

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 8 - 7



8 Calibration

CREATE A NEW SIGNAL CALIBRATION FILE
Options > Signal Calibration > New

When selecting a Signal Type and Type of Calibration, only those options used in the original
analysis are enabled on the right side of the window.

1. Select the sample file to use for the new signal calibration file.
2. Select the Signal Type and Type of Calibration options to include in the new calibration file.

As selections are made, the experiments from the selected analysis file display on the right
side of the window. Only those experiments applicable to the selected signal type and cal-
ibration type are enabled. ClickOK.

3. If prompted, enter the active gas concentration in the carrier gas and loop gas. ClickOK.
4. Delete (or edit) data in the Peak Table as appropriate. Click Save.
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Selections Description
Degree [drop-down box] Select the power to display in the Coefficients list.

Delete Peak [button] Removes a peak from the peak table. Select the peak and click
Delete Peak.

Description [text box] Enter a description of the file.

Include origin
[check box]

Enables or disables the original in the graph.

Load Calibration Data
[button]

Use to enter calibration data from a selected file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Signal Calibration

CREATE A SIGNAL CALIBRATION REPORT
Options > Signal Calibration > Report

Select a previously defined signal calibration file from the drop-down list, then select the print
destination.

Signal Calibration for Dynamic Analysis
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OPEN A SIGNAL CALIBRATION FILE
Options > Signal Calibration > Open
Select a previously defined signal calibration file from the drop-down list. If a calibration file
already exists, select the serial number from the drop-down serial number list. When a new
calibration file is saved with a new serial number, the new serial number displays in the Serial
Number drop-down list.

If this is the first calibration file to be saved, the Serial Number drop-down will not display until the
first calibration file is saved.
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LIST SIGNAL CALIBRATION FILES
Options > Signal Calibration > List

Displays a list view of previously defined signal calibrations for the selected serial number.

Signal Calibration for Dynamic Analysis
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VAPOR CALIBRATION

Values and screen shots in this topic are for a typical vapor calibration for pyridine.

When using the optional vapor generator, it must be calibrated for the type of vapor to be used.
Associating the analysis data with a vapor generator calibration file allows the conversion of peak
area data to volume data. The calibration can be performed either before or after performing the
analysis. A single calibration file can be used with multiple analysis files.

1. Go to File > Open > Sample information. Enter a calibration file name (.CAL). ClickOK,
then click Yes to confirm.

2. Complete the remaining fields on the Sample Description window as needed.

If the window displays in Basic presentation, click Advanced in the view selector drop-
down at the bottom of the window.

3. Select the Analysis Conditions tab. Click Insert, then select Vapor Calibration.

4. Complete the window using these entries:

Selections Description
Calibration Gases
[group box]

Select Helium. Enter a flow rate of 50 for each.
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Selections Description
Reflux Temperatures
[group box]

Enter a minimum of 70 and maximum of 80.

Flask Temperatures
[group box]

Enter a minimum of 80 and maximum of 100.

Number of steps
[text box]

5

Recording Options
[group box]

Select the signal. It is a good idea to select this option when using
helium for the carrier gas. It improves the performance of automatic
peak picking.

Zones [button] Field Enter
TCD Detector

Block zone 100

Filament 175

Valve Zones
Cold trap 110

Analysis 110

Loop 110

Vapor generator 20

Vapor Generator
Reflux 20

Flask 20

Outputs [button] See Auxiliary Inputs and Outputs on page C - 1 .

5. ClickOK to close the Set Temperature Zones window, then again to close the Vapor Cal-
ibration Experiment window.

6. Click Save As, enter a file name, then click Close.
7. Go to Unit [n] > Sample Analysis. Click Browse and select the sample file just created.
8. Click Next three times to accept the values contained in this sample file. These values can

be edited, however, no changes are needed for this example. Click Start.
9. Use the other views of the Analysis window to observe the progress of the analysis.
10. When the analysis completes, close the Analysis window.

Vapor Calibration
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11. When the displayed sample temperature reaches the ambient temperature, open the fur-
nace. Use gloves and remove the sample tube. These fields do not require editing; the
Reflux and Flask temperatures entered on the Vapor Calibration Experiment window are
used.

12. To edit the calibration file, go toOptions > Signal Calibration > New.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

a. Select Load Calibration Data and select the sample file for this calibration; the data con-
tained in the file are automatically loaded.

b. Access the Calculations document on the Micromeritics web page (www.-
micromeritics.com) for information on calculating the volume of each vapor injection,
then enter the values for each peak.

c. Assess the plot,Goodness of Fit, and Coefficients to decide if the calibration file is
acceptable. Use your laboratory’s standards to determine what level of linearity is
acceptable. As a general guideline, use a calibration file with a very low value forGood-
ness of Fit (less than 1 to 2% of the signal), when 1st or 2nd Degree is specified.

d. To delete any peaks that are outliers, highlight the peak data in the table and click
Delete Peak. Evaluate the results when the degree is changed (select a different
degree from the drop-down list).

e. When satisfied with the calibration file, click Save then click Close.

8 - 14 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024

http://www.micromeritics.com/
http://www.micromeritics.com/


LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration
file, a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten
each time a new one is created.

Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number
2013-04-25 Date the calibration file was saved
.CAL File name extension

Load Calibration from File
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9 HARDWARE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.micromeritics.com).
n CryoCooler II and CryoCooler III Operator Manual (PDF)
n Error Messages document (PDF)
n Parts and Accessories

COLD TRAP TUBE OR DELAY PATH
A Cold Trap option is available. Parts and accessories are located on the Micromeritics web page.
The cold trap or delay path is installed in the ports located under the top panel, to the left of the
sample tube ports.

n A cold trap is used to condense liquids out of the gases flowing through the analyzer before
reaching the detector.

n A delay path is used to reduce the perturbation (disturbance) of the gas flow caused by injec-
tions of gas through the septum.

A. Diversion ports
B. Cold trap or Delay path (cold trap

shown)

1. Insert the open ends of the cold trap or delay path into the openings under the upper panel.
If difficult to insert, loosen the attachment nuts by unscrewing them slightly.

9 Hardware
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9 Hardware

A. O-ring
B. Ferrule
C. Retaining nut

NOTE: The same components are used with the
delay path

If the nuts are loosened until they become free of the analyzer, they will fall out of the
analyzer.

2. Press the cold trap or delay path up into the analyzer until it comes to a stop. Securely
tighten the fittings.

Do not overtighten the fittings. A sufficient seal is achieved when the fittings are finger
tight.

3. The use of a Dewar reduces the temperature of the cold trap. To use a Dewar:
a. Fill the Dewar with the appropriate coolant.
b. If using the Dewar shelf, hook the shelf on the front of the analyzer and slide the shelf to

the right. Position the Dewar beneath the cold trap and raise the Dewar until the shelf
can be moved to the left underneath the Dewar. Lower the Dewar to rest on the shelf.

c. If using the Dewar stand, position the Dewar beneath the cold trap and raise the Dewar
until the stand can be moved underneath the Dewar. Lower the Dewar to rest on the
stand.

d. Ensure the cold trap is completely immersed in the coolant.
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CHANGE OR CLEAN THE COLD TRAP OR DELAY PATH
The cold trap removes condensibles from the gas stream, therefore it will require occasional
cleaning. The delay path (used for BET analyses) also attaches to the cold trap port fittings.

1. If a Dewar is around the cold trap, raise the Dewar slightly, move the Dewar stand out of the
way, and remove the Dewar. Allow the cold trap to warm to room temperature.

Depending upon the state of the analyzer, the cold trap fittings may be hot. Use the
cotton gloves provided in the accessory kit when handling heated surfaces. These cot-
ton gloves are not intended to protect hands when heated surfaces are above 60 °C.

2. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic. Right-click on the cold trap valve and select Bypass.

A. Cold trap valve
B. Cold trap heat zone

3. Loosen the retaining nuts on the cold trap port fittings.

Cold Trap Tube or Delay Path
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9 Hardware

A. O-ring
B. Ferrule
C. Retaining nut

NOTE: The same components are used with the
delay path

4. Remove the cold trap (or delay path), nuts, ferrules, and O-rings.
5. Clean the cold trap (or delay path) by flushing it with isopropyl alcohol (IPA). Dry the trap in

an oven or by blowing compressed air or nitrogen through it before replacing it.
6. Inspect the O-rings for cracks or other damage that might cause leaks. If the O-rings are

cracked or damaged, replace them before reinstalling the cold trap (or delay path). Other-
wise, clean, dry, and re-install the O-rings.

Use only Kalrez O-rings. Kalrez is rated for both chemical and temperature suitability
in this application. O-rings of other materials could burn, melt, or decompose.

7. Place the retaining nuts, ferrules, and O-rings on the cold trap (or delay path).

Do not over tighten the retaining nuts. Doing so may damage the O-rings. Finger tight
is sufficient.

8. Hold the cold trap (or delay path) in place and tighten the retaining nuts. Tighten the nuts
only enough to hold the cold trap securely in place and prevent leaks.
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FURNACE
When performing BET analyses, the furnace must be removed to allow placement of a cold bath
Dewar around the sample.

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

FURNACE REMOVAL

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

1. Unplug the furnace power plug and the thermocouple cable from the analyzer

A. Latch
B. Furnace thermocouple
C. Furnace power plug

2. Release the latch on the left side of the furnace, then open the furnace.

Furnace
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9 Hardware

Support post

3. Gently lift the right side of the furnace until it is free from the support post.

Retaining knob

4. Lower the furnace, moving it away from the support post until it is free of the retaining knob.
5. Close the furnace and secure the furnace latch. Place the furnace in a location where it will

be protected from damage.

9 - 6 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024



FURNACE INSTALLATION

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Hold the open furnace next to the furnace support post. Lift the furnace, moving it above the
support post until the retaining knob is inserted in the hole in the top of the furnace.

Retaining knob

2. When the retaining socket on the bottom of the furnace is located above the support post,
gently lower the furnace until it rests securely on the post.

Furnace
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9 Hardware

Support post

3. When ready to begin the experiment, close the furnace around the sample tube and secure
the latch.

4. Plug the thermocouple cable and the furnace power cable into the appropriate connectors
on the analyzer. . These connectors are located on the recessed front panel.
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KWIKCOOL
A KwikCool unit allows the furnace to cool quickly between analyses.

1. Power OFF the analyzer.
2. Attach the KwikCool cable to the connector labeled Sub Ambient Cooler on the front panel

of the analyzer.
3. Attach the tubing provided to the inlet on the front of the furnace.
4. Attach a supply of dry house air (or nitrogen) to the gas inlet on the front of the KwikCool.

The pressure is indicated next to the inlet.
5. Fill a Dewar with an ice water bath.
6. Place the KwikCool on top of the Dewar.

A. Gas inlet
B. Dewar
C. Subambient cooler connector

7. Power ON the analyzer and start the analysis application.
8. In the experiment, select the Enable KwikCool option in the Temperature Ramp window.

KwikCool
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KWIKCOOL VORTEX INSTALLATION

The optional KwikCool Vortex uses compressed air to generate a sub ambient supply of air to the
furnace to allow rapid cooling.

This kit includes:

n 1 KwikCool unit
n 1 Clear urethane tube to connect to clean dry compressed air
n 1 Swagelok fitting to connect the Vortex Cooler to the urethane tube for the supply of clean dry

compressed air

To install the KwikCool Vortex:

1. Connect the KwikCool Vortex electrical cable to the front panel of the analyzer at the con-
nector labeled Sub Ambient Cooler.

2. Push the flexible hose from the front of the KwikCool Vortex onto the short metal tube at the
center front of the furnace.

3. Connect the compressed air tubing to the Swagelok fitting and then connect the Swagelok
fitting to the 1/4 in. tube on the front of the KwikCool Vortex.

4. Connect the other end of the compressed air tubing to any clean, dry compressed air sup-
ply, at approximately 100 psig. Do not exceed 120 psig.

Do not exceed 120 psig. The KwikCool Vortex system uses about 2 cfm of air when
running. Nitrogen or other inert gas may also be used. If a gas cylinder is used, the
KwikCool Vortex will consume the cylinder of gas quickly, depending on the cylinder
size.

5. Restart the analyzer application so the application will recognize the new hardware.
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MASS FLOW CONTROLLER CALIBRATION
Gas Charts on page E - 1

The analyzer uses a Mass Flow Controller (MFC) to control the flow of gases. The MFC requires a
conversion constant for each gas or gas mixture to compensate for variations in gas flows
resulting from variations in the gas properties.

In most cases, the default MFC conversion constant yields accurate data. A new conversion
constant may be used if:

n A unique gas mixture is used.
n The gas to be used is not included in the table.
n A higher precision calibration of the MFC for a given gas is required.
n Unexpected analysis data lead you to believe that the default value is in error.

FLOW MEASUREMENT

An external device that measures the flow of gas from the analyzer’s exhaust is used during MFC
calibration. A soap bubble burette is such a device.

For even more precise calibration, use another type of flow meter and follow these instructions for
obtaining a new conversion constant, substituting your flow meter for the soap bubble burette.

Mass Flow Controller Calibration
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INSTALL A SOAP BUBBLE BURETTE OR OTHER TYPE OF FLOW METER

These instructions are for assembling and using a burette obtained fromMicro-
meritics. If using another type of flow meter, follow the meter manufacturer’s assembly
and operation instructions.

1. Carefully unwrap the glass tube and the rubber bulb.
2. Attach one end of the flexible tubing to the side arm of the glass tube.
3. Attach the metal tubing provided with the bubble burette to the other end of the flexible

tubing.

A. Exhaust port
B. Flexible tubing
C. Bulb filled with leak detector

4. Locate the exhaust port that corresponds to the MFC to be used for this calibration.
5. Remove external plumbing from that port and attach the bubble burette using the connector

provided with the burette. The soap bubble burette must be held in an upright position. For
example, if using the Carrier Flow Controller, attach the bubble burette to the carrier gas
exhaust port.

6. Attach the bulb to the bottom of the glass tube.
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DETERMINE THE GAS FLOW CONSTANT FOR INDIVIDUAL GASES

Unit [n] > Gas Flow Calibration

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Flow the gas to be calibrated through the Carrier gas MFC and sample tube.
3. Connect a flow meter to the exhaust and measure the actual flow rate. If using a bubble bur-

ette, observe a bubble as it rises through the glass tube. The lines on the glass tube indicate
the beginning and ending points for measuring the progress of a bubble through the tube.
Use a stopwatch to measure the amount of time that elapses from the moment the bubble
passes the lower mark on the tube until the moment it passes the higher mark on the tube.

4. Go to Unit [n] > Gas Flow Calibration.
5. Select the gas being flowed.

6. In Actual flow field, enter the actual flow rate to compute the mass flow constant.
7. Click Accept to change theMass flow constant field in the Adsorptive Properties for the gas

to the computed value.

Determine the Gas Flow Constant for Individual
Gases
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SAMPLE THERMOCOUPLE

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

THERMOCOUPLE POSITION

Use the Thermocouple Clamp on page 9 - 21

The thermocouple must be attached to the analyzer prior to running an analysis. There are three
possible configurations for the thermocouple:

n inside the sample tube
n inside the sample tube surrounded by a quartz sheath
n outside the sample tube

Best accuracy is obtained when the bare thermocouple is placed inside the sample tube. In some
cases, one or more of the gases used during the experiment may react with the thermocouple's
Inconel material. A quartz sheath is provided to protect the thermocouple when the gases or
sample used in the experiment may damage it. In this case, the sheath is placed around the
thermocouple and the thermocouple is positioned inside the sample tube. When placed inside the
tube, the thermocouple can be adjusted so that the end is in the sample or just above it. Always try
to position the end of the thermocouple as close to the furnace thermocouple as possible.

Positioning the thermocouple along the exterior of the sample tube is less accurate than the other
configurations. If the thermocouple is placed outside the sample tube, ensure it is clamped against
the sample tube, and that the end does not extend below the point where the sample tube begins
to taper.

1. Power OFF the analyzer, then disconnect the analyzer from the power source.
2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the

handle. Use the handle to open the hinged top panel.

9 - 14 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024



3. Pull down the upper front panel.

4. The valve cover is held in place by two knobs or plungers. Remove the valve cover by
pulling the plungers outward until the valve cover is released. Pull the cover up and out.

5. Remove the insulation that surrounds the valve. The thermocouple ports are located toward
the front of the block.

Thermocouple Position
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9 Hardware

The sample thermocouple and nearby components may be hot. Allow the sample ther-
mocouple to cool before removing. Use the cotton gloves provided with the analyzer
to protect your hands. If the zone is not near room temperature, loosening or tight-
ening the fittings may damage the analyzer components.

A. Left port
B. Right port

n Use the left port to place the thermocouple outside the
tube.

n Use the right port to place the thermocouple inside the
tube

6. Disconnect the thermocouple connector.
7. Use an open-ended wrench to loosen the sample thermocouple fitting.
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The sheath is very fragile and can be easily broken. Because the sheath is made of
quartz, cotton gloves must be worn when handling the sheath. Oils from fingers may
lower the quartz melting point.

8. Adjust the thermocouple:
To change the position: a. Loosen the fitting for the stainless steel plug in the alternate

thermocouple opening and remove the plug.
b. Remove the fitting that retains the sample thermocouple.
c. Move the sample thermocouple from its current position to the

new position.
d. Place the stainless steel plug in the unused thermocouple

opening and tighten the fitting. Reinstall the sample ther-
mocouple retaining screw.

If using the quartz sheath, perform the following before
proceeding. The sheath can only be used when the
thermocouple is being placed inside the sample tube.

i. Remove the ferrule from the thermocouple, straighten
the thermocouple as much as possible.

ii. Insert the thermocouple into the sheath.
iii. Place a larger ferrule around the sheath.

To adjust the length: See Determine the length of the thermocouple on the next
page. Adjust the thermocouple wire up or down as needed.

9. Tighten the thermocouple fitting.
10. Place the insulation in its original position. Reinstall the valve cover.
11. Return the upper front panel and the top panel to their original closed positions.
12. Power ON the analyzer.

Thermocouple Position
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DETERMINE THE LENGTH OF THE THERMOCOUPLE

When adjusting the length of the exposed portion, consider the following:

A. Thermocouple
B. Recessed area inside furnace
C. End of thermocouple should be 2 to 3 mm

(1/8 in.) above the sample

n The end of the thermocouple should be aligned as closely as possible with the furnace ther-
mocouple.

n The end of the thermocouple should never be placed outside the painted (black), recessed
area inside the furnace.

n If the thermocouple is positioned inside the tube, its end should generally be located approx-
imately 2 to 3 mm (1/8 in.) above the sample surface. In some cases, allow the thermocouple to
extend into the sample.

n If the thermocouple is positioned outside the tube, its end should not extend below the point
where the sample tube begins to taper.

METAL TUBES

When using metal tubes, it may be helpful to use the dipstick included with the analyzer
accessories to determine the appropriate length of the sample thermocouple. At times, a small
amount of sample may adhere to the dipstick. When using very small amounts of sample for an
analysis, the amount that adheres to the dipstick may affect analysis results.

1. After inserting the quartz wool and sample into the sample tube, insert the dipstick into tube.
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A. Dipstick sleeve
B. Dipstick rod

Dipstick shown inverted in second
image

2. When the dipstick reaches the sample, gently press down on the sleeve until it is flush with
the top of the sample tube.

3. Remove and invert the dipstick.

The exposed rod indicates the approximate length for the
external portion of the thermocouple

Determine the length of the thermocouple
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4. Place the inverted dipstick on the underside of the analysis port close to the thermocouple.
Place it on a flat surface and not into one of the openings in the port.

A. Distance between the thermocouple and dipstick
should be 2-3 mm (1/8 in.)

B. Thermocouple
C. Port
D. Exposed rod of dipstick

The end of the thermocouple should be 2 to 3 mm (1/8 in.) above the exposed rod. If it is not,
adjust the thermocouple length as needed.
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USE THE THERMOCOUPLE CLAMP

If the thermocouple is placed outside the sample tube, a clamp must be used to secure the
thermocouple to the sample tube.

A. Do not allow the thermocouple to extend below the
point where the sample begins to taper

B. Thermocouple
C. Clamp
D. Sample tube

Use the Thermocouple Clamp
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RECALIBRATE THE SAMPLE THERMOCOUPLE

Calibration on page 8 - 1

A calibration file is created specifically for each analyzer before the analyzer is shipped. This
calibration file is installed during installation. If the original calibration file is corrupted or missing,
or if the sample thermocouple is replaced, recalibration will be needed.

Do not attempt to calibrate anything other than the sample thermocouple without prior
approval from a qualified Micromeritics Service Representative.

Prior to recalibration, ensure:

n The analyzer is powered ON and the application is running.
n All heat zones to be calibrated are stabilized at ambient temperature.
n Familiarity with manually controlling the analyzer.
n All gas flows through the analyzer are stopped.
n The furnace is open, and the sample tube is removed (the thermocouple is bare and exposed).
n A traceable thermocouple meter and a water bath (ambient temperature) to immerse the

sample thermocouple are available.

1. Go to Unit [n] > Instrument Calibration.

2. Place the water bath around the thermocouple so that the lowest 25 mm (1 in.) is immersed
in the water. Place the thermocouple meter (reference thermocouple) parallel to the sample
thermocouple so that both thermocouples are at the same temperature.

3. After the reference thermocouple meter reading stabilizes, enter the ambient temperature
reading in the Low Cal. field on the Instrument Calibration window.

4. Remove the water bath. Move the tip of the reference thermocouple so that it touches the
sample thermocouple tip yet allows the furnace to be closed.

5. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic. Set the furnace target temperature to 1000 °C. Use a ramp rate of 50 °C/min.
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Observe the schematic to ensure that both the furnace temperature and sample tem-
perature are increasing.

6. After the furnace and sample temperature have stabilized, enter the reading from the ref-
erence thermocouple in the High Cal. field on the Instrument Calibration window.

7. Use manual control of the furnace to return the temperature to ambient.
8. On the Instrument Calibration window, click Accept to save the new values. Make a backup

copy of the settings when prompted.

Recalibrate the Sample Thermocouple
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SAMPLE TUBE

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

SAMPLE TUBE INSTALLATION

Sample Thermocouple on page 9 - 14

Ensure the furnace has cooled to ambient temperature before installing tubes. Use
the cotton gloves provided in the accessory kit when handling heated surfaces. These
cotton gloves are not intended to protect hands when heated surfaces are above
60 °C. Rubber gloves may be used to handle the sample tube when it has cooled.

Wear latex gloves when handling the quartz sample tube. The natural oils in human
skin can chemically damage and weaken the quartz tube. It is also important that the
sample tube and its components, as well as the sample and exhaust ports, be clean
and free of debris. Dust particles from quartz wool or the insulator disc of previous
analyses may adhere to the port and/or components, preventing a proper seal of the
sample tube.

Use only Kalrez (or equivalent) O-rings. Kalrez is rated for both chemical and
temperature suitability in this application. O-rings of other materials could burn, melt,
or decompose.
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A. Sample tube collar
B. O-rings

1. Open the furnace.
2. Remove any sample tube stoppers immediately before connecting the sample tube to the

analyzer.

For quartz tubes, do not allow the nuts to slide down rapidly to the curved portion of
the tube. This could damage the tube.

3. Place an O-ring around each opening of the sample tube.
4. Insert the open ends of the sample tube into the openings under the upper panel, aligning

the thermocouple in the proper position.
5. Push the sample tube up into the sample port until it comes to a stop. Tighten the fittings by

turning the retaining nuts until finger tight.

Do not overtighten the analysis port fittings— doing so may break the quartz sample
tube. The O-rings are sealed when the fittings are finger tight.

6. If the thermocouple is placed on the outside of the sample tube, clamp it to the tube.
7. Close and latch the furnace. The furnace will not heat unless closed. The pressure con-

troller will also be disabled when the furnace is open.

Sample Tube Installation
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SAMPLE TUBE REMOVAL

The furnace and sample tube may remain very hot for some time after analysis has
ended. The sample tube retaining nuts are extremely hot, approximately 110 ºC. Use
extreme caution!

It is recommended to allow the furnace and sample tube to return to ambient temperature before
touching them. If the sample tube has cooled, use rubber gloves when removing it. If it is still hot,
use the cotton gloves provided.

1. Unlatch and open the furnace.

Support the sample tube retaining nuts so that they do not fall rapidly out of the ana-
lyzer. This may damage the sample tube.

2. Inspect the O-rings for cracks or other damage that might cause leaks. If the O-rings are
cracked or damaged, replace them before reinstalling the sample tube. Additional O-rings
are shipped with the analyzer. Otherwise, clean, dry, and re-install the O-rings.
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SAMPLE TUBE FILTER OR O-RING REPLACEMENT

A frit filter is used to protect the analyzer internal components from contaminants that may be
forced out of the sample tube during an analysis. As the analyzer is used, the filter may gradually
become clogged with trapped particles. If the filter does become blocked, it must be removed and
cleaned or replaced. One indication of a clogged filter is a sample pressure greatly exceeding
atmospheric pressure. The nominal sample pressure reading should be a few mmHg above
atmospheric pressure

1. Loosen the analysis port fittings while holding the sample tube.

The sample tube and nearby components may be hot. Allow the sample tube to cool
before removing it. Use the cotton gloves provided in the accessory kit when handling
heated surfaces. These cotton gloves are not intended to protect hands when heated
surfaces are above 60 °C.

2. Carefully remove the sample tube by unscrewing the retaining nuts. Do not allow the nuts to
slide down onto the curved portion of the sample tube or the tube may break.

3. Remove the left (smaller) sample tube fitting (it has a tube within a tube).
4. Use a small diameter probe to remove the O-ring and frit filter disk from the sample tube fit-

ting.
5. Install a new (or cleaned) analysis port filter in the sample tube fitting.
6. Inspect the O-ring for cracks or cuts. If the O-ring is damaged, replace it with a new O-ring.

Otherwise, clean the O-ring, dry it, and place it in the sample tube fitting. Ensure the O-ring
is securely in place.

7. Place the left sample tube fitting back into position and tighten it slightly.
8. Reinstall the right sample tube fitting and sample tube, then tighten both fittings.

Sample Tube Filter or O-ring Replacement

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 9 - 27



9 Hardware

SEPTUM
The septum is used to inject quantities of gas into the analyzer.

Septum port

Do not use the septum at pressures above ambient. Gas may escape at elevated pres-
sures.

Accuracy of data is diminished when poor techniques are used for injecting gas through the
septum.

Injecting the gas through the septum causes a peak to appear, but it also causes a perturbation in
the flow of gas through the analyzer. This perturbation is visible in the peak data. To minimize this
perturbation, inject the gas more slowly into the septum. Prolonging the injection causes the peak
to spread.

An injection method should be developed to balance the need to minimize the perturbation with
the need for sharper peaks. See Peak Editor on page 6 - 3 to adjust peak data to reduce the
effects of perturbation.

n Always hold the syringe by its metal parts away from the needle. Holding the syringe by the
glass allows body heat to affect the volume of gas in the syringe.

n After filling the syringe, allow the syringe to lie on a room temperature surface for about a
minute. This ensures that the syringe and its contents are at room temperature.

n If the gas used is lighter than air, do not allow the filled syringe to remain in a vertical position
(needle up) — the gas will diffuse out and the total volume will be reduced.
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Fill the syringe

1. Empty the syringe completely.
2. Insert the syringe into a septum accessory installed on the gas regulator.
3. Draw the syringe plunger back until the syringe is completely filled with gas.
4. Remove the syringe from the septum and allow it to return to room temperature as

described previously.
5. Press the plunger into the syringe until the correct amount of gas is contained in the syringe.

Alternate method to fill the syringe with nitrogen (evaporating from liquid
nitrogen

1. Empty the syringe.
2. Hold the tip of the needle just above the surface the liquid nitrogen.
3. Draw the syringe plunger back until the syringe is filled with nitrogen gas.
4. Allow the syringe to stabilize at room temperature.
5. Push the plunger into the syringe until the correct amount of gas is contained in the syringe.

Inject gas into the analyzer

1. Insert the needle fully into the septum.
2. Press the plunger into the syringe completely to ensure that the entire quantity of gas is

injected from the syringe.
3. Remove the syringe.
4. Replace the septum cap and tighten finger tight.

Septum
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SEPTUM REPLACEMENT

A. Septum connector
B. Septum
C. Knurled nut

The septum usually requires replacing after approximately 100 injections when using the 1 mL
syringe.

1. Turn the knurled nut counter-clockwise and remove it from the injection port.
2. Tap the nut into the palm of your hand to remove the septum and discard the used septum.
3. If the washer came out when the septum was removed, place the washer back into the

knurled nut first.
4. Place a new septum into the knurled nut.
5. Place the knurled nut back onto the injection port. Turn the nut clockwise to finger tighten.

Do not use a wrench to tighten the septum retaining nut. Do not overtighten the retain-
ing nut. Doing so may damage the septum or the fitting.
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VAPOR GENERATOR INSTALLATION

Use caution in the areas where this symbol is displayed on the instrument.Use the
cotton gloves provided in the accessory kit when handling heated surfaces. These
cotton gloves are not intended to protect hands when heated surfaces are above
60 °C.

Topics in this section are applicable only if the vapor generator option is installed on
the analyzer

Vapor Generator Gas Path Leak Test on page 10 - 21

Clean the vapor generator before changing to a different liquid.

The majority of the vapor generator’s components are internal to the analyzer and are installed
and calibrated by a Micromeritics Service Representative.

Use appropriate safety measures to prevent injury from contact with hazardous
liquids used in the vapor generator.

1. Fill the Erlenmeyer flask to a depth of at least 50 mm (2 in.).
2. Unzip the heating mantle, place it around the flask; do not zip it closed. Screw the flask into

the port on the underside of the front panel. The metal cylinder that extends down from the
vapor generator port is the aerator. When the flask is properly installed, the aerator should
extend down into the flask and its contents. Zip the mantle closed.

3. Plug the heating mantle connector into the appropriate connector on the recessed front
panel.

4. Twist the ring to secure the connector.
5. The valve that controls the flow of gas from the vapor generator has two states: Bypass and

Vapor. In the sample file, select Vapor for the state of the vapor generator valve during the
portion(s) of analyses to flow vapor through the system. The loop gas is the gas that flows
through the vapor generator; ensure the gas used for vapor generation is connected to one
of the loop gas inlet valves.

Vapor Generator Installation
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CLEAN THE VAPOR GENERATOR

Enable Manual Control on page 10 - 4

It is necessary to clean the vapor generator before changing the liquid.

1. Fill the flask with Isopropyl Alcohol (IPA).
2. Install the flask on the analyzer.
3. Flow an inert gas through the vapor generator and analyzer for approximately 20 minutes.

Such cleaning can be performed using Manual Control.
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10 TROUBLESHOOTING
The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.micromeritics.com).
n CryoCooler II and CryoCooler III Operator Manual (PDF)
n Error Messages document (PDF)
n Parts and Accessories

Most operational problems are caused by:
n Leaks (commonly found at the sample tube O-ring at the analysis port)
n Sample weighing errors
n Use of too much analysis bath fluid in the Dewar at the start of an analysis
n Entry of incorrect system volume for analysis
n Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided
below:

Does not work when powered ON

Cause A: Power cord is not fully inserted at one of the ends

Action A: Insert power plug firmly into outlet socket. Insert unit connector into power con-
nector opening.

Cause B: No power at outlet.

Action B: Plug in another electrical device to test outlet. If there is no power, contact elec-
trician.

Cause C: Plug prongs are bent so that contact is not made at outlet.

Action C: Gently move power plug at the outlet while watching the status LEDs on the ana-
lyzer front panel. If at least one LED becomes illuminated, have an electrician
replace the outlet or the plug.

Cause D: Power cord is damaged.

Action D: Have an electrician check cord using a test meter. Replace cord if defective.

Cause E: Loose internal connection or broken wire.

Action E: Call a Micromeritics Service Representative for repair or replacement.

10 Troubleshooting

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 10 - 1

http://www.micromeritics.com/


10 Troubleshooting

Liquid nitrogen boils away too quickly to complete an analysis.

Cause A: Dewar damaged.

Action A: Replace Dewar.

Cause B: Lengthy analysis.

Action B: Refill Dewar during analysis.

Specified temperature not reached or not maintained.

Cause: Thermocouple or another internal component is damaged or disconnected.

Action: Contact the appropriate service personnel.

Gas drained from gas cylinder.

Cause: Leaks in the gas line connection.

Action: Replace the gas cylinder; then pressurize the system. Close, then open the
cylinder valve. If the needle on the pressure gauge on the gas cylinder jumps
abruptly, a leak in the gas line connection may be indicated. Check all gas line
connections.

Too much heat supplied to analyzer.

Cause: Thermocouple or another internal component is damaged or disconnected.

Action: Contact the appropriate service personnel.

A stable TCD baseline cannot be maintained.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 10 - 30 to replace or clean the TCD.
Cause B: Possible leak in reference/carrier path.

Action B: Perform leak test in the reference/carrier path. See Perform a Leak Test on
page 10 - 18.

Cause C: Faulty RTD in one of the temperature zones.

Action C: Access manual mode and check for temperature stability in the temperature
zones.
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Data collection results in very high or very low peaks that are inconsistent with previous
experience.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 10 - 30 to replace or clean the TCD.
Cause B: A different (lower) TCD temperature is being used.

Action B: Repeat the analysis using a higher temperature.

During data collection, a TCD signal of zero is recorded, or no peaks are seen.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 10 - 30 to replace or clean the TCD.
Cause B: TCD temperature was not reset after a run automatically suspended.

Action B: Ensure the TCD is re-enabled after all run suspensions.

Furnace will not heat.

Cause A: Furnace not closed and latched.

Action A: Close and latch the furnace.

Cause B: The furnace is not plugged in.

Action B: Plug in the furnace connector.

Cause C: Thermocouple damaged or not plugged in.

Action C: If unplugged, plug in the thermocouple. Replace the thermocouple if neces-
sary.

Pressure will not rise or readings very unstable.

Cause A: Furnace not closed and latched.

Action A: Close and latch the furnace.

Cause B: The furnace is not plugged in.

Action B: Plug in the furnace connector.

10 Troubleshooting
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10 Troubleshooting

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Show Instrument Schematic on page 2 - 16
Use Enable Manual Control to enable the manual control of certain system valves and pump com-
ponents on the analyzer schematic. When this option is enabled, a checkmark appears to the left
of Unit [n] > Enable Manual Control. If the analyzer schematic is not immediately visible, go to
Unit [n] > Show Instrument Schematic.
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FOAM AIR FILTER REPLACEMENT
The foam air filter should be cleaned every 30 days (more frequently in environments with high
levels of dust). If, after cleaning, it is determined that the filter is degrading, it should be replaced.

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Right-click the analysis valve and ensure that it is in the Prepare position.
3. Remove the furnace, the cold trap (or delay path), the sample tube, and any other parts or

accessories from the front of the analyzer.
4. Remove the black mat from the lower panel.

5. Remove the screws that hold the stainless steel support plate in place.

Foam Air Filter Replacement
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10 Troubleshooting

6. Hold the furnace support post and lift the support plate up and away from the analyzer.

7. Pull the foam air filter up and out of the analyzer.
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8. Rinse the foam air filter with clean water and allow it to dry completely.
9. If the filter is in good condition, place it back inside the analyzer. If the filter needs to be

replaced, obtain a new filter and place it inside the analyzer.
10. Place the support plate back into position and reinstall its retaining screws.
11. Reinstall the furnace, cold trap (or delay path), sample tube, etc.

Foam Air Filter Replacement
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10 Troubleshooting

GUIDELINES FOR CONNECTING GASES

Analyzer Gauge should indicate
AutoChem 14 - 16 psig (95 - 110 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. If expansion kits or other accessories are used in the lab, spe-
cial consideration should be given to these configurations when installing the gas
lines.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders
close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure.

Long gas lines, such as those used with gas cylinders placed in remote areas, must be purged
for an extended period of time to remove ambient gases. When possible, avoid placing gas
cylinders in remote locations. It is always best to have gas cylinders located near the analyzer.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as
those with a herringbone covering, but the line may be coated internally with a polymer.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
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n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 600 psi or 4100 kPa on the high-pressure gauge. Contaminants
adsorbed to the walls of the cylinder will desorb as the pressure decreases.

REPLACE A GAS CYLINDER

Analyzer Gauge should indicate
AutoChem 14 - 16 psig (95 - 110 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions apply to working with inert gases only. When working with
hazardous gases, follow the safety procedures established by your lab.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

Replace a Gas Cylinder
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10 Troubleshooting

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be
vented from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and

move the cylinder to an appropriate location.
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Connect a Gas Cylinder

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder.

2. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

3. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

4. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately one minute.

n If the pressure is stable, proceed with the next step.
n If the pressure decreases, tighten the regulator connector nut until it becomes

stable. If the pressure does not remain stable, remove the regulator and clean all
contacts at the regulator connection, then reinstall the regulator.

5. Purge the air from the lines by doing the following:

Purge the regulator before starting to prevent contamination of the analysis gas sup-
ply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust the Pressure Control knob to approximately 5 psi.
c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both

gauges read approximately zero.
d. Close the regulator Shut-off valve to stop gas flow.
e. Reconnect the gas line to the regulator.
f. Use two 7/16 in. (11 mm) wrenches to tighten the gas line connection. Hold one wrench

fitting steady and the other to tighten the connector nut.

Replace a Gas Cylinder

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 10 - 11



10 Troubleshooting

6. Set the analyzer pressure by doing the following:
a. Turn the Regulator Control knob clockwise until the low pressure gauge indicates the

appropriate pressure. See the Regulator Pressure Settings table in Connect a Gas
Cylinder.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.
d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.

7. If the gas line to the instrument inlet was previously disconnected, reconnect it now.
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O-RING COMPATIBILITY
O-ring selection for chemisorption measurements is based on temperature, time, and chemical
compatibility. Chemical compatibility should be the first consideration when selecting an
appropriate O-ring. The time at which the furnace, and subsequently the sample cell, is at
elevated temperature can also affect the performance of the O-rings and should be a secondary
consideration. Common O-ring materials include Buna-N (nitrile), Viton (fluoroelastomer), and
Kalrez (perfluoroelastomer). Kalrez has historically been used extensively for chemisorption
measurements due to compatibility with a wide range of chemicals and temperatures and should
be suitable for all applications of the chemisorption option. Viton or Buna-N may also be suitable
for analyses similar to the reference material example file. The ability to re-use Buna-N or Viton O-
rings may be limited, while the re-use of Kalrez O-rings should be broader. Frequency of use and,
potentially, several other factors affect the duration of O-ring use, so rigid rules cannot be
specified for these materials. Leak rate and ultimate vacuum levels may be used as indicators for
O-ring performance.

O-ring Compatibility
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10 Troubleshooting

PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Procedure 3 months
or 75 runs

6 months
or 150 runs

9 months
or 225 runs

12 months
or 300 runs

Change septum U-R F

Change Injection loop U-I-A F

Foam air filter F

Sample tube filter U-R F-R

Clean analyzer exterior U-I-A F

Adjust sample ther-
mocouple

U-I-A F

Clean the cold trap U-I-A U-I-A U-I-A F

Replace TCD U-I-A F

Clean Dewar U-I-A U-I-A U-I-A F

Change sample O-rings F-R

Perform leak check U-I-A F

Check temperature
stability

F

Check sample ther-
mocouple calibration

F-A

Perform calibration run F

U User performed
F Factory / Micromeritics Service procedure
I Inspect
R Replace
A As necessary

Legend:
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CHECK AND CLEAN THE DEWAR

When handling Dewars, follow the precautions outlined in Dewar Precautions on
page 5 - 3.

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar.
Particles or deposits exceeding 1/4 in. (6 mm) in depth may jam between the bottom of the sample
tube and the bottom of the Dewar.

Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample
tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore
volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen
evaporates. The water must be removed, otherwise it will solidify when liquid nitrogen is added
and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitro-

gen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

3. Rinse the Dewar with warm water to melt any remaining ice accumulation which may
remain. Dry thoroughly.

4. Replace the Dewar.

Check and Clean the Dewar
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

Do not allow liquid to penetrate the casing of the instrument. Doing so could result in
damage to the unit.

10 - 16 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024



POWER INSTRUMENT ON AND OFF

Do not connect or disconnect cables when the instrument is powered ON.

When the system is powered on for the first time or after a period of non-use, allow it to warm up
for at least three hours before analyses. During this time, a purge carrier gas (such as helium or
nitrogen) should be flowed through the system at about 50 cm3/min. The heat zones should be set
at 110 °C.

When the instrument is powered on (but the application is still not running), the red Fault light and
the green Attention! light are lit. When the application is started and communication is established
with the instrument, these lights are turned off and the green OK light is lit.

A carrier gas must be flowing through the detector whenever the detector filaments
are turned on; otherwise, the filaments will deteriorate and lose sensitivity. If the
gases are shut off, the filaments are automatically turned off after five minutes.

Power ON the equipment in the following order:

1. Computer, monitor, and printer.
2. Analyzer.

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print
manager will print. If a power failure occurs and an uninterruptible power supply (UPS) is
not attached to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open, and the analysis continues to run.

2. Computer, monitor, and printer.
3. Analyzer

Power Instrument On and Off
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PERFORM A LEAK TEST
This tests all fitting connections in the gas flow path and part of the analysis valve. Any flow
reading other than zero indicates a leak in the gas flow path being tested.

A. Inlet valves
B. Reference gas MFC
C. Cold trap valve heat

zone
D. Analysis valve heat

zone
E. Detector heat zone
F. Auxiliary port
G. Valve heat zone
H. Septum
I. Loop gas MFC
J. Carrier gas MFC
K. Reference gas MFC
L. Calibration valves

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Prepare for the leak test:
a. Set all heat zones to ambient temperature.
b. Set all four MFCs to 50 sccm.
c. Allow the analyzer to cool to room temperature.

This test must be performed in the order provided to ensure the analyzer is fully
tested. Any flow reading other than zero indicates a leak in the gas flow path being
tested.
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PREPARATION GAS PATH LEAK TEST

1. Right-click the analysis valve and select Analyze.
2. Right-click the first preparation valve and selectOpen.
3. Plug the preparation gas exhaust outlet.
4. Observe the preparation gas MFC reading as it slowly drops to zero. A flow reading of zero

indicates the flow path between the preparation gas MFC and the preparation exhaust does
not leak.

5. To fix a leak that may be indicated on the preparation gas MFC, tighten the fittings in the gas
flow path and observe the reading for any decrease that would indicate that the leak has
stopped.

Any leak detected in the remaining steps of this procedure may be fixed by using the
same process mentioned in Step 5.

6. Right-click the preparation gas MFC and select Stop Flow. This will close the helium valve.
7. Remove the plug from the preparation gas exhaust outlet.

REFERENCE GAS PATH LEAK TEST

Valve positions need not be preset for this test. Any flow reading other than zero
indicates a leak in the gas flow path being tested.

1. Right-click the reference valves and selectOpen.
2. Plug the reference gas exhaust outlet.
3. Observe the reference gas MFC reading as it slowly drops to zero.

A flow reading of zero indicates the flow path between the reference gas MFC and the
reference gas exhaust does not leak. This tests all fitting connections in the gas flow path
and the reference side of the thermal conductivity detector.

4. Right-click the reference gas MFC and select Stop Flow. This will close the valve.
5. Remove the plug from the reference gas exhaust outlet plug.

Preparation Gas Path Leak Test
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CARRIER GAS PATH LEAK TEST

1. Right-click the cold trap valve and select Bypass.
2. Right-click the analysis valve and select Prepare.
3. Right-click the loop valve and select Fill.
4. Turn the pressure control knob on the helium gas regulator to deliver less than 50 psi (345

kPag).
5. Right-click the carrier gas inlet valves and selectOpen.
6. Plug the analysis gas exhaust outlet.
7. Right-click on calibration valve B and select Close , then repeat the step for calibration valve

C.
8. Observe the carrier gas MFC reading as it slowly drops to zero. A flow reading of zero indic-

ates the flow path between the carrier gas flow MFC and calibration valve B does not leak.
9. Right-click calibration valve B and selectOpen .
10. Observe the carrier gas MFC reading as it slowly drops to zero or remains at zero from the

previous test. A flow reading of zero indicates the flow path between the carrier MFC and
the carrier exhaust outlet does not leak. This tests all fitting connections in the gas flow path
and part of the analysis valve, part of the bypass valve, the transducer, the septum, part of
the inject valve, and the analysis side of the thermal conductivity detector.

11. Right-click the loop valve and select Inject.
12. Observe the carrier gas MFC reading as it slowly drops to zero or remains at zero from the

previous test. A flow reading of zero indicates the flow path between the carrier gas MFC
and the carrier gas exhaust outlet does not leak. This tests all fitting connections in the gas
flow path, the remaining parts of the loop valve, and the loop.

13. Install an empty sample tube on the sample port.
14. Right-click the analysis valve and select Analyze.
15. Observe the carrier gas MFC reading as it slowly drops to zero or remains at zero from the

previous test. A flow reading of zero indicates the flow path between the carrier gas MFC
and the carrier gas exhaust outlet does not leak. This tests all fitting connections in the gas
flow path, the sample tube, and the remaining parts of the analysis valve.

16. Install a cold trap (or a delay path) on the cold trap port.
17. Right-click the cold trap valve and select Trap.
18. Observe the carrier gas MFC reading as it slowly drops to zero or remains at zero from the

previous test. A flow reading of zero indicates the flow path between the carrier gas MFC
and the carrier gas exhaust outlet does not leak. This tests all fitting connections in the gas
flow path, the remaining parts of the cold trap valve, and the cold trap.

19. Right-click the carrier valves and select Close to close the helium valve.
20. Remove the plug from the analysis exhaust outlet.
21. Reset the pressure on the helium gas regulator to its original pressure.
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VAPOR GENERATOR GAS PATH LEAK TEST

This test is applicable only if the vapor generator option is installed on the analyzer.

1. Right-click the loop valve and select Inject.
2. Right-click the vapor valve and select Bypass.
3. Right-click calibration valve C and select Close
4. Right-click calibration valve D and select Close
5. Plug the loop gas exhaust outlet.
6. Plug the vapor generator gas exhaust outlet.
7. Right-click the loop gas valves and select Open.
8. Observe the loop gas MFC reading as it slowly drops to zero.

A flow reading of zero indicates the flow path between the loop gas MFC and calibration
valves C and D does not leak. This tests all fitting connections in the small section of the gas
flow path to calibration valves C and D.

9. Right-click calibration valve D and selectOpen.
10. Observe the loop gas MFC reading as it slowly drops to zero or remains at zero from the pre-

vious test.

A flow reading of zero indicates the flow path between the loop gas MFC and the loop gas
exhaust outlet does not leak. This tests all fitting connections in the gas flow path, portions
of the vapor generator valve, and the tubing up to the inject valve.

11. Install an empty flask onto the vapor generator port.
12. Right-click the vapor valve and select Vapor.
13. Observe the loop gas MFC reading as it slowly drops to zero or remains at zero from the pre-

vious test.

A flow reading of zero indicates the flow path between the loop gas MFC and the loop gas
exhaust does not leak. This tests all fitting connections in the gas flow path, the remaining
portions of the vapor generator valve, and the relief valve in the vapor generator.

14. Right-click the loop gas MFC and select Stop Flow to close the gas valve.
15. Remove all exhaust plugs.

Vapor Generator Gas Path Leak Test

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 10 - 21



10 Troubleshooting

LOOP GAS PATH LEAK TEST

This test is applicable only if the vapor generator option is installed on the analyzer.

1. Right-click the loop valve and select Inject.
2. Right-click calibration valve C and select Close .
3. Right-click calibration valve D and select Close .
4. Plug the loop gas exhaust outlet.
5. Right-click the loop gas valves and selectOpen.
6. Observe the loop gas MFC reading as it slowly drops to zero.

A flow reading of zero indicates the flow path between the loop gas MFC and calibration
valves C and D does not leak. This tests all fitting connections in the small section of the gas
flow path to Calibration Valves C and D.

7. Right-click calibration valve D and selectOpen
8. Observe the loop gas MFC reading as it slowly drops to zero or remains at zero from the

previous test.

A flow reading of zero indicates the flow path between the loop gas MFC and the loop gas
exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, calibration valves C and D, and the
tubing to the loop valve.
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PURGE THE SYSTEM
When changing the gas that is flowing through the analyzer, or when the type of gas connected to
a port is changed, purge the analyzer of the previous gas by flowing the new gas. The system
should also be purged if the loop is changed.

If changing gases during an analysis, allow the new gas to flow for a period of time before creating
conditions that cause the experiment to begin (such as elevating the temperature). In some cases,
purge one gas by flowing an inert gas for a period of time before starting to flow another gas. This
may be useful for avoiding undesirable combinations of gases within the analyzer.

To flow an inert gas between incompatible gases, insert a Change Gas Flows step (in which an
inert gas is flowed for a period of time) and aWait step (to wait for the inert gas to purge the
analyzer) between other steps that involve incompatible gases.

When gas flows are changed while the analyzer is recording data, the gas flow is
briefly disturbed. This may result in a brief period of noise or other visible disturbances
on the peak data. Either disregard the disturbance or insert aWait for stable baseline
step immediately after changing gas flows.

Purge one line at a time. It is the operator’s responsibility to ensure that dangerous
combinations of gases are not created while using Manual Control. It may be
necessary to flow an inert gas through the system between flows of incompatible
gases.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Set the Cold Trap valve, Analysis valve, Loop valve, and Detector heat zone temperatures
to 110 °C.

a. Move the cursor over each valve until the cursor changes to a thermometer.

When the cursor is on a heat zone, it appears as a thermometer. If it appears
as a handing turning a valve, move the cursor slightly.

b. Right-click and select Set temperature.
c. Enter 110.
d. ClickOK.

3. Wait until the temperature reaches the 110 °C target. Click the heat zone to display both the
target and current temperatures on the right side of the schematic.

Purge the System

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 10 - 23



10 Troubleshooting

4. Purge all air from the gas lines. These steps should be performed for each inlet valve for the
preparation, carrier, and loop gas lines where a gas cylinder is connected.

a. Right-click the preparation gas Mass Flow Controller (MFC).
b. Select Set Flow Rate and enter 50.
c. ClickOK.
d. Right-click gas inlet valve 1 and selectOpen.
e. Allow the gas to flow for approximately 20 minutes or until the lines have been

purged of air.
f. Repeat Step 4 for each valve that has a gas cylinder connected.
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CHANGE THE GAS FLOW DURING AN ANALYSIS

When changing gases during an analysis, allow the new gas to flow for a period of time before
creating conditions that cause the experiment to begin (such as elevating the temperature). Purge
one gas (by flowing an inert gas for a period of time) before starting to flow another gas. This may
be useful for avoiding undesirable combinations of gases within the analyzer.

To flow an inert gas between incompatible gases, insert a Change Gas Flows step (in which an
inert gas is flowed for a period of time) and aWait step (to wait for the inert gas to purge the
analyzer) between other steps that involve incompatible gases.

When gas flows are changed while the analyzer is recording data, the gas flow is
briefly disturbed. This may result in a brief period of noise or other visible disturbances
on the peak data. Either disregard the disturbance or insert aWait for stable baseline
step immediately after changing gas flows.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.

Change the Gas Flow During an Analysis
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10 Troubleshooting

REPLACE THE INJECTION LOOP

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Ensure that no heat is being applied to the analyzer. If necessary, enable manual control
and set the target temperature for the heat zones to ambient. Wait for the analyzer to cool.

2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the
handle. Use the handle to open the hinged top panel. It is not necessary to remove the top
panel. Pull down the upper front panel.

Depending upon the state of the analyzer, the internal components may be hot. Use
caution.

3. The Fill/Inject (Loop) valve cover is held in place by two retaining plungers. Remove the
valve cover by pulling the plungers outward until the Fill/Inject valve cover is released. Pull
the cover up and out.
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4. Remove the insulation from Fill/Inject valve.
5. Unscrew the loop nut and lay it aside. It may be necessary to loosen the screw in the middle

of the assembly in order to free the loop nut.

A. The 5.0 cm³ loop is located
in this position when
installed

B. The 0.5 cm³ and the 1.0 cm³
loops are located in this
position when installed

6. Remove the enclosure ring.

7. Use a 1/4 in. open-end wrench to loosen the nuts on the injection loop.

Replace the Injection Loop
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10 Troubleshooting

8. Pull up and remove the injection loop and enclosure ring from the mounting plate.

Ensure the body of the loop is positioned in the temperature-controlled enclosure of
the loop valve. This orientation keeps the temperature (and volume) of the loop con-
stant. Failure to keep the full loop at a constant temperature may cause variations in
the quantity of gas contained in the loop.
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9. Install the replacement injection loop by placing the ends of the loop into the sides of the
valve and turning the nuts finger tight.

10. Push the replacement loop down to contact the mounting plate and place the loop enclos-
ure ring firmly into place.

11. Screw the loop nut down finger tight. Tighten the screw in middle of the assembly if it was
loosened earlier.

12. Tighten the loop nuts securely, using a 1/4 in. open-end wrench.
13. Check the injection loop for leaks. If a leak is detected, the injection loop is probably not

installed properly. Repeat the installation and check for leaks again. See Perform a Leak
Test on page 10 - 18.

14. After checking for leaks, move the insulation back into position and reinstall the Fill/Inject
valve cover.

15. Close the top panel and the lower front panel.
16. After installing a new injection loop, the loop must be calibrated. Go to Unit [n] > Unit Con-

figuration to update the loop volume.

The smaller loops connect to the same openings in the valve, but rest in a different
position than the larger loop.

Replace the Injection Loop
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10 Troubleshooting

TCD ASSEMBLY

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

The filaments in the thermal conductivity detector assembly are heated to high temperatures and
may be exposed to corrosive gases, therefore they may eventually need to be replaced.
Symptoms that the TCD filaments may need replacing:

n A stable TCD baseline cannot be maintained.
n Data collection results in very high or very low peaks that are inconsistent with previous exper-

ience.
n During a data collection, no TCD signal is displayed on the main display, or the application indic-

ates that no TCD signal is present.

Contamination of the thermal conductivity detector filaments will produce the symptoms described
above. To clean the filaments, set the filament zone to 150 °C and flow an inert gas through the
analyzer for several hours. If this action does not correct the problem, replace the TCD assembly.

REPLACE THE TCD ASSEMBLY

The equipment images in this topic may differ slightly from your equipment; however, the
instructions are the same unless otherwise noted.

1. Ensure that no heat is being applied to the analyzer. If necessary, enable manual control
and set the target temperature for the heat zones to ambient. Wait for the analyzer to cool.

2. Power OFF the analyzer but do NOT disconnect the power cord from the analyzer.

The power cord must remain connected to maintain an electrical ground connection to
the analyzer.

3. Press in on the right side of the retractable handle on the top of the analyzer to protrude the
handle. Use the handle to open the hinged top panel. It is not necessary to remove the top
panel. Pull down the upper front panel.
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A. Upper front panel
B. TCD block
C. TCD Assembly
D. Bypass/Trap valve cover

4. Pull the Bypass/Trap valve cover retaining plungers outward until the Bypass/Trap valve
cover is released. Pull the cover up and out.

5. Remove the insulation from the back of the Bypass/Trap valve and locate the TCD
assembly (not shown).

The thermal conductivity detector assembly and nearby components may be hot.
Allow the TCD to cool before removing it. Use the cotton gloves provided with the ana-
lyzer to protect your hands.

6. Loosen all four fittings for the stainless steel tubing. Label each piece of tubing for recon-
nection.

7. Unplug the TCD assembly cable from the card cage motherboard and cut the plastic cable
ties that retain the various cables. This frees the cables for removal of the TCD and cable.

A. TCD cable
B. Mounting plate

Replace the TCD assembly
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10 Troubleshooting

8. Use a screwdriver to remove the two TCDmounting screws from the yoke plate. Lift the
TCD assembly out of the analyzer.

9. Install the new TCD assembly in the analyzer. Reconnect the tubing at all four fittings and
reconnect the cable to the card cage motherboard.

10. Reinstall the insulation in the back of Bypass/Trap valve over the TCD assembly.
11. Reinstall the Bypass/Trap valve cover and allow the retaining plungers to snap into place.
12. Close the top panel and the upper front panel.
13. Power ON the analyzer.
14. Adjust the filament temperature to 150 °C and select an inert carrier gas to flow through the

TCD. Set the TCD Zone temperature to 110 °C.
15. Allow the TCD baseline to stabilize. Go to Unit [n] > Show Status to observe the TCD read-

ing. Stabilization may take several hours.

CLEAN THE TCD ASSEMBLY

In some instances, contamination of the thermal conductivity detector filaments will produce the
symptoms described above. To clean the filaments, set the filament zone to 150 °C and flow an
inert gas through the analyzer for several hours. Contact your Micromeritics service
representative if necessary.
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11 ANALYSIS TUTORIALS

BET SURFACE AREA ANALYSIS
The BET Surface Area analysis evaluates total surface area of the catalyst before and after
chemisorption. Loss of activity, which may occur due to the blocking of pores during the
chemisorption reaction, as well as the occurrence of sintering of the support, can be studied.

After outgassing the sample, a mixture of 30% nitrogen and 70% helium is applied to the sample
which is immersed in a liquid nitrogen (LN2) bath. The amount of nitrogen adsorbed (usually
measured on desorption) at LN2 temperatures is used to calculate total surface area.

Because nitrogen uptake is a function of pore size, sample sintering can cause results to show
reduced surface area. Therefore, it may be helpful to perform BET as the first and last
experiments in the analysis in order to check for sintering of the support.

PREPARATION

Pretreatment Flow helium over the sample to remove impurities, usually at the
maximum temperature tolerated by the sample (for example, the tem-
perature at which the sample was calcined).

Analysis Flow 30% N2/He, using a Dewar of liquid nitrogen, to measure the
uptake of nitrogen. Then remove the LN2 Dewar and replace it imme-
diately with a Dewar of water at ambient temperature. The amount of
N2 desorbed is measured and the BET equation is used to calculate
the active surface area.

Cold Trap Install the external long delay path. Do not use a cold trap Dewar.
Pressure regulator For BET analysis, gas cylinders should be set to a level between 10

and 15 psig (69 and 103.5 kPag).
Furnace temperature During pretreatment, select a temperature high enough to remove

contaminants or moisture, but not so high as to cause sintering or fus-
ing of the sample. Hold the temperature long enough to remove con-
taminants or moisture. Maintain the target temperature for at least 30
minutes to ensure adequate degassing. Ensure the Done step is set
to return the sample temperature to 0 ºC.

11 Analysis Tutorials
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11 Analysis Tutorials

CALIBRATION

BET experiments require a separate calibration consisting of three manual injections of nitrogen
through the septum. This calibration can be performed either before or after the BET analysis. As
with all TCD calibrations, use the Peak Editor to associate the calibration file with the analysis file.
For this reason, it is necessary that the data on the manual injections are collected in a separate
experiment from the BET experiment. The injections may be included in the same analysis as the
BET experiment, or they may be performed as a completely separate analysis. Use the same
recording options (zero, invert) for the Calibration experiment and the BET experiment.

The following method includes the calibration injections as a separate experiment which follows
the BET experiment in the analysis.

INJECTION SIZE

Inject three volumes of gas with the goal of approximating the volume of gas taken up by the
sample. Use one injection slightly larger than the expected volume, one injection slightly smaller
than the expected volume, and one injection between these two volumes. The largest injection
should be two to three times greater than the smallest injection.

Because the same syringe must be used for all three injections, select a syringe that can
accommodate all three injection volumes. The volume of gas uptake can be estimated if the
approximate surface area (SA) of the sample is known. Use the following formula to determine the
approximate volume (Vm) to inject.

So:

For example, a sample of 0.1 g of 50 m2/g material has a surface area of 5 m2. Therefore, the
volume of the gas which will be adsorbed is approximately 1.145 cm3 STP.
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PROCEDURE

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared.

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the ana-
lyzer.

2. Ensure the Delay Path is installed in the cold trap port.
3. Create a sample file containing the appropriate analysis conditions and report options.

a. Go to File > New Sample.
b. Complete the Sample Description window using appropriate values.
c. Select the Analysis Conditions tab and insert the following experiment steps:

Insert Step Window Field Field Entry or Selection
Experiment New Experiment Experiment

description
Enter a description of the exper-
iment

Type of analysis Physisorption Surface Area
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

20

Vapor Generator
Reflux 20
Flask 20

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

BET Surface Area Analysis
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11 Analysis Tutorials

Insert Step Window Field Field Entry or Selection
Outputs Outputs Use default values
Peaks Peaks Use default values
Recording Options Invert the

TCD signal
Select this option

Temperature
Ramp

Temperature Ramp Ramp Type Sample ramp
End temperature 350
Ramp rate 50.0
Hold time 0.00
Enable KwikCool No

Temperature
Ramp

Temperature Ramp Ramp Type Return to ambient
Enable KwikCool Enable this selection

Change Gas
Flows

Gas Flows Prep Gas None
Carrier/Reference
Gas

Nitrogen-Helium

Loop Gas None
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait until baseline
is stable

Select this option

Wait Wait Wait for operator Click OK to proceed with phys-
isorption measurement

Start Recording Start Recording One measurement
every

0.1 seconds

Dose Dose Get physisorption
point

Select this option

The application automatically inserts a Stop Recording step when a Start Recording step is
inserted. Ensure that a Dose step and a Temperature Ramp step is inserted within the Start/Stop
Recording loop.

Termination Termination Return to ambient
temperature

Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable
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To include the calibration data collection (three manual injections through the septum) within
this analysis but as a separate experiment, also insert the following steps (before the Dose
step):

Insert Step Window Field Field Entry
Experiment New Experiment Experiment

description
Enter a description of the exper-
iment

Type of analysis Other
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

20

Vapor Generator
Reflux 20
Flask 20

Gas Flows Prep Gas None
Carrier/Reference
Gas

Nitrogen-Helium

Loop Gas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording One measurement
every

0.1 seconds

Start Repeat Start Repeat
Sequence

Repeat 3 times

BET Surface Area Analysis
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11 Analysis Tutorials

Insert Step Window Field Field Entry
Wait Wait Wait for operator Prepare manual N2 injection. Click

OK.
Dose Dose Manual injection Select this option

The application automatically inserts a Stop Repeat step when a Start Repeat step is inserted.
Ensure that aWait step is inserted within the Start/Stop Repeat loop.

The application automatically inserts a Stop Recording step when a Start Recording step is inser-
ted. Ensure that the Dose step and the Temperature Ramp step is inserted within the Start/Stop
Record loop.

d. Select the Report Options tab and modify the values as needed.
e. Click Save, then click Close.

4. Start the analysis.
a. Go to Unit [n] > Sample Analysis and select the sample file that was just created.
b. Edit the sample file as needed, but for this example, editing is not required. Click Next.
c. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, select None.
d. Click Next.
e. Read the cautionary window and make any necessary changes. Click Start to start the

analysis. During the analysis, change the Dewar when prompted.

Change the Dewar rapidly. It is recommended to hold the water Dewar in one hand
and remove the LN2 Dewar with the other to minimize the time required for the
change.

5. When the analysis ends, remove the sample tube from the analyzer, place the caps on the
tube, and dry off the outside of the tube with a paper towel.

6. Weigh the sample tube, sample, and caps. Subtract this weight from the weight obtained for
the sample tube and caps. The resulting weight is the dry sample weight (the after analysis
weight). This weight will be used when calculating the BET surface area in the following sec-
tions.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.
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GENERATE THE BET REPORT
The following tasks must be performed before generating the BET report:

n Edit the sample file and the calibration file to ensure that peaks are properly marked
n Create a TCD calibration file
n Associate the TCD calibration file with the sample file

After completion of these tasks, go to Reports > Start Report. Verify that BET Surface Area is
selected.

EDIT THE PEAKS IN THE SAMPLE FILE

1. Open the Peak Editor.
2. Select the Peak Editor experiment from the view selector drop-down list at the bottom of the

window.
3. Select Edit Peaks in the View Type group box.
4. Click Find All Peaks.
5. If needed, edit the peak markers of the desorption peak:

The desorption peak is most often used to determine the surface area because the
desorption process starts with the adsorbate equilibrated on the surface.

a. Drag the cursor over the entire baseline of the peak to enlarge the editing area.
b. Click on the baseline of the left side of the peak, right click and selectMark left edge.
c. Repeat step b for the right side of the peak.

6. As the peak edges are adjusted, the values associated with the peak (listed in the peak
table) are also adjusted. When satisfied with the appearance of the peak, right click and
select Save.

EDIT THE PEAKS IN THE CALIBRATION FILE

1. Click Calibration.
2. Select the calibration file used with the analysis. ClickOK.
3. Edit the peaks in the same manner as described for the sample file.

BET Surface Area Analysis
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Create the TCD calibration file

1. Go toOptions > Signal Calibration > New.
2. Select User defined and enable an Experiment. ClickOK.

3. Click Load Calibration Data.
4. Select the sample file containing the calibration data. ClickOK. The data in the file are inser-

ted into the appropriate fields of the Signal Calibration window.
5. The values in the Peak Quantity column are defaults. The correct values for the volume of

each injection at STP must be determined using the formula:

Determine the volumes for each calibration peak listed in the table.

6. Enter the converted values (cm3 STP) into the table.Assess the Peak Area plot, Goodness
of Fit, and Coefficients to decide if the calibration file is acceptable. Use your laboratory’s
standards to determine what level of linearity is acceptable. As a general guideline, use a
calibration file with a very low value for Goodness of Fit (less than 0.1), when 1st or 2nd
Degree is specified.

To delete peaks that are outliers, highlight the peak data in the table and click Delete Peak.
Evaluate the results when changing the degree (select a different degree from the drop-
down list).

11 - 8 AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024



7. Enter a new description into the Description field.
8. When satisfied with all values in the file, click Save, then click Close

Associate the Calibration file with the Sample file

1. Open the Peak Editor.
2. Select the Peak Editor experiment from the view selector drop-down list at the bottom of the

window.
3. Select the experiment and click the Calibration button.
4. Select the down-arrow to the right of the Calibration field. Select the calibration file just cre-

ated. ClickOK.
5. Repeat steps 3 and 4 for each experiment.
6. Click Save, then click Close.

BET Surface Area Analysis
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LOOP CALIBRATION FOR TCD ANALYZERS TUTORIAL
Septum on page 9 - 28

Each calibration loop must be calibrated prior to its first use to determine its precise volume under
local conditions. Calibration consists of:

n Determining the average area of a series of peaks generated by injections of a known volume
of gas through the analyzer septum using a syringe.

n Determining the average area of a series of peaks generated by injections of the same gas
using the analyzer’s internal loop.

n Calculating the volume of the loop by comparing the average peak area generated by the loop
injections with that generated by the syringe injections.

n Entering the calculated loop volume under Unit [n] > Unit Configuration.

STEP 1: UPDATE AMBIENT PRESSURE AND TEMPERATURE

Options > Environmental Defaults
Environmental Defaults for TCD Analyzers on page 2 - 12

Ambient pressure and temperature at the time of the analysis affect the results of a loop
calibration. In calculations, the analyzer uses the ambient pressure and temperature recorded
in Environmental Defaults. Check and update the Environmental Defaults before beginning a
loop calibration.

STEP 2: CREATE A SAMPLE FILE

Create the sample file and insert a Loop Calibration experiment on the Analysis Conditions
tab.

A loop calibration must be created for each loop. For Loop Calibration, select a
carrier gas, flow rate, and loop gas that will commonly be used for sample ana-
lyses.
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STEP 3: PERFORM THE ANALYSIS

1. Install the correct injection loop.
2. Go to Unit > Sample Analysis and select the sample file for the loop calibration.
3. Click Next to accept the default values, then click Start.
4. Follow the prompts to make the selected number of injections. Use a volume that is

close to the volume of the loop being calibrated. For example, if calibrating the 1 cm3

loop, use a 1 cm3 syringe and inject as close to 1 cm3 of gas as possible.

Pay close attention to the instructions provided in each prompt and perform the
steps in the order given. Most accurate data results from keeping injection size as
consistent as possible. Injection errors may be evident in the data and may make it
necessary to repeat the experiment.

After the last manual injection, the analyzer automatically makes the same number of
injections using the loop.

STEP 4: GENERATE THE REPORT

Peak Editor on page 6 - 3

When properly performed, each manual and automatic injection results in a peak. When the
Results view of the Start Analysis window is selected, each peak can be viewed as it is
collected. The area under the peak corresponds to the amount of gas injected.

1. In the Peak Editor, open the sample file to ensure the peaks are properly marked.
2. Go to File > Open > [.SMP] and open the .SMP file containing the calibration exper-

iment and verify (or correct) the defined peaks using the Peak Editor.
3. On the Reports tab, select only the Loop Calibration report option.
4. Go to Unit > Unit Configuration. In the Loop volume field, enter the Loop Volume.

Verify that the Loop Volume and Environmental Default values are correct prior to
starting an analysis with injections.

Loop Calibration for TCD Analyzers Tutorial
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GENERATE THE LOOP CALIBRATION REPORT
Peak Editor on page 6 - 3

Open the Peak Editor and ensure that peaks are properly marked.

There are three possibilities for each dose of gas injected during Pulse chemisorption :

n all of the gas is taken up by the sample,
n some of the gas is taken up by the sample, or
n none of the gas is taken up by the sample.

When pulse chemisorption is properly performed, there will be some injections of each type.
When the data is viewed using the Peak Editor, however, only those injections in which some
or none of the gas is taken up will appear as peaks. When all of the gas is taken up by the
sample, none of it reaches the detector and, therefore, the peak area is zero. These types of
peaks are detected automatically by the application and do not require marking.

1. Go to File > Open > .SMP file.
2. Select the sample file used with this analysis. ClickOK.
3. Select the Report Options tab.
4. Enter the percent of active gas in the Active concentration field.
5. On the Sample Description tab, click Active Metals.
6. Verify that the Stoichiometry Factor and the% of Sample Weight values are correct.
7. ClickOK.
8. Verify that the values for the physical injection volume, ambient temperature, and ambi-

ent pressure are accurate.
9. Go to Reports > Start Report to generate the report.

PULSE CHEMISORPTION ANALYSIS TUTORIAL
A Pulse chemisorption analysis determines active surface area, percent metal dispersion, and
active particle size by applying measured pulses of reactant gas to the sample, depending upon
what technique is used. Pulse chemisorption is performed in the same manner as TPD, except
that the sample is dosed with the analysis gas using the injection loop until each active site has
reacted. After the active sites have completely reacted, the discretely injected gas volumes
emerge unchanged. If TPD is performed after Pulse chemisorption, additional information about
the distribution of active sites and the strength of active sites is collected.

The amount chemisorbed is the difference between the total amount of reactant gas injected and
the amount that did not react with the active sites of the sample. The size of each pulse is
determined by the loop, which is located on an electrically operated valve.
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LOOP VOLUME
It is preferred for the sample to require at least two doses of gas, but no more than ten doses,
before the reaction ends— depending on the environment. Some factors that influence the
number of doses required are sample size, the active surface area per unit of sample, and the size
of the loop. If the pulse chemisorption analysis requires more doses or fewer doses, change either
the sample size or the loop size.

Three loops of different sizes are provided with the analyzer — each loop must be calibrated prior
to use. As an alternative to replacing the loop, the loop volume may be changed by adjusting its
temperature. If the loop volume is changed by changing its temperature, results will be more
accurate if the loop volume is recalibrated at the new temperature.

Pulse Chemisorption Analysis Tutorial
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LOOP CALIBRATION
Before data from an analysis that uses an injection loop can be reduced, a loop calibration
experiment must be performed. An independent loop calibration can be performed either before or
after the analysis.

The following example assumes that the loop calibration will be performed after the analysis. A
Loop Calibration step can be included in a pulse chemisorption analysis.

PREPARATION

Pretreatment Degas by flowing inert gas (such as helium, argon, or nitrogen) over
the sample while ramping the temperature.

Analysis Pulse the loop (analysis) gas over the sample until the peak area
remains constant.

Cold Trap No cold trap is needed during pretreatment. During the analysis, use
the cold trap fixture with a Dewar of water in place as a short delay
path. This delay compensates for the flow disturbance caused by
each loop injection.

Pressure regulator Gas cylinders should be set to a level between 10 and 15 psig (69
and 103.5 kPag).

Furnace temperature Select a temperature high enough to remove any contaminants or
moisture, but not so high as to cause sintering or fusing of the
sample. Ensure the Done step is set to return the sample tem-
perature to ambient.
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PROCEDURE

In the following example, Pulse chemisorption is performed on a sample of Pt/Al2O3
with CO. Alter the analysis conditions to accommodate a different analysis.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 5 - 5.

1. Obtain the sample mass, then install the loaded sample tube and thermocouple on the ana-
lyzer. Close the furnace around the sample tube.

2. Create a sample file for this analysis.
a. Complete the Sample Description tab. Enter the correct mass and complete the

optional fields.
b. Select the Analysis Conditions tab and insert the experiment steps listed below:

Insert Step Window Field Field Entry or Selection

Experiment New Experiment Experiment
description

Enter a description of the exper-
iment

Type of analysis Pulse Chemisorption
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

20

Vapor Generator
Reflux 20
Flask 20

Pulse Chemisorption Analysis Tutorial
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Insert Step Window Field Field Entry or Selection
Gas Flows Prep Gas Helium

Carrier/Reference
Gas

Helium

Loop Gas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait [n] minutes 5

Change Gas
Flows

Gas Flows Prep Gas Hydrogen
Carrier/Reference
Gas

Helium

Loop Gas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 120
Ramp rate 10.0
Hold time 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 220
Ramp rate 10.0
Hold time 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 350
Ramp rate 10.0
Hold time 120.0
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Insert Step Window Field Field Entry or Selection

Change Gas
Flows

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait [n] minutes 90

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Wait Wait Wait [n] minutes 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 35
Ramp rate 5.0
Hold time 10.0

Change Gas
Flows

Change Gas
Flows

Prep Gas None
Carrier/Reference
Gas

Helium

Loop Gas Carbon Monoxide
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording One measurement
every

0.2 second

Wait Wait Wait [n] minutes 3

Start Repeat Start Repeat
Sequence

Repeat until peaks
are equal or [n]
times

20

Dose Dose Inject Loop Gas Select this option
Wait for [n] minutes 1.5

The application automatically inserts a Stop Repeat step when a Start Repeat step is
inserted. Ensure that the Dose step is inserted within the Start/Stop Repeat loop.

Pulse Chemisorption Analysis Tutorial
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11 Analysis Tutorials

Insert Step Window Field Field Entry or Selection

The application automatically inserts a Stop Recording step when a Start Recording
step is inserted. Ensure that the Temperature Ramp step is inserted within the
Start/Stop Recording loop.
Termination Termination Return to ambient

temperature
Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select the Report Options tab and modify values as needed.
e. Click Save, then click Close.

3. Start the analysis.
a. Go to Unit > Sample Analysis. From the Files list box, select the sample file created

in the previous step. Edit the file as needed. Click Next.
b. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, select None. Click Next.

Calibration files can also be associated with a sample file after analysis using Cal-
ibration button in the Peak Editor.

c. Read the cautionary window and make any necessary changes.
d. Click Start to start the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature. To
speed cooling of the sample, use the optional CryoCooler or KwikCool.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When the displayed sample temperature reaches the ambient temperature, open the
furnace. Using gloves, remove the sample tube.
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GENERATE THE LOOP CALIBRATION REPORT
Peak Editor on page 6 - 3

Open the Peak Editor and ensure that peaks are properly marked.

There are three possibilities for each dose of gas injected during Pulse chemisorption:

n all of the gas is taken up by the sample,
n some of the gas is taken up by the sample, or
n none of the gas is taken up by the sample.

When pulse chemisorption is properly performed, there will be some injections of each type.
When the data is viewed using the Peak Editor, however, only those injections in which some or
none of the gas is taken up will appear as peaks. When all of the gas is taken up by the sample,
none of it reaches the detector and, therefore, the peak area is zero. These types of peaks are
detected automatically by the application and do not require marking.

1. Go to File > Open > .SMP file.
2. Select the sample file used with this analysis. ClickOK.
3. On the Sample Description tab, click Active Metals. Verify that the Stoichiometry Factor

and the% of Sample Weight values are correct. ClickOK.
4. Verify that the values for the physical injection volume, ambient temperature, and ambient

pressure are accurate.
5. Go to Reports > Start Report to generate the report.

Pulse Chemisorption Analysis Tutorial
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TEMPERATURE PROGRAMMED DESORPTION ANALYSIS

This topic provides an example of how to perform a Temperature Programmed
Desorption analysis using NH3 on calcium oxalate under helium with a 10 °C/min tem-
perature ramp. Make the appropriate modifications for the material being analyzed.

Temperature Programmed Desorption (TPD) analyses determine the quantity, type, and strength
of active sites available on the surface of a catalyst from measurement of the amount of gas
desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of
analysis gas flows over the sample and reacts with the active sites. (Alternatively, Pulse
chemisorption can be used to react with active sites.) Programmed desorption begins when the
temperature is ramped linearly over time while a constant stream of inert carrier gas passes over
the sample.

At a certain temperature, the heat will overcome the activation energy, breaking the bond between
the adsorbate and adsorbent. The adsorbed species will then desorb. If different active metals are
present, they usually will desorb the reacted species at different temperatures. The desorbed
molecules enter the stream of inert carrier gas and are swept to the detector where the detector
response is proportional to the gas concentrations. The quantity of desorbed species, combined
with the stoichiometry factor, and the temperature at which pre-adsorbed species desorb, yield
the quantity and strength of active sites, respectively.

If TPD is performed after coverage of the active sites by flow or pulse chemisorption, additional
information about the distribution of active sites and the strength of active sites is collected.
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PREPARATION

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 5 - 5.

Pretreatment Degas by flowing inert gas— such as helium, argon, or nitrogen—
over the sample while ramping the temperature.

Analysis Choose a gas mixture from the following table based on the needed
results. Flow the gas over the sample, then ramp the temperature
beginning at ambient.

Cold Trap Not required

Needed Results Carrier Gas Analysis Gas
Active Metal Surface Area H2 Chemisorption argon hydrogen

Active Metal Surface Area CO Chemisorption helium carbon monoxide

Acidity helium ammonia (15%maximum
NH3, blended in helium)

Before performing an analysis, ensure the sample and analyzer have been
adequately prepared.

Temperature Programmed Desorption Analysis
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11 Analysis Tutorials

PROCEDURE
These instructions analyze zeolite with ammonia (use 15%maximum NH3 blended in helium) at 3
to 20 ºC/min. Adjust the values in the example to accommodate the analysis you are performing.

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the ana-
lyzer. Close the furnace around the sample tube.

2. Create a sample file for this analysis.
a. Go to File > New Sample.
b. Complete the Sample Description window. Enter the correct mass and complete the

optional fields as needed.
c. Select the Analysis Conditions tab and insert the following experiment steps:

Insert Step Window Field Field Entry or Selection
Experiment New Experiment Experiment

description
Enter a description of the exper-
iment

Type of analysis Other
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

20

Vapor Generator
Reflux 20
Flask 20

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass
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Insert Step Window Field Field Entry or Selection
Outputs Outputs Use default values
Peaks Peaks Use default values

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 350
Ramp rate 50.0
Hold time 10.00

Experiment New Experiment Experiment
description

Enter a description of the exper-
iment

Type of analysis Temperature Programmed
Desorption

Zones TCD Detector
Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

50

Vapor Generator
Reflux 40
Flask 50

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Outputs Outputs Use default values
Peaks Peaks Use default values

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Temperature Programmed Desorption Analysis
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Insert Step Window Field Field Entry or Selection
Change Gas
Flows

Gas Flows Prep Gas Ammonia (15%maximum NH3 blen-
ded in helium)

Carrier/Reference
Gas

Helium

Loop Gas Ammonia (15%maximum NH3 blen-
ded in helium)

Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait [n] minutes 60

Change Gas
Flows

Gas Flows Prep Gas None
Carrier/Reference
Gas

Helium

Loop Gas Ammonia (15%maximum NH3 blen-
ded in helium)

Cold trap valve Bypass
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait [n] minutes 30

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording One measurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 500
Ramp rate 3.0
Hold time 0.0

The application automatically inserts a Stop Recording step when a Start Recording
step is inserted. Ensure that the Temperature Ramp step is inserted within the
Start/Stop Recording loop.
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Insert Step Window Field Field Entry or Selection
Wait Wait Wait [n] minutes 30

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Repeatedly insert the steps between the double lines in this table. Use a different ramp rate for
each repetition; after ramping at 3°/min. and 5°/min., use 10, 15, and 20°/min. This shifts the
peak as a function of the Heat of Desorption.

Termination Termination Return to ambient
temperature

Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select the Report Options tab and set the values. Click Save then click Close.
3. Start the analysis.

a. Go to Unit > Sample Analysis. From the Files list box, select the sample file created
in the previous step. Edit the file as needed. Click Next.

b. From the drop-down list, select the calibrations associated with each experiment in the
sample file (if any). For this example, select None. Click Next.

c. Read the cautionary window and make any necessary changes.
d. Click Start to start the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature.
To speed cooling of the sample, use the optional CryoCooler or AutoCool. Remove
the sample tube when the analysis is complete.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

Temperature Programmed Desorption Analysis
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TEMPERATURE PROGRAMMED OXIDATION ANALYSIS

This topic provides an example of performing a TPO onWO3. Because TPR is often
used as the preparation for TPO, the TPR process was included in this example.

Temperature Programmed Oxidation (TPO) examines the extent to which a catalyst can be re-
oxidized. Generally, TPO analyses are used to measure the degree of reduction of certain oxides.

Usually the sample is pretreated and the metal oxides are reduced to the base metal. Then the
reactant gas is applied to the sample in pulses or (alternatively) as a steady stream. The analyzer
measures the uptake of the reactant gas.

TPO is often performed after TPR is performed. When the TPR experiment concludes, the sample
is returned to room temperature. Then, the analysis gas is changed to 2-5% O2 + He. This gas
mixture is flowed after the sample is at ambient temperature, then the temperature is ramped up to
the same maximum temperature used for the preceding TPR analysis. The portion of the sample
that had been reduced is re-oxidized, and the degree of reduction can be calculated.

If the TPR and TPO results are different, there are several possible causes: the sample material
sintered such that only a surface oxide (and not a bulk oxide) is formed, or part of the sample was
re-oxidized at room temperature while the TCD baseline was stabilizing.

When using any mixture of gases for TPR or TPO analyses, make sure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity, See Gas Charts on page E - 1.

PREPARATION

Pretreatment TPR
Analysis 2 to 5% oxygen/helium is flowed through the sample while tem-

perature is ramped, beginning at ambient temperature.
Cold Trap None needed.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 5 - 5.
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PROCEDURE
1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the ana-

lyzer. Close the furnace around the sample tube.
2. Create a sample file for this analysis.

a. Go to File > New Sample. Enter a file name or accept the default. ClickOK, then click
Yes to confirm.

b. Complete the Sample file as needed.
c. Select the Analysis Conditions tab and insert the experiment steps in the following

table:

Insert Step Window Field Field Entry
Experiment New Experiment Experiment

description
Enter a description of the exper-
iment

Type of analysis Temperature Programmed
Reduction

Zones TCD Detector
Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

20

Vapor Generator
Reflux 20
Flask 20

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Hydrogen-Argon (blend of 10%
hydrogen in argon)

Loop Gas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Outputs Outputs Use default values

Temperature Programmed Oxidation Analysis
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Insert Step Window Field Field Entry
Peaks Peaks Use default values

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Change Gas
Flows

Gas flows Prep Gas None
Carrier/Reference
Gas

Hydrogen-Argon (blend of 10%
hydrogen in argon)

Loop Gas None
Cold trap valve Bypass
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait for operator Position cold trap Dewar and close
furnace

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording One measurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 980
Ramp rate 10.0
Hold time 0.00

The application automatically inserts a Stop Recording step when a Start Recording
step is inserted. Ensure that the Temperature Ramp step is inserted within the
Start/Stop Recording loop.
Change Gas
Flows

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient
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Insert Step Window Field Field Entry
Experiment New Experiment Experiment

Description
Enter a description of the exper-
iment

Type of analysis Temperature Programmed
Oxidation

Zones TCD Detector
Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

20

Vapor Generator
Reflux 20
Flask 20

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Rate 50 cm3/min
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording One measurement
every

1.0 seconds

Temperature
Ramp

Temperature
Ramp

Ramp Type Sample ramp
End temperature 980
Ramp rate 20.0
Hold time 0.00

Temperature Programmed Oxidation Analysis
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Insert Step Window Field Field Entry
The application automatically inserts a Stop Recording step when a Start Recording
step is inserted. Ensure that the Temperature Ramp step is inserted within the
Start/Stop Recording loop.
Change Gas
Flows

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Helium

Loop Gas None
Cold trap valve Bypass
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Temperature
Ramp

Temperature
Ramp

Ramp Type Return to ambient

Termination Termination Return to ambient
temperature

Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select the Report Options tab and set the values.
e. Click Save, then click Close.

3. Start the analysis.
a. Go to Unit > Sample Analysis. From the Files list box, select the sample file created

in the previous step. Edit the file as needed. Click Next.
b. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, select None. Click Next.
c. Read the cautionary window and make any necessary changes.
d. Click Start to start the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature.
To speed cooling of the sample, use the optional CryoCooler or KwikCool. Remove
the sample tube when the analysis is complete.

4. As the temperature increases, the sample is oxidized, and the application calculates the
volume of oxygen taken up.
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5. Allow the TCD signal to return to the initial baseline after the peak has been displayed
6. When the displayed sample temperature reaches the ambient temperature, open the fur-

nace. Using gloves, remove the sample tube.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

Temperature Programmed Oxidation Analysis
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TEMPERATURE PROGRAMMED REDUCTION ANALYSIS

This topic provides an example of how to perform a TPR analysis of copper oxide.
Copper Oxide Reference Material can be ordered fromMicromeritics . Parts and
accessories are located on the Micromeritics web page.

Some reactions begin at temperatures below ambient. In such cases, a Dewar con-
taining an appropriate coolant should be used instead of the furnace at the beginning
of the experiment. For example, reduction of PtO should begin at approximately -50
°C, because the reaction begins at about -30 °C. Alternatively, the optional
CryoCooler can be used.

Temperature Programmed Reduction (TPR) determines the number of reducible species present
in the catalyst and reveals the temperature at which reduction occurs. An important aspect of TPR
analyses is that the sample need not have special characteristics other than containing reducible
metals.

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier gas such
as nitrogen or argon) over the sample, usually starting at ambient temperature. While the gas is
flowing, the temperature of the sample is increased linearly with time and the consumption of
hydrogen by adsorption/reaction is monitored. Changes in the concentration of the gas mixture
are determined. This information yields the hydrogen uptake volume.

PREPARATION

Pretreatment Oxidize by flowing O2 over the sample.
Analysis Flow 5-10% hydrogen/argon while ramping the temperature. The

analyzer records hydrogen consumption as a function of tem-
perature. Nitrogen is sometimes used because it may be more eco-
nomical than argon. Argon is recommended over nitrogen because
the resultant peak(s) show no reaction between sample and gas.

Cold Trap A cold trap is required to remove traces of water formed as a product
of the reduction.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 5 - 5.
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PROCEDURE
Sample Files on page 3 - 2
Peak Editor on page 6 - 3

1. Obtain the sample mass then install the loaded sample tube on the analyzer. If the analysis
begins below ambient, either place a Dewar of coolant around the sample tube or close the
furnace around the sample tube and install the CryoCooler. If the analysis begins at ambi-
ent, close the furnace around the sample tube.

2. Install the cold trap (if using one), then place a Dewar filled with coolant around the cold
trap. Ensure that the Dewar contains sufficient coolant to cover the cold trap loops.

A mixture of isopropyl alcohol (IPA) and liquid nitrogen (LN2) is the recommended coolant
for this experiment. Place the isopropyl alcohol in a Dewar and slowly pour LN2 into the
Dewar while stirring the mixture. Continue to add and stir the mixture until it becomes a
slush. The mixture must be capable of achieving a temperature of about -90 ºC.

Extreme caution should be used when mixing the IPA/LN2. See Dewar Precautions
on page 5 - 3.

3. Create a sample file for this analysis.
a. Go to File > New Sample.
b. Complete the Sample Description window. Enter the correct weight and complete the

optional fields.
c. Select the Analysis Conditions tab and insert the experiment steps listed below:

Insert Step Window Field Field Entry or Selection
Experiment New Experiment Experiment

description
Enter a description of the exper-
iment

Type of analysis Temperature Programmed Reduc-
tion

Temperature Programmed Reduction Analysis
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Insert Step Window Field Field Entry or Selection
Zones TCD Detector

Block zone 100
Filament 175

Valve Zones
Cold trap 110
Analysis 110
Loop 110
Vapor
generator

40

Vapor Generator
Reflux 40
Flask 40

Gas Flows Prep Gas Helium
Carrier/Reference
Gas

Hydrogen-Argon (10% blend of
hydrogen in argon)

Loop Gas None
Rate 50 cm3/min
Cold trap valve Trap
Analysis valve Prepare
Loop valve Fill
Vapor valve Bypass

Outputs Outputs Use default values
Peaks Peaks Use default values

Wait Wait Wait for operator Add sample and setup cold trap

Change Gas
Flows

Gas Flows Prep None
Carrier Hydrogen-Argon (10% blend of

hydrogen in argon)
Loop None
Cold trap valve Trap
Analysis valve Analyze
Loop valve Fill
Vapor valve Bypass

Wait Wait Wait until baseline
is stable

Select this option

Start Recording Start Recording One measurement
every

1.0 seconds
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Insert Step Window Field Field Entry or Selection
Temperature
Ramp

Temperature
Ramp

Type Sample Ramp
End Temperature 400
Ramp Rate 10.0
Hold Time 0.00

The application automatically inserts a Stop Recording step when a Start Recording
step is inserted. Ensure that the Temperature Ramp step is inserted within the
Start/Stop Recording loop.
Termination Termination Return to ambient

temperature
Select this option

Leave detector
enabled after ana-
lysis

Option is not selected

Zones Not applicable
Gas Flows Not applicable

d. Select the Report Options tab and modify the values as needed.
e. Click Save, then click Close.

4. Start the analysis.
a. Go to Unit > Sample Analysis. From the Files list box, select the sample file created

in the previous step. Edit the file as needed. Click Next.
b. From the drop-down list, select the calibrations associated with each experiment in the

sample file (if any). For this example, select None. Click Next.

Calibration files can also be associated with a sample file after analysis using Set
Calibration in the Peak Editor.

c. Read the cautionary window and make any necessary changes.
d. Click Start to start the analysis.

As the temperature increases, the copper oxide is reduced, the water produced by the
reaction is collected in the cold trap (if used), and the amount of hydrogen consumed
is detected and transmitted to the application. Use the Results view to display a
chromatogram of the hydrogen consumed from the detector signal as a function of the
ramping temperature.

Temperature Programmed Reduction Analysis
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A hydrogen consumption peak, which corresponds to the reduction capacity of copper
oxide, is displayed. The maximum peak should occur at approximately 280 ºC. This
temperature varies highly, depending on the CuO particle size. Larger particle size
shifts the temperature upward to 330 °C or more. Under certain combinations of
sample, hydrogen concentration, and flow rate, two peaks may appear due to the
transition state of Cu2+ to Cu+ to Cu.
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A ADVANCED REPORTS - PYTHON MODULE

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

ADVANCED REPORTS
Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 11 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

A Advanced Reports - Python Module
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A Advanced Reports - Python Module

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. On the Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.

Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Advanced Reports
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SCRIPTS

Run a Script

1. Open a sample file with a Complete file status.
2. Select Advanced in the view selector drop-down list at the bottom of the window.
3. Select the Report Options tab.
4. Highlight Advanced in the Selected Reports list box, then click Edit.
5. On the Advanced Report Options window, click Add.
6. Select one or more python scripts then click Select. The selected scripts become a part of

the drop-down list in the Available Scripts section of the Advanced Report Options window.
7. In the Select Reports section, select up to five Advanced reports in the drop-down lists.
8. ClickOK.
9. Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.

Edit a Script

Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added

scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Remove [button] Removes the script from the Available Scripts box but does not affect
original .py text file.

Replace [button] Replaces the contents of the selected script however, the script
name remains the same.

Scripts

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 A - 3



A Advanced Reports - Python Module

PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

1 import mic
2 import numpy as np
3
4 mic.graph( 'My Graph', 'X', 'F(X)' )
5 myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ]

)
6 mic.graph.add( 'X2', myx, myx*myx, marker='o' )
7 mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='^' )

The results are:
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Summary Report

This script produces a summary report with two summaries:

1 import mic
2 import numpy as np
3
4 mic.summary( "My Summaries" )
5 mic.summary.add( "Summary A",
6 ["Label 1:", "Label 2:", "Label 3:"],
7 ["val1", "val2", "val3"] )
8 mic.summary.add( "Summary B",
9 ["Label 4:", "Label 5:", "Label 6:"],

10 ["val4", "val5", "val6"] )

The result is:

Python Reports
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Tabular Report

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.

This script uses the Python package numpy and c-style formatting of the numerical
values.

11 import mic
12 import numpy as np
13
14 mic.table( "My Tables" )
15 mic.table.addtable( "My Set A" )
16 mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )
17 mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )
18 x1 = 0.2
19 x2 = 0.5
20 x3 = 3.14159/2
21 mic.table.addtable( "My Set B" )
22 mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),
23 '{:8.3f}'.format(x2),
24 '{:8.3f}'.format(x3)] )
25 mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),
26 '{:8.3f}'.format(np.sin(x2)),
27 '{:8.3f}'.format(np.sin(x3))] )
28 mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),
29 '{:8.3f}'.format(np.cos(x2)),
30 '{:8.3f}'.format(np.cos(x3))] )
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The result is:

Python Reports
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A Advanced Reports - Python Module

ACQUIRE BASIC INFORMATION

This script produces a graph of the primary, repeat, and difference isotherms, and prints
summaries of the sample information and the adsorptive properties.

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic_chem.isotherm,mic.sample_information, andmic.adsorptive_data are applied.

Note the calls tomic_chem.isotherm andmic.adsorptive_data above are each returning results as
a list with elements of varying return type.

1 import mic
2
3 p_primary, q_primary = mic.chem_isotherm('primary')
4 p_repeat, q_repeat = mic.chem_isotherm('repeat')
5 p_difference, q_difference = mic.chem_isotherm('difference')
6 mic.graph('Graphical Report 1', 'Absolute Pressure (mmHg)', 'Quant-

ity Adsorbed (cm³/g STP)')
7 mic.graph.add('Primary', p_primary, q_primary)
8 mic.graph.add('Repeat', p_repeat, q_repeat)
9 mic.graph.add('Difference', p_difference, q_difference)

10
11 mic.summary("Sample Information")
12 mic.summary.add( "Sample Information",
13 [ "Ambient free space:",
14 "Analysis free space:",
15 "Sample mass:",
16 "Description:",
17 "Analysis temperature:",
18 "Sample density:" ],
19 [ '{:8.3f}'.format(mic.sample_information('ambient

freespace')) + ' cm³',
20 '{:8.3f}'.format(mic.sample_information('ana-

lysis freespace')) + ' cm³',
21 '{:8.3f}'.format(mic.sample_information('sample

mass')) + ' g',
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22                    mic.sample_information('sample description'),
23 '{:8.3f}'.format(mic.sample_information('ana-

lysis temperature')) + ' K',
24 '{:8.3f}'.format(mic.sample_information('sample

density')) + ' g/cm³' ] )
25
26 csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
27
28 mic.summary.add( "Adsorptive Data",
29 [ "Cross sectional area:",
30 "Hard sphere diameter:",
31 "Density conversion factor:",
32 "Molecular weight:",
33 "Analysis gas:" ],
34 [ '{:8.3f}'.format(csa) + ' nm²',
35 '{:8.3f}'.format(hsd) + ' Å',
36 '{:8.3f}'.format(dcf),
37 '{:8.3f}'.format(mol_weight),
38                    analysis_gas ] )

Acquire Basic Information
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ENABLE THE USE OF OVERLAY DATA

1. On the Report Options tab, clickOverlays.
2. On the Plot Overlay Sample Selection window, to move a file from the Available Files list

box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

3. ClickOK.
4. On the Report Options tab, highlight Advanced in the Selected Reports list box.
5. Click Edit.
6. Select theOverlay samples checkbox to the right of the selected report.
7. ClickOK.
8. Run the script using the instructions found in Scripts on page A - 3.
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MICMODULE PYTHON CALLS

TABLES

Available Mic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

1 mic.table.addtable( name )
2
3 Keyword arguments:
4
5   name --- the table name

Add a Column

This script adds a column to the last created table:

1 mic.table.addcolumn(header, values, align='r'):
2
3 Keyword arguments:
4
5   header --- column header; must be a string (or convertible)
6   values --- column values; must be a list of strings (or con-

vertible)
7   align  --- column alignment; 'r', 'l', 'c' for right, left, and

center justified

MicModule Python Calls
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Create a New Tabular Report

1 mic.table( title='User Table' )
2
3 Keyword arguments:
4
5   title --- the tabular report title (default = 'User Table')
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SUMMARY REPORTS

Add a Summary Section

This script adds a summary section to the last created summary report:

1 mic.summary.add(name, labels, values):
2
3 Keyword arguments:
4
5   name   --- summary section name
6   labels --- column of labels; must be a list of strings
7 (or convertible) and the same length as values
8   values --- column of values; must be a list of strings
9 (or convertible) and the same length as labels

Create a New Summary Report

1 mic.summary( title='User Summary' )
2
3 Keyword arguments:
4
5   title --- the summary title

Summary Reports
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GRAPHIC REPORTS

Add a Curve

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',
2               marker='a', graphtype='both', interpolation='akima'):
3
4 Keyword arguments:
5
6   name      --- the curve name
7   x         --- list of x values; must be a list of floats
8 (or convertible) and the same length as y
9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x
11   yyaxis    --- place this curve on the yy-axis if True
12                 otherwise place on the y-axis (default = False)
13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')
14 or a three-element list or tuple (e.g.,

[65,105,225]);
15 if None, color is automatically selected (default =

None)
16   linestyle --- line style; (default = '-')
17 '-'        : solid
18 '--'       : dash
19 '.'        : dot
20 '-.'       : dash dot
21 '-..'      : dash dot dot
22   marker    --- marker shape; (default = 'a')
23 '+'        : plus
24 'o' or '0' : circle
25 'x'        : cross
26 '^'        : up triangle
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27 'v'        : down triangle
28 's'        : square
29 'd'        : diamond
30 '8'        : hourglass
31 '~'        : horizontal hourglass
32 '' or None : no marker
33 'a'        : automatically selected
34   graphtype --- graph type; (default = 'both')
35 'curve' or 'c' : curve
36 'points' or 'p' : points
37 'both' or 'b' : curve-and-points
38 'hist' or 'h' : histogram
39   interpolation -- linear or akima spline interpolation

(default='akima')
40 'akima' use akima spline
41 'linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):
2
3 Add a curve to the last created graphical report using the second
4 y-axis. The arguments to this call are the same as to mic.-

graph.add.

Graphic Reports
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Create a New Graphical Report

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',
2           yylabel='YY axis',
3           xlinear=True, ylinear=True, yylinear=True,
4           xinvert=False, yinvert=False, yyinvert=False,
5           xrange=None, yrange=None, yyrange=None, xbars_id=''):
6
7 Keyword arguments:
8
9   title    --- the graphical report title (default = 'User Graph')

10   xlabel   --- x-axis label (default = 'X axis')
11   ylabel   --- y-axis label (default = 'Y axis')
12   yylabel  --- yy-axis label (default = 'YY axis')
13   xlinear  --- x-axis linear scale; if false, use log scale
14 (default = True)
15   ylinear  --- y-axis linear scale; if false, use log scale
16 (default = True)
17   yylinear --- yy-axis linear scale; if false, use log scale
18 (default = True)
19   xinvert  --- Invert x-axis if true (default = False)
20   yinvert  --- Invert y-axis if true (default = False)
21   yyinvert --- Invert yy-axis if true (default = False)
22   xrange   --- None, or two values giving the min and max
23                range of the axis.
24   yrange   --- None, or two values giving the min and max
25                range of the axis.
26   yyrange  --- None, or two values giving the min and max
27                range of the axis.
28   xbars_id --- None, or the id of an xbar control created
29                via the mic.control() object
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GET EXPERIMENT INFORMATION

1 mic.dyn_chem_experiment(exp_num, sec_num=0, item=''):
2
3   Get data associated with the indexed experiment
4
5   Keyword arguments:
6
7     exp_num    --- The index of the experiment to acquire
8                    information for.  Indexing begins at 1
9

10     sec_num    --- If zero, the primary experiment data is
returned.

11                    If greater than zero, returns associated sec-
ondary

12                    experiment if any (typically these are mass
specs).

13
14     item       --- the specific experiment property to return
15                    information on.  If '' or None, then return
16                    the whole experiment dictionary
17
18   Usage:
19
20     exp = mic.dyn_chem_experiment(exp_num = 1)
21     ms1 = mic.dyn_chem_experiment(exp_num = 1, sec_num = 1)
22     expid = mic.dyn_chem_experiment(exp_num = 1, item = 'id')
23     temp = mic.dyn_chem_experiment(exp_num = 1, item = 'tem-

perature')
24
25 mic.dyn_chem_experiment_all():
26
27   Return a dictionary of all experiments. The key is the experiment

Get Experiment Information
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28   number, the value is a dictionary with keys from 0 (primary exper-
iment

29   data) through n where n is the number of secondary experiments
(e.g.,

30   mass spec data).
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GET SAMPLE INFORMATION ITEM

1 mic.sample_information( item, sample_number = 0 ):
2
3 Keyword arguments:
4
5   item          --- string identifying the item to be returned.
6                     For example; 'sample mass', or 'sample descrip-

tion'
7                     The default is an empty string for which the

return
8                     value is a list of all available keywords
9

10   sample_number --- Sample to retrieve
11 0           : current sample file (default)
12 1 through 8 : corresponding overlay sample file
13
14 Usage:
15
16   all_keywords = sample_information()
17   mass         = sample_information('sample mass')
18   mass         = sample_information('sample mass',0)

Get Sample Information Item
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GET IMPORTED PORE DATA

1 mic.imported_pore_data(import_number=1):
2
3 Get imported pore data.
4
5 Keyword arguments:
6
7   import_number --- the import number (1 through 8)
8
9 Usage:

10
11   porew, incvol, desc = mic.imported_pore_data(1)
12
13   porew  --- array of pore dimension boundaries (angstroms);
14              empty-array if unavailable.
15   incvol --- array of incremental pore volumes (cm^3/g);
16              empty-array if unavailable.
17   desc   --- Name of data set; empty-string if unavailable.
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GET METAL COMPOSITION FOR CHEMISORPTION

1 mic.metal_composition(metal='', metal_property='', sample_
number=0):

2
3 Get information about the active metals in this sample
4
5 Keyword arguments:
6
7   metal           --- the metal to return information about
8 if '' or None, then return a list of the
9                       active metals

10
11   metal_property  --- the specific property to return information

on
12 if '' or None, then return all the prop-

erties
13 for the specified metal (requires metal to

be
14                       specified)
15
16   sample_number --- Identifier for the metal data to retrieve
17 0           : current sample file (default)
18 1 through 8 : corresponding overlay sample

file
19
20 Usage:
21
22   metal_list  = mic.metal_composition()
23   copper_prop = mic.metal_composition('copper')
24   copper_perc = mic.metal_composition('copper',
25 'percent of sample mass')
26
27 In the above first usage case, the list of active metals is

Get Metal Composition for Chemisorption
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returned.
28 In the above second usage case, a python dictionary type
29 is returned which includes all the properties of the metal
30 available and their corresponding values.  The last case returns
31 a single value (int, float, or string) for the specified property.
32
33 The metal_property keywords which one can use are
34
35   atomic weight
36   oxygen atoms
37   density
38   percent of sample mass
39   metal atoms
40   cross sectional area
41   percent reduced
42   stoichiometry GASNAME
43
44 where in the last keyword one substitutes the desired gas name to
45 obtain its stoichiometry factor.  One can also make the call
46 metal_composition(metalname) without any metal_property keyword
47 provided to see the whole dictionary of keywords and values.
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B ATOMIC WEIGHTS AND CROSS-SECTIONAL AREAS

Metal Symbol Atomic Weight
(g/mol)

Cross-sectional
Area (nm2)

Density (g/mL)

chromium Cr 51.996 0.0635 7.19

cobalt Co 58.933 0.0662 8.9

copper Cu 63.54 0.0680 8.96

gold Au 196.967 0.08696 18.9

hafnium Hf 178.490 0.0862 13.3

iridium Ir 192.220 0.0769 22.4

iron Fe 55.847 0.0613 7.89

manganese Mn 54.938 0.0714 7.43

molybdnum Mo 95.940 0.0730 10.22

nickel Ni 58.710 0.0649 8.9

niobium Nb 92.906 0.0806 8.57

osmium Os 190.220 0.0629 22.6

palladium Pd 106.400 0.0787 12.02

platinum Pt 195.090 0.0800 21.45

rhenium Re 186.2 0.0649 21.02

rhodium Rh 102.905 0.0752 12.1

tuthenium Ru 101.070 0.0613 12.4

silver Ag 107.868 0.0869 10.5

tantalum Ta 180.947 0.0800 16.6

thorium Th 232.038 0.1350 11.7

tin Sn 118.710 0.1082 4.54

tungsten W 183.850 0.0741 19.3

vanadium V 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51

Atomic Weights and Cross-sectional Areas for Selected Metals

B Atomic Weights and Cross-Sectional Areas
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C AUXILIARY INPUTS AND OUTPUTS

File > New Sample [or Open] > Analysis Conditions tab

Analog and digital signals can be connected to the analyzer. Two industry standard D shell
connectors are available on the analyzer. A shielded cable with male pins must be used for any
auxiliary signal connected to the analyzer. The analog connector uses a 15 pin body; the digital
connector uses a 25 pin body. The cable shield must connect to a metal shell D connector
housing.

Analog inputs are enabled by marking one or both check boxes on the Insert Experiment window.

Click Insert then select Experiment. After an auxiliary input is enabled, it remains enabled for the
duration of the experiment. Because an analysis can be comprised of many experiments, an input
can be disabled or enabled at various points in the analysis, as determined by the selection on the
New Experiment windows.

C Auxiliary Inputs and Outputs
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C Auxiliary Inputs and Outputs

Digital inputs are controlled by inserting aWait step in the analysis. On theWait window, select
Wait for digital input number. Specify 1 or 2 to indicate the input signal. Enter a number of minutes
to wait; if the signal is not received before that amount of time elapses, the analysis continues
without the input.

Analog and digital outputs are enabled by marking the applicable check box(es) on theOutputs
window. TheOutputs window is available when setting the initial conditions for an experiment (by
clicking theOutputs button on the New Experiment window), or at many other points in the
analysis (by inserting a Set Outputs step in the experiment). The state of the auxiliary outputs can
be changed frequently throughout the analysis.
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The state of the auxiliary inputs and outputs is displayed on the analyzer schematic. Auxiliary
signals can be incorporated in reports (overlaid over other data in graphs), in the Results view of
the Analysis window (during analysis) and in the Peak Editor.

In the Auxiliary Status Display on the analyzer schematic, a zero or a one is displayed to show the
state of each digital output (DO), relay output (RO), and digital input (DI). See Digital on page C -
5.

The voltage is displayed for each analog input (AUX 1 and AUX 2).

C Auxiliary Inputs and Outputs
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C Auxiliary Inputs and Outputs

ANALOG
The 15 pin analog connector provides two output signals and two input signals.

OUTPUT SIGNALS:

n The TCD signal (could be as high as 12 volts —positive or negative).
n The sample temperature signal, which is a buffered voltage from the sample thermocouple.

The voltage ranges from –0.365 V at –40 °C, 0 at 0 °C, to 10.88 V at 1110 °C. The signal fol-
lows the type-K thermocouple nonlinear characteristic.

The signals are available at these pins:

TCD (+) 7

TCD (–) 5

Temp (+) 8

Temp (–) 6
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INPUT SIGNALS:

The inputs are available for connection to other detectors, such as a mass spectrometer. The
voltage range is –15 to 15 volts. The analyzer application can record these signals at the same
time as it records TCD and sample thermocouple data.

The signals connect to these pins:

Auxiliary input 1 (+) 4

Auxiliary input 1 (–) 3

Auxiliary input 2 (+) 2

Auxiliary input 2 (–) 1

All other pins in the 15 pin connector are floating (not connected). Connect the metal shell of the
connector to the chassis ground and cable shield to maintain shielding of the signals.

DIGITAL
The 25 pin digital connector provides floating signals to control and monitor external hardware—
such as auxiliary detectors or chart recorders.

The outputs consist of four sets of latching relay contacts and four opto-coupled photo transistors.
The inputs are two optically isolated photo couplers.

The analyzer application sets these as logic 1 or logic 0— as defined by the analysis step. They
are displayed on the analyzer schematic.

A logic 1 causes the relay to connect the common contact to the normally open contact. The relay
will retain this condition even when power to the analyzer is disconnected. A logic 0 causes the
relay to connect the common contact to the normally closed contact.

A logic 1 to the opto-coupled outputs causes the NPN photo transistor to be turned on. A logic 0
turns the NPN photo transistor off.

The two opto-coupled inputs are read by the analyzer as logic 1 (when current flows through the
opto-coupler photo diodes) or logic 0 (when no current is flowing).

Input signals:
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ELECTRICAL SPECIFICATIONS

Relays Maximum voltage = 250V~, 48 VDC
Maximum switching current = 4A at 250V~; 3A at 30 VDC
Maximum switching current = 100 mA at 100 VDC

Opto-coupled outputs Maximum voltage: VCE = 70 VDC
Maximum reverse voltage, VCE = 7 VDC
Maximum current = 10 mA

Opto-coupled inputs Maximum reverse voltage = 3 v
Nominal forward voltage 1.3 v at 10
Minimum current required to be recognized by the analyzer = 1 mA

Pin Type Function
1 Relay 1 normally closed

2 Relay 1 common

3 Relay 1 normally open

4 Relay 2 normally closed

5 Relay 2 common

6 Relay 2 normally open

7 Relay 3 normally closed

8 Relay 3 common

9 Relay 3 normally open

10 Relay 4 normally closed

11 Relay 4 common

12 Relay 4 normally open

13 Not Used Not used

14 Opto output 1 collector

15 Opto output 1 emitter

16 Opto output 2 collector

17 Opto output 2 emitter

18 Opto output 3 collector

19 Opto output 3 emitter

Digital Connector Pin Designations
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Pin Type Function
20 Opto output 4 collector

21 Opto output 4 emitter

22 Opto input 1 anode (+)

23 Opto input 1 Cathode (-)

24 Opto input 2 anode (+)

25 Opto input 2 cathode (-)

Digital Connector Pin Designations (continued)

Input signals:
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D EXPORTED DATA EXAMPLE

D Exported Data Example
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D Exported Data Example
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D Exported Data Example
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E GAS CHARTS

RELATIVE THERMAL CONDUCTIVITY OF GASES

Name Chemical Formula Conductivity (Relative to Air)
Air 1.00

Ammonia NH3 0.92

Argon Ar 0.68

Butane C4H10 0.60

Carbon Dioxide CO2 0.62

Carbon Monoxide CO 0.97

Ethane C2H6 0.79

Helium He 5.84

Hydrogen H2 7.07

Krypton Kr 0.37

Methane CH4 1.29

Neon Ne 1.87

Nitric Oxide NO 0.99

Nitrogen N2 1.00

Nitrogen Dioxide NO2 or N2O4 1.51

Nitrous Oxide N2O 0.65

Oxygen O2 1.02

Sulfur Dioxide SO2 0.38

Water Vapor H2O 0.67

E Gas Charts
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E Gas Charts

TYPICAL GASES USED

Flow Rate of 50 cm3/min

Test Preparation
Gas

Carrier
Gas

Loop
Gas

Other

TPR Experiment Argon 10% H2 in
Argon

N/A

Calibration N/A Argon TCD Level Calibration

TPD Ammonia
Helium or
15% NH3 in
Helium Helium

N/A

Calibration N/A NH3 in
Helium TCD Level Calibration

TPD Pyridine Helium
Helium Helium

Pyridine in vapor generator

Calibration N/A User-defined Pyridine in
vapor generator

TPD Hydrogen 10% H2 in
Argon

Argon
N/A Calibration

Calibration N/A 10% H2 in
Argon TCD Level Calibration

TPD Oxygen 10%O2 in
Helium

Helium
N/A

Calibration N/A 10%O2 in
Helium TCD Level Calibration

TPO Experiment Helium 10%O2 in
Helium

N/A

Calibration N/A Helium TCD Level Calibration

H2 Pulse
Chemisorption 10% H2 in

Argon

Argon 10% H2 in
Argon

CO Pulse
Chemisorption Helium 10% CO in

Helium

Calibration Not Required

BET Surface Area Helium
30% N2 in
Helium N/A

Calibration N/A
User-defined manual injec-
tions of N2 (0.5, 1.0, 1.5,
and 2.0 cm3)
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GAS CONVERSION CONSTANTS
Dynamic analysis uses a Mass Flow Controller (MFC) to control the flow of gases. The MFC
requires a conversion constant for each gas or gas mixture to compensate for variations in gas
flows resulting from variations in the properties of gases. A default gas table containing MFC
conversion constants is included on theOptionsmenu. The following table provides a more
complete list of gases and their conversion constants.

Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Acetylene C2H2 0.6535

Air (mixture) 0.9901

Allene C3H4 0.4752

Ammonia NH3 0.7822

Argon Ar 1.3861

Arsine A5H3 0.7525

Boron Trichloride BCl3 0.4356

Boron Trifluoride BF3 0.5743

Bromine Pentafluoride BrF5 0.2871

Bromine Trifluoride BrF3 0.4356

Butane C4H10 0.2871

Butene C4H8 0.3267

Carbon Dioxide CO2 0.7723

Carbon Monoxide CO 0.9802

Carbon Tetracloride CCl4 0.3465

Carbon Tetrafluoride CF4 0.4752

Carbonyl Fluoride COF2 0.2673

Carbonyl Sulfide COS 0.6733

Chlorine Cl2 0.8218

Chloroform CHCl3 0.4356

Chlorine Trifluoride ClF3 0.4257

Gas Conversion Constants for the MFC

E Gas Charts
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Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Cyanogen C2N2 0.4950

Cyclopropane C3H6 0.5050

Deuterium D2 0.9901

Diborane B2H6 0.5446

Dichlorosilane SiH2Cl2 0.4356

Dimethylamine (CH3)2NH 0.6634

Dimethylether (CH3)2O 0.5842

Ethane C2H6 0.5446

Ethyl Chloride C2H5Cl 0.2871

Ethylene C2H4 0.6139

Ethylene Oxide C2H4O 0.5842

Fluorine F2 0.9208

Fluroform CHF3 0.5644

Freon 11 CCl3F 0.3762

Freon 12 CCl3F2 0.3861

Freon 13 CClF3 0.4257

Freon 13 B1 CBrF3 0.4059

Freon 14 CF4 0.4703

Freon 21 CHCl2F 0.4554

Freon 22 CHClF2 0.5050

Freon 23 CHF3 0.5644

Freon 113 CCl2F-CClF2 0.2277

Freon 114 CCl2F4-CClF2 0.2554

Freon 115 CClF2-CF3 0.2713

Gas Conversion Constants for the MFC (continued)
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Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Freon 116 CF3-CF3 0.2277

Germane GeH4 0.6436

Helium He 1.3762

Hexamethyldisizane HMDS 0.1386

Hydrogen H2 1.0000

Hydrogen Bromide HBr 0.9703

Hydrogen Chloride (Dry) HCl 0.9802

Hydrogen Fluoride HF 0.9901

Hydrogen Iodide HI 0.9505

Hydrogen Selenide H2Se 0.8317

Hydrogen Sulfide H2S 0.8416

Isobutane C4H10 0.3069

Isobutylene C4H8 0.3366

Krypton Kr 1.3762

Methane CH4 0.8020

Methylamine CH3NH2 0.5644

Methyl Bromide CH3Br 0.6436

Methyl Chloride CH3Cl 0.6832

Methyl Fluoride CH3F 0.7525

Methyl Mercaptan CH4S 0.5842

Neon Ne 1.3861

Nitric Oxide NO 0.9901

Nitrogen N2 0.9950

Nitrogen Dioxide NO2 0.7525

Gas Conversion Constants for the MFC (continued)
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E Gas Charts

Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Nitrogen Trioxide N2O3 0.4356

Nitrogen Trifluoride NF3 0.5446

Nitrous Oxide N2O 0.7426

Oxygen O2 0.9802

Ozone O3 0.7327

Pentaborane B5Hg 0.2871

n Pentane C5H12 0.2376

Perchloryl Fluoride ClO3F 0.4455

Phosgene COCl2 0.5050

Phosphine PH3 0.7822

Phosphorous Pentafluoride PF5 0.3465

Propane C3H8 0.3861

Propylene (Propene) C3H6 0.4653

Silane SiH4 0.6733

Silicon Tetrachloride SiCl4 0.3168

Silicon Tetrafluoride SiF4 0.3960

Sulfur Dioxide SO2 0.7228

Sulfur Hexafluoride SF6 0.2970

Trichlorosilane Cl3HSi 0.3267

Trimethylamine (CH3)3N 0.3168

Tungsten Hexafluoride WF6 0.2871

Uranium Hexafluoride UF6 0.2178

Vinyl Bromide C2H3Br 0.5248

Vinyl Chloride C2H3Cl 0.5347

Vinyl Fluoride C2H3F 0.5743

Gas Conversion Constants for the MFC (continued)
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Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Xenon Xe 1.3762

Gas Conversion Constants for the MFC (continued)
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F PEAK DETECTION / INTEGRATION OPTIONS

This section applies only to dynamic analysis samples.

File Open > [.RPO file] > [Integration button]
Or, select the Integration button while in the Peak Editor.

Peak detection parameters can be customized using the Integration button on the Report
Options window or the Integration button on the Peak Editor window. Peak detection options can
be customized while creating the sample file or after analysis. For Loop calibrations, peaks are
found using events that occurred during the analysis — such as the time an injection started—
instead of peak detection options.

Selection Description
Standard Settings
[group box]

n Baseline mode

The Baseline Mode affects how the Find All Peaks function works.

Peak Detection/Integration Options

F Peak Detection / Integration Options
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F Peak Detection / Integration Options

Selection Description
If Best Fit Baseline is selected, the bottom of the peaks is placed in
the baseline that best describes the signal outside the range of the
peaks. This assumes a linear baseline between the beginning and
the end of the peak.

If Snap to Signal is selected, the bottom of the peaks is moved to the
signal recorded, not the best fit baseline between the peaks.

n Minimum peak height

Sets the minimum height for peaks to be identified and included in
the peak table. This value is expressed in terms of the trace’s Y-axis
units. Use a value of 0 (zero) to include all peaks.

n Peak smoothing

Smoothing allows the application to average the points before using
them, so that noise spikes are ignored. Specify the number of points
to average into a single value during the peak picking process.

The smoothing parameter can be turned off by setting the value at 1
or 0 (zero). A setting of 1 disables smoothing, and the peak edges
are interpolated to the best X-axis value. A setting of 0 also disables
smoothing, but the peak edges (the points where the peak begins
and ends) are not interpolated. Instead, the nearest data point is
used as the peak edge.

Advanced Settings
[group box]

n Sensitivity

Sensitivity sets the noise rejection level for identifying the peaks in a
trace. Use a value from -100 to 100%. For example, a sensitivity
level of 5%means that 5% of all local maxima in the trace are greater
than the noise and are, therefore to be considered as peaks. A value
of 100% identifies all local maxima (or minima for traces with
transmission Y units) as peaks. One possible exception to note is the
combination of other rejection parameters (such asMinimum Peak
Area and Minimum Peak Height) which can reject peaks even when
the sensitivity is set to 100%.

The sensitivity can also be set to negative values to define a specific
noise level (in Y units) for peak rejection. For example, a sensitivity
setting of - 2.5% sets the noise rejection to 2.5 V. This means that

Peak Detection/Integration Options (continued)
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Selection Description
maxima with an

amplitude of 2.5 V or less will be considered as baseline noise
instead of as peaks. (As opposed to theMinimum Peak Height
rejection parameter which eliminates refined peaks by using their
height above the baseline.)

A setting of 0 (zero) automatically sets a default noise level for the
trace.

n Maximum shoulder ratio

There can also be shoulder peaks (also called combination peaks)
within a group. SeeMaximum group separation. on the next
page for a description of peak groups. Shoulders are usually small
peaks that are overlapped on the front or the tail of a larger peak.
These peaks can also be called leaders and followers, respectively.
As with baseline groups, the areas of these peaks can be calculated
incorrectly. If the larger parent peak has a long tail with a much
smaller peak riding on it, most of the area under the trace belongs to
the parent peak. However, if the area of these peaks was determined
using baseline grouping, the smaller peak would be calculated by
using vertical drop lines at the edges. This would give the parent
peak too little area, and the rider peak too much.

The application can detect these shoulder peaks. The areas of
shoulder peaks are calculated by drawing a skimmed baseline from
the leading edge to the trailing edge. Either an exponential or a
straight skim line can be used. The skim type is specified by a
secondary method parameter (seeMethods on page 2 - 23) and
the default is exponential skimming. The remaining area between
the shoulder peak baseline and the group baseline is considered to
be part of the parent peak.

TheMax Shoulder Ratio parameter is used to specify whether the
peaks that are overlapped in the front or the tail of much larger peaks
should be identified as shoulder peaks. To use shoulder peak
detection, use a nonzero value for theMax Shoulder Ratio
parameter. After a baseline group has been identified, the
application looks for peaks within the group that satisfy the following
shoulder peak criteria:

Peak Detection/Integration Options (continued)
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F Peak Detection / Integration Options

Selection Description
Shoulders must have a significantly higher Y value at one edge than
the other. More importantly, the height of the shoulder above the
common value must be much smaller than the height of the “parent”
(larger) peak above the same valley. It must be smaller by the Max
Shoulder Ratio setting. For example, a setting of 33 implies that
shoulders must be smaller than 33% of their parents in terms of
height above the common valley. The areas for shoulder peaks are
calculated by drawing a skimmed baseline from the left shoulder
peak baseline and the group common baseline is considered to be
part of the parent peak.

Shoulder peaks can only be calculated within a group of peaks. See
Maximum group separation. below for a description of peak
groups. If theMax Group Separation parameter is set to 0 (no
groups), aMax Shoulder Ratio parameter value is not used. Use a
value of zero to specify no shoulder peak detection.

A value of 33% works well with most data. Use a setting of zero to
treat shoulder peaks with a perpendicular drop to the common group
baseline instead of a skimmed baseline.

If the application detects unwanted baseline noise peaks, try
increasing the Sensitivity setting. Conversely, if some peaks are not
detected, decrease the value.

Maximum group separation.

The application normally calculates peak areas by drawing a valley-
to-valley baseline from the leading edge to the trailing edge of every
identified peak. However, in many traces, the valleys between peaks
do not always drop back to the original baseline. If a valley-to-valley
baseline is used for this type of peak, the calculated area does not
accurately reflect the true area under the peak.

The application provides a parameter that allows the calculation of
Baseline Groups. A group of peaks is defined by a common baseline
that extends from the leading edge of the first peak in the group to
the trailing edge of the last. The areas of grouped peaks are
calculated by dropping vertical lines from the peak edges down to
the group baseline.

Peak Detection/Integration Options (continued)
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Selection Description

There may also be Report Groups defined by the
method and assigned group letters from A through Z.
Unlike these Baseline Groups, the Report Groups need
not be next to one another. The two types of groups are
not related.

TheMax Group Separation parameter is used to determine which
peaks in a trace have a common baseline. When using peak
grouping, the application compares the width (actually double the
largest half width) of every identified peak in a trace to the width of
the following peak. TheMax Group Separation parameter specifies a
percentage of the smallest of these two widths in X units. If the edges
of two adjacent peaks differ by less than this value, the two peaks
constitute a group and are given a common baseline. For example, if
two adjacent peaks in the trace have largest half widths of 1 and 1.5
respectively, and theMax Group Separation parameter is set at
20%, then a difference of less than 0.4 X units between the adjacent
edges of these peaks would make them a group with a common
baseline. If the same two peaks have adjacent edges that are
greater than 0.4 X units apart, they do not define a group, and each
peak has its own separate baseline.

The areas for grouped peaks are calculated by drawing imaginary
vertical lines from the peak edges to the common baseline. Any
peaks that share common edges are automatically considered a
group and are given a common baseline for anyMax Group
Separation setting greater than 0. To specify no peak grouping (each
identified peak has its own baseline), use a setting of 0. A value of
33% for this parameter works well with most data. Use a setting of
zero to force all baselines to be drawn from peak valley to valley.

n Minimum peak area

This parameter sets the minimum area required for refined,
processed peaks to be recognized, identified, and included in the
peak table. Any peak with a calculated peak area smaller than the
current setting is not detected. Values for this parameter are
expressed in terms of the trace X-axis units multiplied by the Y-axis
units (e.g., millivolt-minutes).

Setting the Sensitivity parameter to large values (greater than 20%)

Peak Detection/Integration Options (continued)
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F Peak Detection / Integration Options

Selection Description
can cause noise spikes (or dips) on the sides of major peaks to be
identified as peaks themselves. If the areas of the peaks are smaller
than the Minimum Peak Area parameter, major peaks in the trace
may not be identified at all. Exercise caution when using high
Sensitivity settings with the Minimum Peak Area parameter.

If peaks are not detected by the application, lower the setting with a
smaller value. This parameter must be adjusted in conjunction with
the Peak Sensitivity and/or Minimum Peak Height parameters
above. Peak rejection is accomplished through a combination of
peak height and peak area rejection parameters. If the application is
not detecting the peak(s) of interest, decrease both parameters.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 4.

Peak Detection/Integration Options (continued)
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G TEMPERATURE PROGRAMMED ANALYSES
Most temperature-programmed experiments are based on the following highly simplified steps:

1. Gas flows into the analyzer.
2. The gas interacts with the sample as the temperature changes.
3. Gas flows past the detector.
4. The detector collects data.
5. The application plots and calculates results.

How the Detector Works

The detector contains heated filaments that measure the difference in gas thermal conductivity
sensed between the gases flowing over the sample and reference filaments.

The gases flowing past the detector cool the filament by extracting heat. How quickly any type of
gas removes heat from the detector is determined by its thermal conductivity1 ) . A gas with a high
thermal conductivity cools the filament rapidly, and more power is required to maintain its
temperature. A gas with a lower thermal conductivity removes heat from the filament more slowly.

When the sample reacts with the gas, it causes changes in the composition of the gas and,
consequently, changes the thermal conductivity of the gas. These changes are sensed by the
detector as an increase or decrease in the amount of power required to maintain the filament at a
constant temperature.

Data that are Collected

The detector reports the amount of electricity (in volts) required to keep its temperature constant
during the analysis.

1 ) The thermal conductivity of a gas is its ability to conduct heat. Each gas has a distinct thermal
conductivity.

G Temperature Programmed Analyses

AutoChem II 2920 Operator Manual
292-42831-01 (Rev A) — Apr 2024 G - 1



G Temperature Programmed Analyses

The Role of the Sample Temperature

Because the sample’s temperature determines how rapidly it interacts with the analysis gas (or if it
reacts at all), data are collected over the range of temperatures specified.

In some experiments, you may prefer to start collecting data at a very low temperature to establish
a baseline where the gas is completely unaffected by the sample. In other cases, you may prefer
to collect data after a reaction has begun. In still other experiments, your primary interest may be
determining the temperature at which the maximum reaction occurs.

For example, consider the example of a Temperature-Programmed Reduction (TPR). During the
TPR, a metal oxide is reacted with hydrogen to form a pure metal. This reaction is referred to as
“reducing” the metal; for example, TPR of a catalyst containing Platinum. Argon, which has a very
low thermal conductivity, is used as a carrier gas. It is blended in a fixed proportion with hydrogen,
an analysis gas with a much higher thermal conductivity. Then the gas mixture flows through the
analyzer, through the sample, and past the detector.

When the gas blend begins flowing over the sample, a baseline reading is established by the
detector. This baseline is established at a low enough temperature that no reduction of the sample
is occurring, so the baseline level recorded by the detector is that of the thermal conductivity of the
two gases in their fixed proportion. In other words, the proportion of gases flowing over the
detector is the same as the proportion of gases entering the analyzer, because at the low
temperature, there is no interaction with the sample.

A. Gas flows into the sample tube and through the
sample.

B. Before the reaction begins, the concentration of
gases exiting the sample tube is unchanged after
flowing through the sample.

The temperature is then changed, and when a critical temperature is reached, hydrogen atoms in
the gas flow react with the sample, forming H2Omolecules. The H2Omolecules are removed from
the gas stream using a cold trap. As a result, the amount of hydrogen in the argon / hydrogen gas
blend inside the analyzer decreases, and the proportion between the two gases shifts in the
direction of argon, as does the mixture’s thermal conductivity.
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A. As the temperature changes, the sample begins to
react with the gas(es) flowing through it.

B. The concentration of gases exiting the sample tube
is altered after passing through the sample. This
change in the gas concentration is recorded by the
Thermal Conductivity Detector downstream.

Since argon has a lower thermal conductivity than hydrogen, the mixture’s thermal conductivity
consequently decreases. The flowing gas removes heat from the filament more slowly, requiring
less electricity to maintain a constant filament temperature. The analyzer records the electrical
demand as it changes (this is called the detector signal). The detector signal is recorded
continuously over a range of temperatures. When these readings are graphed, the data form one
or more peaks. Peaks can be positive or negative; negative peaks are show in this example.

G Temperature Programmed Analyses
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G Temperature Programmed Analyses

Item Description
1 Baseline readings. The gas(es) is (are) not reacting with the sample, so there is no

change in the signal from reading to reading.
2 As the temperature changes, the sample begins to react with one of the gases. There-

fore the gas mix is then made up of a larger proportion of the other gas. This causes a
shift in the mixture’s thermal conductivity. The detector measures this change by
recording the change in the amount of electricity required to maintain constant filament
temperature.

3 As temperature continues to increase, the interaction reaches a maximum, then begins
to diminish.

4 As fewer and fewer sample atoms are available to bond with the analysis gas, there is
less and less change in the mix of gases flowing into the analyzer and past the
detector, so the thermal conductivity shifts back toward the baseline value.

Negative Peaks Legend

This example illustrates the fundamental concept upon which the analyzer operates. Of course,
the various types of analyses the analyzer can perform result in different types of traces. For
example, a pulse chemisorption analysis results in a series of peaks that gradually increases in
size as the sample is dosed with separate increments of gas. Initially, the gas uptake by the
sample results in smaller peaks. But when all the active sites are saturated, no more gas can be
taken up and the peaks become equal.

PEAK AREA
The area beneath each peak is calculated to provide information about the volume of gas reacted
during the analysis. The Calculations document can be found on the Micromeritics web page
(www.micromeritics.com).

AUTOMATIC OPERATION

The analyzer application provides a simple format to specify all the analysis conditions for the
experiment; create a sample file which contains sample information and a list of specific steps the
analyzer will follow to perform the experiment(s). Then, the analyzer automatically performs the
analysis, from controlling the gas mixture and flow rate to monitoring the temperature and
pressure. After analysis, use the Peak Editor to adjust the peaks to create reports that contain the
data needed, without baseline noise or other undesirable effects.

Because up to 99 experiments can be specified and each experiment can contain up to 99 steps,
the analyzer can perform a wide variety of preparation and analysis functions automatically.
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SORPTION TRAP
In some cases, it is preferred to trap substances resulting from the reaction. In the previous
example, H2O is produced during the analysis. If the gas flow is passed through the sorption trap
at an appropriate temperature, the water can be removed before the gas flows past the detector.

INJECTION LOOP
Injection loops are provided for injecting carefully measured doses of gases for analyses such as
Pulse chemisorption. The analyzer is shipped with a 0.5 cm3 loop installed. A 1 mL loop is also
available. If the sample file is set so that a loop is used for introducing gas into the analyzer, the
analyzer will automatically dose the sample as specified in the sample file.

SAMPLE PREPARATION AND CALIBRATION
Depending on the type of experiment(s) to be performed, sample preparation and/or calibration
may be required. Specific instructions are contained in the appropriate sections of this manual.

A sample is prepared for analysis by removing unwanted adsorbates from the surface of the
sample. This is usually accomplished by flowing gas over the sample and may include heating the
sample. The flowing gas may be inert or chemically active gases may be used to activate the
surface.

Calibration routines provide the analyzer and application with the appropriate information to
convert electrical signals to physically meaningful data such as volume adsorbed, loop volume,
and gas concentration.
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H WORKSHEETS

Worksheets in this section may be copied as needed.

AutoChem Gas Connections Worksheet on the next page
Gas Flow Constant Calibration Worksheet on page H - 3
Manual Injections Worksheet for AutoChem on page H - 5
Sample Data Worksheet for Chemisorption on page H - 6

HWorksheets
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AUTOCHEM GAS CONNECTIONS WORKSHEET

Use this form to record the connected gases. Use this form as a checklist against the gases
identified in the analyzer application.

Unit number (S/N):

Date:

Operator:

Preparation Gas Carrier / Reference Gas Loop Gas

Copy and use this worksheet as needed



GAS FLOW CONSTANT CALIBRATION WORKSHEET

Follow the instructions for calibrating the analyzer’s Mass Flow Controllers for a given gas. Use
worksheet to record measured values and perform calculations included in this process.

SINGLE GASES

MFC being used (optional)

__________ Preparation

__________ Reference (AutoChem II 2920 only)

__________ Carrier

__________ Analysis (Loop)

Gas: ________________________________________________________________________

1. MFC flow rate (as set on instrument schematic): _________________________________
2. Measured flow rate (using an external flow meter): ________________________________
3. Convert the flow rate to Standard Temperature and Pressure (STP) using the following for-

mula:

Measured rate at STP: _________________________

4. Enter the value from line 3 in the Actual flow field of the Gas Flow Constant Calibration win-
dow (Unit [n] > Gas Flow Calibration).

5. The new Mass flow constant displays. Enter the Mass flow constant value: __________
6. Click Accept.
7. Enter the new Conversion Constant for this gas (from line 5) into the Adsorptive Properties

(.ADP) file.

Copy and use this worksheet as needed



GAS MIXTURES

A conversion constant for a mixture of gases can be determined using the conversion constants
for each gas in the mixture. Use the following formula to calculate the conversion constant for the
gas mixture:

where

M = mixture conversion constant
P = percentage of gas n in the mixture, expressed as a whole number (example: for

15%, use 15, not .15)
F = conversion constant (factor) for gas n

Gas Name (n) Conversion Constant (F)
1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

13.

14.

15.

Mixture name: _______________________ Constant (M): _______________________

Copy and use this worksheet as needed



MANUAL INJECTIONS WORKSHEET FOR AUTOCHEM
Use this worksheet to list the planned injection volumes, then check indicate if completed.

Injection Comments/Volume Completed
1 o

2 o

3 o

4 o

5 o

6 o

7 o

8 o

9 o

10 o

11 o

12 o

13 o

14 o

15 o

16 o

17 o

18 o

19 o

20 o

Copy and use this worksheet as needed



SAMPLE DATA WORKSHEET FOR CHEMISORPTION

Sample tube identification:

Sample Mass (g)
Before Degas After Analysis

1. Mass of empty sample tube set g g

2. Mass of sample tube set plus sample g g

3. Mass of sample (step 2 minus step 1) g g

Notes:

Copy and use this worksheet as needed
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